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SALESFORCE MAPS

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Increase customer conversions, improve revenue, and drive pipeline and lead generation. Help field
reps plan for customer visits when they spend less time on the road and more time building
relationships. Design strategic sales and service territories that integrate with Salesforce and external
systems.

Salesforce Maps for Field Reps

Spend more time building customer relationships and less time on the road. Salesforce Maps
help you sell to and serve customers better, optimize schedules and routes for in-person and
virtual visits, and find new business.

Salesforce Maps for Managers and Administrators

Get your sales and service teams to spend more time building customer relationships and less
time on the road. Salesforce Maps and Salesforce Maps Advanced help your teams sell to and
serve more customers in less time and optimize routes for in-person visits.

Get Technical Support for the Salesforce Maps Portfolio

Remove roadblocks and reduce downtime when you route your requests directly to support engineers who specialize in Salesforce
Maps, Salesforce Maps Advanced, and Territory Planning.

Salesforce Maps for Field Reps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Spend more time building customer relationships and less time on the road. Salesforce Maps help
you sell to and serve customers better, optimize schedules and routes for in-person and virtual
visits, and find new business.

Visiting More Customers in Less Time

Increase sales when you build and maintain customer relationships based on optimized account
visits. Improve sales productivity by acting on specific accounts directly from the legend in
Salesforce Maps. Fill gaps in schedules with nearby opportunities and create efficient routes.

Finding New Business Using Salesforce Maps Data

Meet and exceed management’s sales and service goals as you generate leads and discover
untapped and underserved markets. Expand into new locations, identify who can benefit from
your products and services, and fill scheduling gaps while you’re on the road. Salesforce Maps
provides property, business, and demographic data that gives you a competitive advantage for crushing sales and service goals.
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Visiting More Customers in Less Time

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Increase sales when you build and maintain customer relationships based on optimized account
visits. Improve sales productivity by acting on specific accounts directly from the legend in Salesforce
Maps. Fill gaps in schedules with nearby opportunities and create efficient routes.

Plan Visits and Perform Actions for Multiple Records Simultaneously

Meet and exceed customer expectations with timely visits scheduled for multiple accounts at
a time. Manage records in a marker or polyline layer using mass actions conveniently from the
plotted legend in Salesforce Maps. Determine which accounts to take action on while viewing
them on the map. Marker colors and shapes update immediately when you initiate single or
mass action changes.

Visualize and Set the Focus for Records That Require Attention

Select key records on the map and perform mass actions for them from a list that appears in
the legend. Identify records using shape, color, and opacity options that keep you focused on what’s important now in Salesforce
Maps.

Plan Visits and Perform Actions for Multiple Records Simultaneously

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

Meet and exceed customer expectations with timely visits scheduled for multiple accounts at a
time. Manage records in a marker or polyline layer using mass actions conveniently from the plotted
legend in Salesforce Maps. Determine which accounts to take action on while viewing them on
the map. Marker colors and shapes update immediately when you initiate single or mass action
changes.

1. Open a marker or polyline layer.

2. Display markers according to the field you want to work with, such as industry or annual revenue.

3. Right-click a marker row. The row you click is highlighted for easy identification. Actions you
take on that marker apply to all records included within it.
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Visualize and Set the Focus for Records That Require Attention

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

Select key records on the map and perform mass actions for them from a list that appears in the
legend. Identify records using shape, color, and opacity options that keep you focused on what’s
important now in Salesforce Maps.

1. Open a marker or polyline layer.

2. Click Select Markers, and then select markers using Ctrl key shortcuts.
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3. View the list of records and select an action that you want to take.

4. Set appearance options so that you identify selected records and reduce opacity for unselected ones.

Finding New Business Using Salesforce Maps Data

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Meet and exceed management’s sales and service goals as you generate leads and discover untapped
and underserved markets. Expand into new locations, identify who can benefit from your products
and services, and fill scheduling gaps while you’re on the road. Salesforce Maps provides property,
business, and demographic data that gives you a competitive advantage for crushing sales and
service goals.

Types of Data That Broaden Your Reach

Gain insight into markets that can benefit from your products and services directly in Salesforce
Maps. Rely on trusted property, business, and demographic data from providers such as ATTOM
and DatabaseUSA.com.

Examples of Growing Your Business Using Salesforce Maps Data

Generate leads, accounts, and opportunities using the property, business, and demographic
data available in Salesforce Maps. Draw inspiration from real-world examples, and adapt them for your own business requirements.
For added context, overlay other available data including ArcGIS weather trends.

Requirements for Using Salesforce Maps Data

Get access to Salesforce Maps and its data, set your goals, and interpret the data on the map. Later, you generate leads or accounts
from that data and determine whether marketing campaigns can help you and your team reach your goals.

Considerations for Using Salesforce Maps Data

Set your expectations for working with property, business, and demographic data. Salesforce Maps data comes from numerous,
trusted data providers such as ATTOM and DatabaseUSA.com.
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Generating Leads and Identifying New Markets on a Map

Sell to and provide services for property owners and businesses. Generate leads in Salesforce using property and business data
without time-consuming data entry. Determine which locations meet your demographic requirements for business expansions and
recruitment efforts in Salesforce Maps.

Types of Data That Broaden Your Reach

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Gain insight into markets that can benefit from your products and services directly in Salesforce
Maps. Rely on trusted property, business, and demographic data from providers such as ATTOM
and DatabaseUSA.com.

When you plot data from trusted data sources on a map, you increase your chances of reaching
and exceeding your sales and service targets. Choose from property, business, and demographic
data that helps you determine where to focus your efforts.

Examples of What’s IncludedAvailable Data

Property • Property owners and their mailing addresses

• Numbers of rooms

• Loan positions and outstanding balances

• Material compositions, HVAC systems, and property features

• Property tax assessments

Business • Company details such as employee count, contact names, phone numbers, and mailing addresses

• Estimated business expenses for utilities, rent, legal services, and office equipment

• Industry codes

• Totals and ranges for annual sales

Demographic • Income brackets

• Age ranges
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Examples of What’s IncludedAvailable Data

• Levels of education

SEE ALSO:

Fields for Business Data (USA)

Fields for Property Data (USA)

Examples of Growing Your Business Using Salesforce Maps Data

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Generate leads, accounts, and opportunities using the property, business, and demographic data
available in Salesforce Maps. Draw inspiration from real-world examples, and adapt them for your
own business requirements. For added context, overlay other available data including ArcGIS
weather trends.

Property Data Examples

Branch into new areas and find customers who identify with your goods and services when
you focus on owners of properties that have certain characteristics using Salesforce Maps
property data. Add potential business opportunities to Salesforce as prospecting accounts.

Business Data Examples

Focus on prospective customers nearest to your established ones. Find businesses with specific
characteristics and fill gaps in schedules while you’re on the road using Salesforce Maps business
data. Add business prospects to Salesforce as prospecting accounts or leads.

Demographic Data Examples

Expand your business into untapped and underserved communities and diversify your recruiting efforts among key populations
using Salesforce Maps demographic data. Concentrations of your search results appear on a map and help you identify where to
focus your energy.

Property Data Examples

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Branch into new areas and find customers who identify with your goods and services when you
focus on owners of properties that have certain characteristics using Salesforce Maps property data.
Add potential business opportunities to Salesforce as prospecting accounts.

In Salesforce Maps, create data layers using property data from ATTOM and filters that you define.
Complement your prospecting efforts when you include helpful details for contacting property
owners in marker popups. For example, include owner names, addresses, and any other relevant
details.
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Plot the data layer on the map, which shows properties based on the filters that you defined.After you identify prospects, choose whether
to create prospecting accounts in Salesforce or add those prospects to your schedule and routes.

These examples illustrate how different businesses can use property data available in Salesforce Maps for identifying new sales and
service prospects.

Property Data That Helps Identify New ProspectsExample

An alarm systems company explores options for branching into other territories. The company
identifies properties with:

Expand into new geographic
areas and markets

• At least three bedrooms

• Owner occupancy

• Available home equity greater than $100,000

A landscaping company digs for nearby prospects whose properties match criteria that includes
properties:

Identify customers who need
your products and services

• Whose lot square footage is greater than 10,000
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Property Data That Helps Identify New ProspectsExample

• Within specific postal codes

• Categorized as commercial or residential

A roofing contractor provides roofing repairs to a community recently struck by hailstorms. An
ArcGIS data layer shows affected areas on the map. The properties in those areas that result in the
best leads include ones with:

Market to specific property
owners

• Roofing materials consisting of wood shake, ceramic tiles, and composition shingles

• Available home equity greater than $200,000

• Square footage of at least 1,000

Business Data Examples

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Focus on prospective customers nearest to your established ones. Find businesses with specific
characteristics and fill gaps in schedules while you’re on the road using Salesforce Maps business
data. Add business prospects to Salesforce as prospecting accounts or leads.

In Salesforce Maps, create data layers using business data from DatabaseUSA.com and filters that
you define. Complement your prospecting efforts when you include helpful details for contacting
business contacts in marker popups. For example, include contact names, addresses, and any other
relevant details.

Plot the data layer on the map, which shows businesses based on the filters that you defined.
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After you identify prospects, choose whether to create leads or prospecting accounts in Salesforce, or add those prospects to your
schedule and routes.

These examples illustrate how different businesses can use business data available in Salesforce Maps for identifying new sales and
service prospects.

Business Data That Helps Identify New ProspectsExample

A property management company wants to grow their business in nearby industrial parks. Businesses
that the company’s leadership wants to focus on include:

Sell to businesses closest to your
established customers

• Specific words in their company names, NAICS codes, and SIC codes

• At least 10 employees at the corporate level

An emerging HVAC contracting firm identifies potential sales and service opportunities for businesses
with:

Identify buildings by size,
business type, and layout

• Square footage of at least 5,000

• At least 20 employees

• Business types that include specific NAICS codes

A sales rep for a medical supply company makes the most of her route and identifies nearby
businesses:

Fill scheduling gaps along your
route

• That include specific words in their company names, NAICS codes, and SIC codes

• Whose offices are within a 15-mile radius of her location

Demographic Data Examples

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Expand your business into untapped and underserved communities and diversify your recruiting
efforts among key populations using Salesforce Maps demographic data. Concentrations of your
search results appear on a map and help you identify where to focus your energy.

In Salesforce Maps, you create data layers using the Demographic Context (USA) data source and
filters that you define.
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Plot the data layer on the map, which shows concentrations of households who earn income based on the display options that you
specify.

After you identify concentrated areas, determine where to focus your efforts.

These examples illustrate how different institutions and businesses can use demographic data available in Salesforce Maps for identifying
populations and areas of interest for business and recruitment expansion.

Demographic Data That Helps Identify Populations and Areas of InterestExample

A college wants to increase applications in lower socioeconomic areas. Factors that matter to the
college board include:

Diversify your recruiting efforts

• Annual household income

• Children by age range

• Graduation rates among parents
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Demographic Data That Helps Identify Populations and Areas of InterestExample

A regional agricultural supply company considers expanding to another location within an 80-mile
radius of its flagship store. The company’s leadership considers ZIP codes and:

Provide products and services to
underserved communities

• Annual household income up to $70,000

• Household size

• People employed in agriculture and related trades

A residential care provider investigates locations for opening a facility in a county that has high
concentrations of:

Identify specific populations

• People age 75–84

• Households earning at least $72,000 annually

Requirements for Using Salesforce Maps Data

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Get access to Salesforce Maps and its data, set your goals, and interpret the data on the map. Later,
you generate leads or accounts from that data and determine whether marketing campaigns can
help you and your team reach your goals.

When you plot data from trusted data sources on a map, you increase your chances of reaching
and exceeding your sales and service targets. Choose from property, business, and demographic
data that helps you determine where to focus your efforts.

How?What to do

If you don’t have a license for Salesforce Maps, discuss your options with a Salesforce account executive. Your
account executive can help you determine whether it makes sense for you to purchase:

Get License

• Salesforce Maps as an add-on to Sales Cloud, Service Cloud, or an industry-specific offering such as Financial
Services Cloud, Healthcare Cloud, or Manufacturing Cloud

• Retail Execution in Consumer Goods Cloud, which comes standard with Salesforce Maps
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How?What to do

Develop a healthy pipeline of prospects that supplements your regular lead sources. Using Salesforce Maps
data, you can create leads or accounts for the properties and businesses that you want to pursue.

If you’re looking to expand your business into or recruit from untapped and underserved markets, determine
which population characteristics are more likely to respond to your offerings. For example, you want to focus
on counties with high populations and concentrations of households earning income within specific brackets.

Set Goal

Create data layers that you plot in Salesforce Maps. When you identify the data that represents the properties
and businesses that you want to pursue, you create leads using Click2Create in Salesforce Maps.

If you’re working with demographic data, you visualize areas on the map that offer greater potential for expanding
your business or recruiting talent efficiently.

Map Data

SEE ALSO:

Salesforce Help: Retail Execution at Your Fingertips

Considerations for Using Salesforce Maps Data

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Set your expectations for working with property, business, and demographic data. Salesforce Maps
data comes from numerous, trusted data providers such as ATTOM and DatabaseUSA.com.

Keep in mind that...When you...

Salesforce Maps is available at an extra cost with a variety of Salesforce
offerings. For example:

Consider
purchasing
Salesforce Maps
licenses

• Sales Cloud

• Service Cloud

• Retail Execution, which includes Salesforce Maps

• Other industry-specific offerings such as Financial Services Cloud,
Healthcare Cloud, and Manufacturing Cloud

Discuss your options with your Salesforce account executive.

If you import the data into Salesforce:Work with property
and business data • Some of that data doesn’t include email addresses. You can investigate

likely usernames and domain names for the property owners and
businesses that you want to contact.

• You choose between creating leads or accounts using Click2Create in
Salesforce Maps.

• You can manage and prevent duplicate data in Salesforce. Your Salesforce
admin can confirm whether duplicate management is turned on.

12

Finding New Business Using Salesforce Maps DataSalesforce Maps

https://help.salesforce.com/articleView?id=retail_concept_user_get_started.htm&language=en_US


Keep in mind that...When you...

The property, business, and demographic data available in Salesforce Maps can vary among providers
and your sources. If you identify inaccurate data:

Troubleshoot data issues

• Salesforce Customer Support can investigate potential data issues. If an issue originates in Salesforce
Maps, the Salesforce Maps product team can schedule its resolution.

• Salesforce can work with the data providers to correct inaccuracies. But Salesforce can’t control
whether or when providers resolve any of their inaccuracies.

Generating Leads and Identifying New Markets on a Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Sell to and provide services for property owners and businesses. Generate leads in Salesforce using
property and business data without time-consuming data entry. Determine which locations meet
your demographic requirements for business expansions and recruitment efforts in Salesforce Maps.

Explore Sales and Service Opportunities Among Property Owners

Identify properties that can benefit from your products and services using trusted property data
from ATTOM. Get insight on issued permits, loan positions and balances, and property features
and characteristics. Focus on specific cities and neighborhoods on a map using Salesforce Maps
data.

Promote Your Products and Services to Businesses

Provide sales and services to businesses near your established customers. Focus on specific
industries and locations using trusted US and Canadian business data from DatabaseUSA.com
that you plot in Salesforce Maps.

Branch into Untapped and Underserved Markets

Determine the best markets for expanding your business, diversify recruiting efforts based on specific demographics, and focus your
sales and service efforts among key populations. Visual indicators on a map show where you can concentrate your search for new
business opportunities and talent using demographic data in Salesforce Maps.

Explore Sales and Service Opportunities Among Property Owners

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

Identify properties that can benefit from your products and services using trusted property data
from ATTOM. Get insight on issued permits, loan positions and balances, and property features and
characteristics. Focus on specific cities and neighborhoods on a map using Salesforce Maps data.

1. Click Layers > Saved > Personal > New > Data Layer.
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2. Enter a name and a description for your data layer. Select the data source Property Data (USA).

3. Add filters so that you focus on specific property characteristics and locations. Then specify the details that you want to appear in
marker popups, such as names, addresses, and property characteristics.

4. Save your work, and then plot the data layer. Zoom to the area where you want to focus your efforts, and then refresh the layer for
that area.
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Markers that represent individual and clusters of properties appear. When you select any marker, you get access to details for the
properties represented in that marker.

5. To create leads for properties, click a marker, select Actions, and then click Click2Create. If you don’t have access to Click2Create,
ask your Salesforce admin for help.

Promote Your Products and Services to Businesses

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

Provide sales and services to businesses near your established customers. Focus on specific industries
and locations using trusted US and Canadian business data from DatabaseUSA.com that you plot
in Salesforce Maps.

1. Click Layers > Saved > Personal > New > Data Layer.
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2. Enter a name and a description for your data layer. Select the data source Business Data (USA).

3. Add filters so that you focus on specific property characteristics and locations. Then specify the details that you want to appear in
marker popups, such as contact names, addresses, and business characteristics.

4. Save your work, and then plot the data layer. Zoom to the area where you want to focus your efforts, and then refresh the layer for
that area.
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Markers that represent individual and clusters of businesses appear. When you select any marker, you get access to details for the
businesses represented in that marker.

5. To generate leads for businesses, click a marker, select Actions, and then click Click2Create. If you don’t have access to Click2Create,
ask your Salesforce admin for help.

Branch into Untapped and Underserved Markets

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

Determine the best markets for expanding your business, diversify recruiting efforts based on specific
demographics, and focus your sales and service efforts among key populations. Visual indicators
on a map show where you can concentrate your search for new business opportunities and talent
using demographic data in Salesforce Maps.

1. Click Layers > Saved > Personal > New > Data Layer.
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2. Enter a name and a description for your data layer. Select the data source Demographic Context (USA), and then select the level
of detail that you want to appear on the map such as neighborhoods or ZIP codes.

3. Add a filter so that you focus on a specific area such as a state or a county.

4. Add styles that help you differentiate areas that represent greater opportunities than others. For example, you want to focus on ZIP
codes where the most households earn between $50,000 and $59,999. To show you where to focus your energy, you set ranges
and corresponding colors that show concentrations of households earning income based on your selection.
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5. Save your work, and then plot the data layer. Zoom to the areas where you want to focus your efforts.

Salesforce Maps for Managers and Administrators

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Get your sales and service teams to spend more time building customer relationships and less time
on the road. Salesforce Maps and Salesforce Maps Advanced help your teams sell to and serve more
customers in less time and optimize routes for in-person visits.

Salesforce Maps Setup

Prepare field reps for improved efficiencies and higher profits. Set up features to help your reps
maximize selling and service time, and optimize routes.
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Salesforce Maps Advanced Setup

Reduce the time that sales and service managers and their reps spend planning customer visits. Automate schedules and routes for
your reps as far out as three months. The visit plans that you create get your teammates facing more customers and driving fewer
miles.

SEE ALSO:

Salesforce Maps

Salesforce Maps Developer Guide

Salesforce Maps Setup

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Prepare field reps for improved efficiencies and higher profits. Set up features to help your reps
maximize selling and service time, and optimize routes.

Installing and Giving Access to Salesforce Maps

Take the initial steps to help your field reps spend less time on the road and more time building
relationships with customers.

Controlling What Appears on Maps

Determine which objects and data that your reps can plot on the map in Salesforce Maps. Set
up and organize a folder structure for sharing layers or keeping them private among specific
reps.

Keeping Field Reps Safe During Customer Visits

Help your sales and service reps and their customers minimize the risk of exposure to COVID-19. Your reps request manager approval
for on-site customer visits directly in Salesforce Maps. When your reps arrive at and depart from approved, in-person customer visits,
prompt your reps to review and respond to your company’s safety guidelines.

Simplifying and Automating Processes for Field Reps

Help field reps spend less time tending to administrative duties and more time cultivating customer relationships using Salesforce
Maps.

Setup Reference

Learn about settings and options so that Salesforce Maps works for your reps and managers the way you intend.

SEE ALSO:

Salesforce Maps Developer Guide
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Installing and Giving Access to Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Take the initial steps to help your field reps spend less time on the road and more time building
relationships with customers.

1. Install Salesforce Maps

Get Salesforce Maps installed before you give your users access to it and its related products,
such as Salesforce Maps Territory Planning and Salesforce Maps Advanced.

2. Accessing Salesforce Maps Products

Ensure all your reps get access to Salesforce Maps products, including Salesforce Maps Advanced
and Territory Planning. And consider advantages and trade-offs for managing access through
default and custom permission sets.

3. Managing Permission Groups

Grant and restrict access for users and profiles in Salesforce Maps. If the default permission group doesn’t reflect the control that you
want for everyone in your company, create your own permission groups. Then, determine who can, for example, edit Salesforce
fields and export data.

4. Determine Who Can Access Features and Assign Routes

Control who sees what, who can assign routes, and whether reps can check out automatically after they leave a location, for example,
in Salesforce Maps.

5. Customizing Controls Available to Users

Control which action buttons your Salesforce Maps users can access. Create and maintain as many sets of buttons as you want to
assign to individual users and profiles.

Install Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To install packages:
• Download AppExchange

Packages

To configure installed
packages:
• Customize Application

Get Salesforce Maps installed before you give your users access to it and its related products, such
as Salesforce Maps Territory Planning and Salesforce Maps Advanced.

1. Click the installation URL that you received in an email message after you submitted the
Salesforce Maps order form email. Then log in to Salesforce.

2. Select Install for Admins Only.

3. Click Install.

4. Select Yes, grant access to these third party websites and click Continue.

5. If a message indicates that the installation is taking longer than expected, click Done.

We send you an email notification after the installation finishes. The installed package appears
as a trial for up to 72 hours.
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Accessing Salesforce Maps Products

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Ensure all your reps get access to Salesforce Maps products, including Salesforce Maps Advanced
and Territory Planning. And consider advantages and trade-offs for managing access through default
and custom permission sets.

Methods for Managing Access to Salesforce Maps Products

Consider the impact of giving your reps access using recommended default permission sets
compared with custom ones that you create.

Give Users Access to Salesforce Maps Products

Grant access to Salesforce Maps products, including Territory Planning and Salesforce Maps
Advanced.

Methods for Managing Access to Salesforce Maps Products

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Consider the impact of giving your reps access using recommended default permission sets
compared with custom ones that you create.

ConsiderationsAdvantagesType of
Permission
Sets

Default •• Some companies prefer to provide
lower-level access to certain fields than
what default permission sets provide.

They include access to fields and
features that meet the most
common security requirements for
companies. • Default permission sets don’t provide

options for fine-tuning field access.• When Salesforce periodically
updates security requirements and
releases new features, default
permission sets include those
updates.

Custom • When Salesforce periodically updates
security requirements and releases

• They give you options for
fine-tuning field access for your
specific security requirements. new features, it’s up to you to update

your custom permission sets.• It’s easy to create custom
permission sets when you clone
the default ones.

• If you don’t update your custom
permission sets, your reps can lose
access to certain features.

SEE ALSO:

Knowledge Article: Updates to Include in Custom Permission Sets for Salesforce Maps Products
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Give Users Access to Salesforce Maps Products

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To assign user permission
sets:
• Assign Permission Sets

Grant access to Salesforce Maps products, including Territory Planning and Salesforce Maps
Advanced.

1. From Setup, in the Quick Find box, enter Users, and then select Users.

2. Select a user that you want to grant access to Salesforce Maps and its related products.

3. In the Permission Set License Assignments section, click Edit Assignments.

4. Enable the Salesforce Maps permission set licenses that you want your user to access. Then
save your changes.

5. In the Permission Set Assignments section, click Edit Assignments.

6. Select the permission sets that correspond to the permission set licenses that you enabled.

Corresponds with This Permission SetThe Permission Set
License...

SF MapsSalesforce Maps

SF Maps Territory PlanningSalesforce Maps Territory
Planning

SF Maps Territory Planning for Sales Planning (Requires Sales
Planning)

None

SF Maps AdvancedSalesforce Maps Advanced

SF Maps Community LoginsSalesforce Maps Community
Logins

SF Maps Community Named UserSalesforce Maps Community
Named User

SF Maps Live AdminSalesforce Maps Live Admin

SF Maps Live Mobile TrackingSalesforce Maps Live Mobile
Tracking

7. For users who are also admins for Salesforce Maps products, select the Maps Admin permission set. This permission set is in addition
to the permission sets you selected in the previous step.

8. Click Add, and then save your changes.
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Managing Permission Groups

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Grant and restrict access for users and profiles in Salesforce Maps. If the default permission group
doesn’t reflect the control that you want for everyone in your company, create your own permission
groups. Then, determine who can, for example, edit Salesforce fields and export data.

Create Permission Groups

Determine who you let, for example, edit field labels, export data, and create data layers in
Salesforce Maps.

Edit Permission Groups

Update permissions that you assigned to users and profiles in Salesforce Maps. That way, your
permission groups accurately reflect the authorization you intend for your company.

Create Permission Groups

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Determine who you let, for example, edit field labels, export data, and create data layers in Salesforce
Maps.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Permission Groups > New.

4. Give your permission group a name and a description. Then save your work.

5. Click Edit, then select the permissions that you want for your users. Assign users and profiles to the permission group.
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6. Save your changes.

SEE ALSO:

Permission Group Settings

Edit Permission Groups

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Update permissions that you assigned to users and profiles in Salesforce Maps. That way, your
permission groups accurately reflect the authorization you intend for your company.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Permission Groups, and then select the permission group you want to edit.

4. Select the permissions that you want for your users and profiles.

5. Save your changes.

SEE ALSO:

Permission Group Settings
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Determine Who Can Access Features and Assign Routes

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Control who sees what, who can assign routes, and whether reps can check out automatically after
they leave a location, for example, in Salesforce Maps.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Settings > General. Then, select the features of your choice.

Avoid selecting Debug Logs, because we reserve that for Salesforce Customer Support.

4. Save your work.

SEE ALSO:

General Settings Options

Customizing Controls Available to Users

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Control which action buttons your Salesforce Maps users can access. Create and maintain as many
sets of buttons as you want to assign to individual users and profiles.

1. Create and Maintain Button Sets

Determine which Salesforce Maps buttons you want available to individual users and profiles.
For example, let users in a specific territory or industry add markers to routes and schedules,
modify records, and log activities.

2. Create Custom Actions Buttons

Give your reps access to web pages, Lightning web components, and flows from markers on
the map. Add your customized actions to buttons that you include in Salesforce Maps button
sets.

3. Configure Custom Actions That Include Lightning Web Components and Flows

Show headers and buttons from Lightning web components and screen flows in custom actions without the standard, redundant
ones that Salesforce Maps add.

4. Assign Button Sets

Control which Salesforce Maps buttons individual users and profiles access based on the button sets you create.
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Create and Maintain Button Sets

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Determine which Salesforce Maps buttons you want available to individual users and profiles. For
example, let users in a specific territory or industry add markers to routes and schedules, modify
records, and log activities.

1. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Settings > Button Sets.

4. To create a button set, select Create New. Then, give your button set a name.

To maintain a button set, select the one you want to change.

5. Drag buttons between the layouts. To remove buttons, drag them to the Available Buttons
section.

SEE ALSO:

Button Sets Options

Create Custom Actions Buttons

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Give your reps access to web pages, Lightning web components, and flows from markers on the
map. Add your customized actions to buttons that you include in Salesforce Maps button sets.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Select Settings > Custom Actions.

4. Select Create. Then give your custom action button a name and select whether you want the
button to appear on selected base objects and on desktop and mobile apps.

5. Specify any requirements for the custom actions button to appear.
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6. Configure processes and automation.

Add automation that saves your reps time and helps them comply with company policies. For example, send your reps to a page
when you add a URL in the free text field. Other options let you load a specific Lightning web component or trigger a flow within
the custom actions window.

7. Save your work.

8. Add your new button to any button sets.

Configure Custom Actions That Include Lightning Web Components and Flows

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Show headers and buttons from Lightning web components and screen flows in custom actions
without the standard, redundant ones that Salesforce Maps add.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Click Settings, and then click Custom Actions.

4. Select the custom action from which you want to remove the Salesforce Maps header and
button. Then select Hide custom action header and footer.
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5. Save your changes.

6. Configure the close button that appears as part of your Lightning web component within the custom actions window. Add this
attribute to your component’s code.

<aura:attribute name="MapsCloseAction" type="Aura.action" access="global"/>

Then, add this logic to the component’s JavaScript controller.

const MapsCloseAction =
component.get("v.MapsCloseAction");$A.enqueueAction(MapsCloseAction);

The custom action window appears without the standard Salesforce Maps title and close button.
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Assign Button Sets

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Control which Salesforce Maps buttons individual users and profiles access based on the button
sets you create.

1. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Permission Groups, and then select the permission group to which you want to assign
the button set.

4. In the Button Set field, select the button set that you want to assign to the permission group.

5. Save your work.

Controlling What Appears on Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Determine which objects and data that your reps can plot on the map in Salesforce Maps. Set up
and organize a folder structure for sharing layers or keeping them private among specific reps.

Determining What Reps Can Plot on the Map

Set up and manage base objects that correspond with the Salesforce records that your reps
want to plot in Salesforce Maps. Help your reps reach and maintain peak productivity when
you include data from Salesforce and any proprietary and third-party data providers.

Managing Shape Layers to Show Specific Areas on the Map

Map specific areas using geographic boundaries such as countries, states, counties, census
tracts, and postal codes in Salesforce Maps. Manage how boundaries appear in shape layers
using filter, draw, copy, and adjust features.

Managing Marker Layers to Show Records on the Map

Help sales and service managers and reps visualize their business-critical data using Salesforce Maps marker layers. Apply filters and
styles to configure marker layers for specific business requirements.

Including External Data on the Map

Help your company grow by setting up location analysis that shows specific proprietary and third-party data in Salesforce Maps. For
example, focus on revenue or census data for conducting in-depth market research, scouting out new business locations, and
discovering prospects.

Showing Utility Lines on the Map

Retain customers and meet expectations when you support reps’ efforts to address utility issues quickly by setting up polyline layers
in Salesforce Maps. Plot spans that visualize records’ polylines and select those records when planning work, such as trimming a tree
that’s interfering with transmission lines. Then use mass actions to add the line and tree’s location to a route for your service team.

Locating Assets on the Map

Gain insights into how your sales and service teams are operating. Analyze real-time and historical data to identify opportunities for
growth, safety, and efficiency in Salesforce Maps. For example, dispatch the nearest driver to a service call when you see your drivers’
locations on the map.
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Organizing Layers in Folders

Organize layers in private folders. With folder permissions, you have control to create public folders within the Corporate folder, and
then specify who gets access to them in Salesforce Maps.

Determining What Reps Can Plot on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Set up and manage base objects that correspond with the Salesforce records that your reps want
to plot in Salesforce Maps. Help your reps reach and maintain peak productivity when you include
data from Salesforce and any proprietary and third-party data providers.

Edit Base Objects

Customize the base objects that correspond with the records that appear for your reps in
Salesforce Maps. If the standard base objects don’t meet your company’s needs, tweak the base
objects for a better fit.

Create Base Objects to Plot on Maps

In addition to the commonly used base objects that Salesforce Maps plots for you, you can add
other objects that help your reps in the field. Base objects can represent either Salesforce objects
that include addresses, or Salesforce objects that look up to ones that include addresses.

Plot Any Salesforce Data on the Map

Visualize record data for objects that rely on addresses from a related object in Salesforce Maps. For example, your reps work with
consumer goods and want to plot visit records, but the records don’t include addresses. To get visit records to appear on the map,
set up your Visit base object to include address fields from Retail Store or other related objects.

Plot Customer Data from Proprietary and Third-Party Systems

Work with data that your company stores outside Salesforce directly in Salesforce Maps. Establish routes between Salesforce records
that your reps plot on the map and records that your company stores in other systems. For example, let your reps plot unqualified,
mail-in leads from your company’s lead generation system and update it with geographical coordinates from Salesforce Maps. Or
route auto body repair shops stored in Salesforce records to insurance adjusters stored in records on premises.

Include Dynamic Context Relevant to Plotted Salesforce Records

Add context to Salesforce records when your reps plot them in Salesforce Maps. Help your reps focus on what’s important using
layers with dynamic filters for ID and string fields such as Owner ID and Billing State. For example, from Salesforce, your rep plots an
account on the map. Accounts belonging to that rep within the plotted account’s state also appear on the map.

Optimize POI and Search Performance

Improve loading times for points-of-interest and search results when you exclude base objects that don’t concern you from global
search in Salesforce Maps.
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Edit Base Objects

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Customize the base objects that correspond with the records that appear for your reps in Salesforce
Maps. If the standard base objects don’t meet your company’s needs, tweak the base objects for a
better fit.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Base Object > Edit Existing.

4. Select the base object that you want to edit.

5. Select an address location based on either the corresponding Salesforce object, or a related
Salesforce record’s ID.

For example, you edit the Opportunity base object because you want opportunities to reflect
the address of their respective accounts—not the opportunities themselves. So you select
Account ID. Salesforce Maps uses this address to plot markers and records on the map.

Or, you want billing accounts to reflect the address that’s on the billing accounts. So you select
This Object.

6. If you want, select the record type to which this base object applies.

7. Select the address and coordinate the options that you want maps to reference. Select among standard and custom address fields.

For example, to let field reps see account locations based on billing addresses, select addresses and coordinates from the account
billing address.

8. Save your changes.

SEE ALSO:

Base Objects Settings
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Create Base Objects to Plot on Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

In addition to the commonly used base objects that Salesforce Maps plots for you, you can add
other objects that help your reps in the field. Base objects can represent either Salesforce objects
that include addresses, or Salesforce objects that look up to ones that include addresses.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Base Object > Create New.

4. Select the Salesforce object that you want to appear on maps.

For example, you want to plot cases from high-revenue accounts. So you select Case.

5. Enter a name. Then select an address location based on either the corresponding Salesforce
object, or a related Salesforce record’s ID.

For example, you want cases to reflect the address of their respective accounts—not the cases
themselves. So you select Account ID.

6. Select the address and coordinate the options that you want maps to reference. Select among standard and custom address fields.

For example, you want field reps to see account locations based on billing addresses. So you select addresses and coordinates from
the account billing address.
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7. Save your changes.

SEE ALSO:

Base Objects Settings

Plot Any Salesforce Data on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Visualize record data for objects that rely on addresses from a related object in Salesforce Maps. For
example, your reps work with consumer goods and want to plot visit records, but the records don’t
include addresses. To get visit records to appear on the map, set up your Visit base object to include
address fields from Retail Store or other related objects.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Select Base Object.

4. From the base object for the records that your reps want to plot on the map, select the address
location field such as PlaceID. Then select the related object from which you want to specify
the address fields such as Address.

5. Select the address fields that you want to plot on the map from the related object.

6. Save your changes.

34

Salesforce Maps SetupSalesforce Maps



Plot Customer Data from Proprietary and Third-Party Systems

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Work with data that your company stores outside Salesforce directly in Salesforce Maps. Establish
routes between Salesforce records that your reps plot on the map and records that your company
stores in other systems. For example, let your reps plot unqualified, mail-in leads from your company’s
lead generation system and update it with geographical coordinates from Salesforce Maps. Or route
auto body repair shops stored in Salesforce records to insurance adjusters stored in records on
premises.

1. Follow the steps to create, connect to, and validate external data sources. When you create
external objects, you can set them up to write geographical coordinates from Salesforce Maps
to your source systems. To do so, select Writable External Objects.

2. Confirm and update these settings for all latitude and longitude fields in your external objects.

To...Set...

NumberData Type

3Length

15Decimal Places

3. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed Packages.

4. Click Configure next to the Salesforce Maps package.

5. Create a base object. View all Salesforce objects, and then select the external object that you created. Name the base object and
add a description.

6. Map any address and coordinate fields.
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7. Save your work.
Your reps can now create marker layers using the base object that connects to your external data source.

Include Dynamic Context Relevant to Plotted Salesforce Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Add context to Salesforce records when your reps plot them in Salesforce Maps. Help your reps
focus on what’s important using layers with dynamic filters for ID and string fields such as Owner
ID and Billing State. For example, from Salesforce, your rep plots an account on the map. Accounts
belonging to that rep within the plotted account’s state also appear on the map.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Select Base Object > Edit, and then select the base object for the records that your reps plot
on the map.

4. Scroll to Button URL and click Select.

The button URL copies to your clipboard. You later paste that URL when you create a button in the base object’s corresponding
Salesforce object.

5. In object manager settings, select the object for the records that your reps plot, such as Account. Then select Buttons, Links, and
Actions > New Button or Link.

6. Enter a label and a name, and then paste the button URL from your clipboard.
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To specify a layer that loads when your reps plot records on the map, append the parameter &layerid=  and the layer’s ID that
you copy from the maps__MarkerLayer__c object. To include fields with dynamic filtering such as Owner ID and Billing State, add
a pipe character and then select the fields, each separated by pipe characters.

7. Save your changes.

8. Add the custom button to your page layout, and then save your changes.

The custom button appears on accounts.
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Optimize POI and Search Performance

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Improve loading times for points-of-interest and search results when you exclude base objects that
don’t concern you from global search in Salesforce Maps.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Base Object > Edit Existing.

4. Select the Salesforce object that you want to exclude from global search.

5. Scroll to Advanced Options and select Disable Global Search.

6. Save your changes.

Managing Shape Layers to Show Specific Areas on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Map specific areas using geographic boundaries such as countries, states, counties, census tracts,
and postal codes in Salesforce Maps. Manage how boundaries appear in shape layers using filter,
draw, copy, and adjust features.

Shape Layers and Data Source Updates

Anticipate how changes to geographic boundaries such as countries, states, counties, census
tracts, and postal codes can affect your sales and service efforts using Salesforce Maps.

Create Shape Layers

Design and map layers that you plot on the map. Create layers when you define shapes using
countries, filters, drawing tools, or postal codes.

Edit Shape Layers

Set the geographic shape areas you see on the map, what details they show, and how they appear.
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Shape Layers and Data Source Updates

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Anticipate how changes to geographic boundaries such as countries, states, counties, census tracts,
and postal codes can affect your sales and service efforts using Salesforce Maps.

Salesforce Maps works with providers, such as the US government, that supply data for your shape
layers. Periodically, these providers update their data, which means that your shape layers reflect
those updates. When providers update data:

• Incrementally and frequently, such as for counties and postal codes, in some cases you notice
minor changes to your shape layers.

• Infrequently, such as for census tracts every 10 years, your shape layers can change drastically.

Regardless of the frequency of these data updates, Salesforce Maps can’t control whether and when
providers update the data resulting in the boundaries that appear in your shape layers.

Create Shape Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Design and map layers that you plot on the map. Create layers when you define shapes using
countries, filters, drawing tools, or postal codes.

1. Click Layers.

2. To save the shape layer privately so only you can see it, click Saved > Personal. Or, to share
the shape layer with other maps users, click Saved > Corporate.

3. Hover over New and select Shape Layer.
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4. Enter a name and description.

5. Click Next.

6. Select a shape using filters, drawing on the map, or pasting postal codes.

For example, to see all the neighborhoods in San Francisco, select United States > Neighborhoods, and then add a county filter.

7. To create a label, adjust colors, and change other options for how your shape layer looks, click Display.

8. Save and plot your changes.
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Edit Shape Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Set the geographic shape areas you see on the map, what details they show, and how they appear.

1. Click Layers.

2. Enter the name of the shape layer you want to edit or click Saved and select the folder that
contains the shape layer you want to edit.

3. Hover over the shape layer menu and click Edit.

4. Select the tab for the area you want to edit. Then make your changes.

5. Save your changes.
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Managing Marker Layers to Show Records on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Help sales and service managers and reps visualize their business-critical data using Salesforce Maps
marker layers. Apply filters and styles to configure marker layers for specific business requirements.

Create Marker Layers

Determine what customer data to include on the map and how it appears so that managers
and reps can find and service the records efficiently. Select the Salesforce Maps base objects
with records that you want to show on the map.

Edit Marker Layers

Determine which records you see on the map, what details they show, and how they appear.

Create Marker Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Determine what customer data to include on the map and how it appears so that managers and
reps can find and service the records efficiently. Select the Salesforce Maps base objects with records
that you want to show on the map.

1. Click Layers.

2. To save the marker layer privately so only you can see it, click Saved > Personal. Or, to share
the marker layer with other maps users, click Saved > Corporate.

3. Hover over New, and select Marker Layer.

4. Enter a name and description.
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5. Select the base object with records that you want to show on maps.

6. Click Next.

7. Select the filter and style options that you want the marker layer to show.

8. Save your changes.

SEE ALSO:

Determining What Reps Can Plot on the Map

Marker Layer Options

Edit Marker Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Determine which records you see on the map, what details they show, and how they appear.

1. Click Layers.

2. Enter the name of the marker layer that you want to edit, or click Saved, and then select the
folder that contains the maker layer that you want to edit.

3. Hover over the marker layer menu, and click Edit.
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4. Save your changes.

SEE ALSO:

Determining What Reps Can Plot on the Map

Marker Layer Options

Including External Data on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Help your company grow by setting up location analysis that shows specific proprietary and
third-party data in Salesforce Maps. For example, focus on revenue or census data for conducting
in-depth market research, scouting out new business locations, and discovering prospects.

Create Data Layers

Determine what data you want to show in Salesforce Maps according to your business
development and prospecting needs. Customize the data source, filter results, and style the
data layer.

Edit Data Layers

Adjust the sources, filters, or style of your plotted data layers and corresponding popup in
Salesforce Maps.

Create Data Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Determine what data you want to show in Salesforce Maps according to your business development
and prospecting needs. Customize the data source, filter results, and style the data layer.

1. Click Layers.

2. To save the data layer privately so only you can see it, click Saved > Personal. Or, to share the
data layer with other maps users, click Saved > Corporate.

3. Hover over New and select Data Layer.

4. Name the data layer and select the data source, filter, and style options you want the data layer
to show. Popups provide helpful default topics preselected for some data sources, which you
can edit at any time.
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5. Save your changes.

Data layers plot results in the visible map area by default. To plot the data layer in different area, move the map and refresh the layer.

Tip:  Using the data plotted on the map, create Salesforce records quickly with Salesforce Maps Click2Create.

SEE ALSO:

Fields for Business Data (USA)

Fields for Property Data (USA)

Edit Data Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Adjust the sources, filters, or style of your plotted data layers and corresponding popup in Salesforce
Maps.

1. Click Layers.

2. Enter the name of the data layer you want to edit or click Saved and select the folder that
contains the data layer you want to edit.

3. Hover over the data layer menu and click Edit.

4. Select the tab for the area you want to edit. Then make your changes.
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5. Save your changes.

SEE ALSO:

Fields for Business Data (USA)

Fields for Property Data (USA)

Showing Utility Lines on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Retain customers and meet expectations when you support reps’ efforts to address utility issues
quickly by setting up polyline layers in Salesforce Maps. Plot spans that visualize records’ polylines
and select those records when planning work, such as trimming a tree that’s interfering with
transmission lines. Then use mass actions to add the line and tree’s location to a route for your
service team.

Create Polyline Layers

Show utility lines on the map so reps can manage and respond to service calls quickly and
efficiently in Salesforce Maps. Add filters that determine which polylines show up on the map,
such as accounts in certain states or area codes.

Edit Polyline Layers

Update polyline layers as your business changes and grows. Change which records you see on
the map and adjust their filters, display options, and popups in Salesforce Maps.

Create Polyline Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Show utility lines on the map so reps can manage and respond to service calls quickly and efficiently
in Salesforce Maps. Add filters that determine which polylines show up on the map, such as accounts
in certain states or area codes.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Choose a permission group and enable polyline layers under Layers.
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4. In Salesforce Maps Base Objects settings, select the base object that you want to plot polyline layers for, such as Account.

a. Configure the latitude and longitude fields.

b. Assign at least two geolocation fields to two vertices. Then click Save.

5. In Salesforce Maps, click Layers.

6. To save the polyline layer privately so only you can see it, click Saved > Personal. Or, to share the polyline layer with other maps
users, click Saved > Corporate.

7. Hover over New and select Polyline Layer.

8. Enter a name and description.

9. Select the base object to plot.

10. Click Next.
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11. Choose the filter and style options that you want your polyline layer to show.

12. Save and plot your work.
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Edit Polyline Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To access Salesforce Maps:
• Salesforce Maps

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Update polyline layers as your business changes and grows. Change which records you see on the
map and adjust their filters, display options, and popups in Salesforce Maps.

1. Click Layers.

2. Enter the name of the polyline layer you want to edit, or click Saved and select the folder that
contains the polyline layer you want to edit.

3. Hover over the polyline layer menu and click Edit.

4. Select the tab for the area you want to edit. Then make your changes.

5. Save your changes.
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Locating Assets on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Gain insights into how your sales and service teams are operating. Analyze real-time and historical
data to identify opportunities for growth, safety, and efficiency in Salesforce Maps. For example,
dispatch the nearest driver to a service call when you see your drivers’ locations on the map.

Create Live Layers

Give sales and service managers insight into drivers and routes. With Salesforce Maps live layers,
managers can see live and historical locations of vehicles, equipment, and users in the field.
Select which assets appear on the map, what details they show, and how they look.

Edit Live Layers

Update live layers in Salesforce Maps to account for changes in vehicles, equipment, and users
in the field, and how they appear on the map.

Create Live Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Give sales and service managers insight into drivers and routes. With Salesforce Maps live layers,
managers can see live and historical locations of vehicles, equipment, and users in the field. Select
which assets appear on the map, what details they show, and how they look.

1. Click Layers.

2. To save the live layer privately so only you can see it, click Saved > Personal. Or, to share the
live layer with other maps users, click Saved > Corporate.

3. Hover over New and select Live Layer.

4. Select the base object with the records that you want to appear on maps.

5. Click Continue.

6. Enter a name and description.
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7. Select the filter and style options that you want the live layer to show.

8. Save your changes.

Edit Live Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To access the shared
Corporate folder:
• Folder Permissions

Update live layers in Salesforce Maps to account for changes in vehicles, equipment, and users in
the field, and how they appear on the map.

1. Click Layers.

2. Enter the name of the live layer that you want to edit, or click Saved, and then select the folder
that contains the live layer that you want to edit.

3. Hover over the live layer menu, and click Edit.

4. Save your changes.
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Organizing Layers in Folders

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Organize layers in private folders. With folder permissions, you have control to create public folders
within the Corporate folder, and then specify who gets access to them in Salesforce Maps.

Create Folders for Organizing Layers

Store, access, and organize layers in private folders. Or with folder permissions, you can create
shared folders within the Corporate folder.

Set Permissions for Shared Folders Used to Organize Layers

Specify which users and profiles can access your shared folders within the Corporate folder and
the layers inside them.

SEE ALSO:

Determine Who Can Access Features and Assign Routes

General Settings Options

Managing Permission Groups

Create Folders for Organizing Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Store, access, and organize layers in private folders. Or with folder permissions, you can create shared
folders within the Corporate folder.

1. In Salesforce Maps, click Layers > Saved.

2. Select either Personal or Corporate, depending on whether you want to create a private or
a shared folder.

3. Hover over New, and then click Folder.
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4. Enter a unique name, and then click Create.

SEE ALSO:

Set Permissions for Shared Folders Used to Organize Layers

Create Marker Layers

Create Shape Layers

Set Permissions for Shared Folders Used to Organize Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

To set folder permissions:
• Folder Permissions

Specify which users and profiles can access your shared folders within the Corporate folder and the
layers inside them.

1. In Salesforce Maps, click Layers > Saved.

2. Select Corporate.

3. Right-click the folder that you want to set permissions for. Then, click Edit Permissions.

4. To add a permission, click Create New > User or Create New > Profile. Then, search for the user or profile that you want to set
permissions for.

5. Set the permissions that you want to grant to your user or profile. Then, save your changes.
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SEE ALSO:

Determine Who Can Access Features and Assign Routes

Create Folders for Organizing Layers

Keeping Field Reps Safe During Customer Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Help your sales and service reps and their customers minimize the risk of exposure to COVID-19.
Your reps request manager approval for on-site customer visits directly in Salesforce Maps. When
your reps arrive at and depart from approved, in-person customer visits, prompt your reps to review
and respond to your company’s safety guidelines.

1. Your Company’s Safety Guidelines

Minimize the risk of exposure to COVID-19 among your sales and service reps and their customers
during in-person visits when you provide critical guidance from your company in Salesforce
Maps. Create safety checklists that capture guidance from your company’s leaders and state
and local governments.

2. Establishing an Approval Processes for In-Person Customer Visits

Automate processes that help sales and service reps request manager approval for on-site
customer visits and adhere to your company’s COVID-19 safety guidelines. Show your reps which customers they’re approved to
meet using visual indicators that you configure in Salesforce Maps.

3. Prompting Field Reps to Respond to Safety Guidelines

Encourage your sales and service reps to minimize risk of exposure to COVID-19. Prompt them to review and respond to your
company’s safety guidelines in Salesforce Maps. Automate prompts whenever your reps arrive at and depart from in-person customer
visits.

4. Identifying Trends for New COVID-19 Cases

Give sales and service managers and their field reps tools to use to make informed decisions before they schedule in-person customer
visits. Show trends over 14-day moving averages within US counties in Salesforce Maps. Adding an ArcGIS layer shows uptrends,
downtrends, and trend duration.

Your Company’s Safety Guidelines
Minimize the risk of exposure to COVID-19 among your sales and service reps and their customers during in-person visits when you
provide critical guidance from your company in Salesforce Maps. Create safety checklists that capture guidance from your company’s
leaders and state and local governments.
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Craft your guidelines using our samples for inspiration.

Review These SamplesFor...

Employee health • I haven’t tested positive for COVID-19 in the past 14 days.

• I’ve measured my body temperature within the last 3 hours, and the reading was lower than 100.4  or 38 .

• I’m not experiencing any symptoms consistent with COVID-19.

• I’ve completed my wellness check-in through work.com.

Employee safety • I haven’t had contact with anyone confirmed or suspected of having COVID-19 in the past 14 days.

• I agree to report any suspected exposure to COVID-19.

• I haven’t traveled outside my state or province, except for my regular work commute or other day-to-day
reasonable activities in the past 14 days.

• I agree to maintain a distance of at least 6 feet (or roughly 2 meters) from others and to not shake hands or
share or exchange items.

• I agree to use applicable personal protective equipment such as face coverings.

• I agree to practice good health hygiene such as washing my hands, not touching my face, and applying hand
sanitizer.

• I’ve reviewed case trends for this location and its surrounding counties.

Customer safety • My customer provided documented consent for this in-person visit.

• My customer has had the opportunity to communicate all requirements for a safe meeting.

When your field reps arrive at or depart from customer visits, prompt them to review and respond to your company’s guidelines. Always
refer to your state and local government regulations.

Establishing an Approval Processes for In-Person Customer Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Automate processes that help sales and service reps request manager approval for on-site customer
visits and adhere to your company’s COVID-19 safety guidelines. Show your reps which customers
they’re approved to meet using visual indicators that you configure in Salesforce Maps.

1. Setting Up an Object for Manager Approvals

Handle and store manager approvals for on-site customer visits using a custom object that you
create in Salesforce. Let sales and service reps request their manager’s approval for visits directly
from marker pop-ups in Salesforce Maps.

2. Creating Email Templates for On-Site Visit Requests

Keep your sales and service reps informed about the statuses of their on-site visit requests.
Automate email notifications that tell reps when they submit requests through Salesforce Maps
and whether their managers approve or deny visits to specific customers.

3. Developing a Process to Approve On-Site Visits

Automate processes for submitting, approving, and denying requests for in-person customer visits from sales and service reps. Your
reps submit requests for visits to managers through Salesforce Maps.
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4. Create On-Site Visit Requests for New Records

Automate the submission of requests for on-site visits when sales and service reps create accounts in Salesforce Maps.

5. Building the Flow for On-Site Visit Requests

Automate processes for submitting, approving, and denying requests for in-person customer visits from sales and service reps. Your
reps submit requests to managers through Salesforce Maps.

6. Preparing Salesforce Maps for On-Site Approval Requests

Let your sales and service reps submit requests for in-person customer visits directly in Salesforce Maps. Provide visual indicators for
your reps so that they identify which customers they’re approved to visit.

Setting Up an Object for Manager Approvals

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Handle and store manager approvals for on-site customer visits using a custom object that you
create in Salesforce. Let sales and service reps request their manager’s approval for visits directly
from marker pop-ups in Salesforce Maps.

1. Create an Object for Approvals

Set up a custom object that handles manager approvals for on-site customer visits. Sales and
service reps request approvals directly in Salesforce Maps.

2. Add Fields for Approvals

Set up fields that managers require for determining whether to approve on-site visits. Sales and
service reps request approvals directly from marker pop-ups in Salesforce Maps.

3. Set Permissions for Approvals

Give managers and their field reps access to the custom object that you created for handling and storing approvals using profile-based
permissions. Sales and service reps submit approval requests from marker pop-ups in Salesforce Maps.

4. Add Approval Status Fields to Records

Let managers and their sales and service reps track statuses of on-site visit requests when they view records, such as accounts, and
plot marker layers in Salesforce Maps. Set up an on-site approval status field on the object for the records that reps plot on the map.

5. Prevent Changes to Statuses on the Object for Approvals

Ensure that on-site approval statuses change only through the approval process when you set the approval status field for on-site
visits to read-only. Sales and service reps request approval from marker pop-ups in Salesforce Maps, then managers approve or deny
those requests.

6. Prevent Changes to Approval Statuses on Records

Require sales and service reps to adhere to the process for scheduling in-person visits when you set the on-site approval field that
appears on records to read-only.

7. Sync On-Site Approval Status Fields

Sync the statuses of on-site requests between on-site approval records for handling and storing approvals and records related to
them, such as accounts. For example, when managers approve requests for accounts, trigger code updates the statuses for on-site
approval records. When statuses for on-site approval records sync with account records, sales and service reps see which accounts
they’re approved to visit based on color-coded markers in Salesforce Maps.
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Create an Object for Approvals

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create custom objects:
• Customize Application

Set up a custom object that handles manager approvals for on-site customer visits. Sales and service
reps request approvals directly in Salesforce Maps.

1. From Object Manager in Setup, select Create > Custom Object.

2. Enter a label and a description, then set the label for the record name and the data type.

3. Select Allow Reports, Allow Activities, and Allow in Chatter Groups. Then save your work.

Add Fields for Approvals

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create fields:
• Customize Application

Set up fields that managers require for determining whether to approve on-site visits. Sales and
service reps request approvals directly from marker pop-ups in Salesforce Maps.

1. From Object Manager in Setup, select the object you created for manager approvals.

2. Click Fields & Relationships > New.

3. Create these fields, then add them to the page layout for the object you created for manager
approvals.

Do ThisFor the
property...

Field for...

Select Lookup Relationship.Field TypeManager who
approves

Select User.Related To

Enter Approving Manager.Field Label

Accept the default settings.Field-Level
Security

Select Master-Detail Relationship.Field TypeRelated account

Select Account or the type of record that your reps
plot.

Related To

Enter Related To.Field Label

Select Account or the type of record that your reps
plot.

Custom
Related List
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Do ThisFor the property...Field for...

Select Formula.Field TypeAccount address

Enter Location.Field Label

Select Text.Formula Return Type

Enter the formula:

Related_To__r.BillingStreet & " " & BR()&
Related_To__r.BillingCity & ", " &

Formula

Related_To__r.BillingState & " " &
Related_To__r.BillingPostalCode

Accept the default settings.Field-Level Security

Select Picklist.Field TypeApproval status

Enter Status.Field Label

Select Enter Values, with each value separated by a new line. On
separate lines, enter:

Values

• Request not submitted

• Request submitted

• Approved

• Denied

Then select:

• Use first value as default value

• Restrict picklist to the values defined in the value set

Accept the default settings.Field-Level Security

4. Save your work.
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Set Permissions for Approvals

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set permissions:
• Customize Application

Give managers and their field reps access to the custom object that you created for handling and
storing approvals using profile-based permissions. Sales and service reps submit approval requests
from marker pop-ups in Salesforce Maps.

1. From Setup, go to Users > Profiles.

2. Click the name of the profile that you want to have access to on-site approvals.

3. Click Object Settings.

4. Click your approval object.

5. Click Edit, then select the object permissions:

• Read

• Create

• Edit

• Delete

• View All

6. Save your work. Repeat steps 1 through 5 for all profiles you want to have access to on-site approvals.
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Add Approval Status Fields to Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create fields:
• Customize Application

Let managers and their sales and service reps track statuses of on-site visit requests when they view
records, such as accounts, and plot marker layers in Salesforce Maps. Set up an on-site approval
status field on the object for the records that reps plot on the map.

1. From Object Manager in Setup, select the object that you related to your on-site approval object,
such as Account.

2. Click Fields & Relationships > New.

3. Create an approval status field, then add it to the page layouts where you want statuses for
on-site visit requests to appear.

Do ThisFor...

Select Picklist.Field Type

Enter a label such as On-Site Approval Status.Field Label

Select Enter Values, with each value separated by a new line. Then on separate lines, enter the
statuses:

Values

• Request not submitted

• Request submitted

• Approved

• Denied

Then select:

• Use first value as default value

• Restrict picklist to the values defined in the value set

Accept the default settings.Field-Level Security

4. Save your work.
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Prevent Changes to Statuses on the Object for Approvals

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To specify access for objects:
• Customize Application

Ensure that on-site approval statuses change only through the approval process when you set the
approval status field for on-site visits to read-only. Sales and service reps request approval from
marker pop-ups in Salesforce Maps, then managers approve or deny those requests.

1. From Object Manager in Setup, select the object you created for manager approvals.

2. Click Page Layouts > On-Site Approval Layout.

3. Hover over Status, then click .

4. Select Read-Only, then click OK.

5. Save your work.

Prevent Changes to Approval Statuses on Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set access for fields:
• Customize Application

Require sales and service reps to adhere to the process for scheduling in-person visits when you
set the on-site approval field that appears on records to read-only.

1. From Object Manager in Setup, select an object such as account.

2. Click Page Layouts > Account.

3. Hover over the On-Site Approval Status field, then click .

4. Select Read-Only, then click OK.
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5. Save your work.

Sync On-Site Approval Status Fields

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create an Apex trigger:
• Author Apex

Sync the statuses of on-site requests between on-site approval records for handling and storing
approvals and records related to them, such as accounts. For example, when managers approve
requests for accounts, trigger code updates the statuses for on-site approval records. When statuses
for on-site approval records sync with account records, sales and service reps see which accounts
they’re approved to visit based on color-coded markers in Salesforce Maps.

1. From Setup, select Developer Console.

2. Click File > New > Apex Trigger.

3. Name the trigger OnSiteApprovalTrigger, for example.

4. For sObject, select On_Site_Approval__c, for example.

5. Click Submit.
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6. Enter the trigger code into the body as shown with this sample code. If you’re using different API names of objects and fields, modify
them as needed.

trigger OnSiteApprovalTrigger on On_site_Approval__c (after insert, after update) {
public list<On_site_Approval__c> approvals = Trigger.new;

if(Trigger.isInsert || Trigger.isUpdate) {
List<Account> accountsToUpdate = new List<Account>();
for(On_site_Approval__c a : approvals) {

Account acc = new Account();
acc.Id = a.Related_To__c;
acc.On_site_Approval_Status__c = a.Status__c;
accountsToUpdate.add(acc);

}
update accountsToUpdate;

}
}

7. Click File > Save.
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Creating Email Templates for On-Site Visit Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Keep your sales and service reps informed about the statuses of their on-site visit requests. Automate
email notifications that tell reps when they submit requests through Salesforce Maps and whether
their managers approve or deny visits to specific customers.

1. Set Up an Email Template for Submitted Requests

Provide automated email confirmations to your sales and service reps when they submit requests
for on-site visits through Salesforce Maps.

2. Set Up an Email Template for Approved Requests

Deliver the good news to sales and service reps when their managers approve on-site visits
with specific customers. A marker layer that you set up later in Salesforce Maps includes visual
indicators that tell reps which customers they’re approved to visit.

3. Set Up an Email Template for Denied Requests

Inform your sales and service reps when managers deny on-site visits for specific customers. A marker layer that you set up later in
Salesforce Maps includes visual indicators that tell reps which customers aren’t approved for visits.

Set Up an Email Template for Submitted Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create custom HTML
email templates:
• Edit HTML Templates

Provide automated email confirmations to your sales and service reps when they submit requests
for on-site visits through Salesforce Maps.

1. From Setup, in the Quick Find box, enter Templates, then select Classic Email Templates.

2. Click New Template.

3. Select Custom (without using Classic Letterhead) as the template type, then click Next.

4. Enter the email template information.

ValueField

Unfiled Public Classic Email TemplatesFolder

SelectedAvailable for Use

On-Site Approval SubmittedEmail Template Name

General US & Western EuropeEncoding
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ValueField

Your Salesforce Maps on-site approval request was submittedSubject

5. Click Next.

6. Enter the code into the HTML Body as shown with this sample code. Modify the text and names as needed.

You submitted an on-site approval request to your manager or delegated approver:
{!User.Manager}. View the request <a href="{!On_Site_Approval__c.Link}">here</a>.
<br/><br/>
<span style="font-weight:bold;">Account Owner</span>
<br/>
{!Account.OwnerFullName}
<br/><br/>
<span style="font-weight:bold;">Account Name</span>
<br/>
{!Account.Name}
<br/><br/>
<span style="font-weight:bold;">Account Address</span>
<br/>
{!Account.BillingStreet}
<br/>
{!Account.BillingCity}, {!Account.BillingState} {!Account.BillingPostalCode}

7. Click Next.

8. Click Copy text from HTML version.

9. Save your work.
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Set Up an Email Template for Approved Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create custom HTML
email templates:
• Edit HTML Templates

Deliver the good news to sales and service reps when their managers approve on-site visits with
specific customers. A marker layer that you set up later in Salesforce Maps includes visual indicators
that tell reps which customers they’re approved to visit.

1. From Setup, in the Quick Find box, enter Templates, then select Classic Email Templates.

2. Click New Template.

3. Select Custom (without using Classic Letterhead) as the template type, then click Next.

4. Enter the email template information.

ValueField

Unfiled Public Classic Email TemplatesFolder

SelectedAvailable for Use

On-Site Approval ApprovedEmail Template Name

General US & Western EuropeEncoding

Your Salesforce Maps on-site approval request was approvedSubject

5. Click Next.
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6. Enter the code into the HTML Body as shown with this sample code. Modify the text and names as needed.

The on-site approval request you submitted has been approved by {!User.Name}.
View the request <a href="{!On_Site_Approval__c.Link}">here</a>.
<br/><br/>
<span style="font-weight:bold;">Account Owner</span>
<br/>
{!Account.OwnerFullName}
<br/><br/>
<span style="font-weight:bold;">Account Name</span>
<br/>
{!Account.Name}
<br/><br/>
<span style="font-weight:bold;">Account Address</span>
<br/>
{!Account.BillingStreet}
<br/>
{!Account.BillingCity}, {!Account.BillingState} {!Account.BillingPostalCode}

7. Click Next.

8. Click Copy text from HTML version.

9. Save your work.
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Set Up an Email Template for Denied Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create custom HTML
email templates:
• Edit HTML Templates

Inform your sales and service reps when managers deny on-site visits for specific customers. A
marker layer that you set up later in Salesforce Maps includes visual indicators that tell reps which
customers aren’t approved for visits.

1. From Setup, in the Quick Find box, enter Templates, then select Classic Email Templates.

2. Click New Template.

3. Select Custom (without using Classic Letterhead) as the template type, then click Next.

4. Enter the email template information.

ValueField

Unfiled Public Classic Email TemplatesFolder

SelectedAvailable for Use

On-Site Approval DeniedEmail Template Name

General US & Western EuropeEncoding

Your Salesforce Maps on-site approval request was deniedSubject

5. Click Next.
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6. Enter the code into the HTML Body as shown with this sample code. Modify the text and names as needed.

The on-site approval request you submitted has been denied by {!User.Name}.
View the request <a href="{!On_Site_Approval__c.Link}">here</a>.
<br/><br/>
<span style="font-weight:bold;">Account Owner</span>
<br/>
{!Account.OwnerFullName}
<br/><br/>
<span style="font-weight:bold;">Account Name</span>
<br/>
{!Account.Name}
<br/><br/>
<span style="font-weight:bold;">Account Address</span>
<br/>
{!Account.BillingStreet}
<br/>
{!Account.BillingCity}, {!Account.BillingState} {!Account.BillingPostalCode}

7. Click Next.

8. Click Copy text from HTML version.

9. Save your work.
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Developing a Process to Approve On-Site Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Automate processes for submitting, approving, and denying requests for in-person customer visits
from sales and service reps. Your reps submit requests for visits to managers through Salesforce
Maps.

1. Prepare an Approval Process

Specify which sales and service reps can submit approval requests for in-person customer visits
from Salesforce Maps. Identify which managers can approve those visits.

2. Set Up an Approval Step

Assign approval requests to managers and their delegates when sales and service reps request
on-site customer visits in Salesforce Maps.

3. Create an Action for Submitted Requests

Set up initial submission actions that automate email notifications and update status fields when your sales and service reps submit
requests for in-person customer visits through Salesforce Maps.

4. Create an Action for Approved Visits

Set up final approval actions that automate email notifications and update status fields when managers approve requests for in-person
customer visits through Salesforce Maps.

5. Create an Action for Denied Visits

Set up final rejection actions that automate email notifications and update status fields when managers deny requests from sales
and service reps for in-person customer visits through Salesforce Maps.

6. Activate the Approval Process

Let your sales and service reps submit requests for in-person customer visits through Salesforce Maps. Your approval process keeps
everyone informed about submitted, approved, and denied visit requests.

Prepare an Approval Process

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set up approval
processes:
• Customize Application

Specify which sales and service reps can submit approval requests for in-person customer visits
from Salesforce Maps. Identify which managers can approve those visits.

1. From Setup, go to Process Automation > Approval Processes.

2. Select On-Site Approval, then select Create New Approval Process > Use Standard Setup
Wizard.

3. Enter a process name, such as On-Site Approval Process, then click Next.

4. For Specify Entry Criteria, select the option criteria are met, then click Next.

5. For Specify Approver Field and Record Editability Properties, select Manager, then click Next.

6. For Select Notification Templates, don’t enter an approval assignment email template. Instead,
click Next.
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7. Add all available fields, then select the option display approval history information. For security settings, select the second option,
then click Next.

8. For submitter type, select Creator, then add Record Creator. Select the options for page layout settings and submission settings.
Save your work.

9. Select the last option, then click Go.
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Set Up an Approval Step

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set up approval
processes:
• Customize Application

Assign approval requests to managers and their delegates when sales and service reps request
on-site customer visits in Salesforce Maps.

1. From Setup, go to Process Automation > Approval Processes.

2. Select the approval process that you created, for example, On-Site Approval Process.

3. Click New Approval Step. Enter the name On-Site Approval Submitted. Set the
step number to 1, then click Next.

4. Select All records should enter this step, then click Next.

5. Select the options:

• Automatically assign using the user field selected earlier.

• The approver’s delegate may also approve this request.

6. Save your work.

7. Select the last option, then click Go.
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Create an Action for Submitted Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set up approval
processes:
• Customize Application

Set up initial submission actions that automate email notifications and update status fields when
your sales and service reps submit requests for in-person customer visits through Salesforce Maps.

1. From Setup, go to Process Automation > Approval Processes.

2. Select the approval process that you created, for example, On-Site Approval Process.

3. Under Initial Submission Actions, click Add New > Email Alert.

4. Enter a description, such as Email sent when on-site visit request is
submitted. Search for and select the email template that you created for submitted requests.

5. Select the recipient type Creator, then add Record Creator.

6. Save your work.

7. Under Initial Submission Actions, click Add New > Field Update.

8. Enter a name such as Field Update for Submitted Requests, then enter a description.

9. For the field to update, select the status field that you created for on-site visit requests, such as On-Site Visit Request Status. Then
select the specific value for when field reps submit requests, such as Request submitted.

10. Save your work.
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Create an Action for Approved Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set up approval
processes:
• Customize Application

Set up final approval actions that automate email notifications and update status fields when
managers approve requests for in-person customer visits through Salesforce Maps.

1. From Setup, go to Process Automation > Approval Processes.

2. Select the approval process that you created, for example, On-Site Approval Process.

3. Under Final Approval Actions, click Add New > Email Alert.

4. Enter a description, such as Email sent when on-site visit request is
approved. Search for and select the email template that you created for approved requests.

5. Select the recipient type Creator, then add Record Creator.

6. Save your work.

7. Under Final Approval Actions, click Add New > Field Update.

8. Enter a name such as Field Update for Approved Requests, then enter a description.

9. For the field to update, select the status field that you created for on-site visit requests, such as On-Site Visit Request Status. Then
select the specific value for when managers approve requests, such as Approved.

10. Save your work.
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Create an Action for Denied Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To set up approval
processes:
• Customize Application

Set up final rejection actions that automate email notifications and update status fields when
managers deny requests from sales and service reps for in-person customer visits through Salesforce
Maps.

1. From Setup, go to Process Automation > Approval Processes.

2. Select the approval process that you created, for example, On-Site Approval Process.

3. Under Final Rejection Actions, click Add New > Email Alert.

4. Enter a description, such as Email sent when on-site visit request is
denied. Search for and select the email template that you created for denied requests.

5. Select the recipient type Creator, then add Record Creator.

6. Save your work.

7. Under Final Rejection Actions, click Add New > Field Update.

8. Enter a name such as Field Update for Denied Requests, then enter a description.

9. For the field to update, select the status field that you created for on-site visit requests, such as On-Site Visit Request Status. Then
select the specific value for when managers deny requests, such as Denied.

10. Save your work.
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Activate the Approval Process

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To activate approval
processes:
• Customize Application

Let your sales and service reps submit requests for in-person customer visits through Salesforce
Maps. Your approval process keeps everyone informed about submitted, approved, and denied
visit requests.

1. From Setup, go to Process Automation > Approval Processes.

2. Select the approval process that you created, for example, On-Site Approval Process.

3. Click Activate, then click OK.

Create On-Site Visit Requests for New Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create processes:
• Manage Flow AND View

All Data

Automate the submission of requests for on-site visits when sales and service reps create accounts
in Salesforce Maps.

1. From Setup, go to Process Automation > Process Builder, then click New.

2. Name the process and select A record changes.

3. Save your work.

4. Click Add Object and select your on-site approval object.

76

Salesforce Maps SetupSalesforce Maps



5. Select only when a record is created, then save your work.

6. Click Add Criteria and enter Record Created for the criteria name.

7. Select No criteria—just execute the actions, then save your work.

8. From Record Created > Immediate Actions, click Add Action.

9. Set options on the Select and Define Action page.

Do ThisOption

Select Submit for Approval.Action Type

Enter Submit for Approval.Action Name

Select Specific approval process, then select the name of your approval process, for example,
On-Site Approval Process.

Approval Process

Select Yes.Skip the entry criteria for this
process?

Select Current User.Submitter

10. Save your work.
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11. Click Activate > Confirm.

Building the Flow for On-Site Visit Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Automate processes for submitting, approving, and denying requests for in-person customer visits
from sales and service reps. Your reps submit requests to managers through Salesforce Maps.

1. Create a Flow to Request On-Site Customer Visits

Start the process that helps sales and service reps request approval for visiting customers in
person. Create a flow based on an object that reps plot in Salesforce Maps. We give you guidance
for reps who plot accounts, but you can adapt this process for reps who plot, for example, leads,
contacts, and cases.

2. Set Up a Screen That Appears When Reps Request Approvals

Show your sales and service reps details about customers they want to visit. Include
customer-specific info such as account names, account addresses, and names of managers
who review and approve requests that reps initiate in Salesforce Maps.

3. Capture On-Site Approval Details in Records

Store approval statuses for each request in on-site approval records. For visit requests that your sales and service reps submit through
Salesforce Maps, set up the flow to create records that include record IDs, names, and approval statuses.

4. Notify Reps When Errors Prevent Submissions for Visit Requests

Keep sales and service reps informed when problems prevent them from submitting requests for in-person customer visits through
Salesforce Maps. Include messaging in your flow that provides your reps guidance for what to do next.

5. Provide Reps Confirmation for Submitted On-Site Visit Requests

Let your sales and service reps know when they submit requests for on-site customer visits in Salesforce Maps. Include messaging
in your flow that, for example, tells reps to wait for manager approval before scheduling in-person meetings.
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Create a Flow to Request On-Site Customer Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Start the process that helps sales and service reps request approval for visiting customers in person.
Create a flow based on an object that reps plot in Salesforce Maps. We give you guidance for reps
who plot accounts, but you can adapt this process for reps who plot, for example, leads, contacts,
and cases.

1. From Setup, in the Quick Find box, enter Flows, then select Flows.

2. Click New Flow. Select Screen Flow, then click Next. Select Auto-Layout.

3. Click New Resource. For the resource type, select Variable.

4. For the API name, enter recordId. For the data type, select Text. Select Available for input, then click Done.

5. Add an element, and select Get Records.
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6. Enter a label that relates to the object you’re selecting for your flow. For example, for the Account object, enter Get Account
Record.

Select the object such as Account. Then filter records.

To...Set the filter
element...

IdField

EqualsOperator

recordIdValue

7. Click Done.
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Set Up a Screen That Appears When Reps Request Approvals

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Show your sales and service reps details about customers they want to visit. Include customer-specific
info such as account names, account addresses, and names of managers who review and approve
requests that reps initiate in Salesforce Maps.

1. Continue building the flow from the previous procedure.

2. Add an element, then select Screen.

3. Add screen properties. For the label, enter On-Site Visit Request, then enter a description. Clear the options Show
Header, Previous, and Pause.

4. Under Screen Components, scroll to and click Display Text.
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5. Enter an API name such as display_text_account_details.

6. In the Display Text box, enter the details you want to appear for your reps as they prepare to submit an approval request. For example:

Account Name
{!Get_Account_Record.Name}

Account Address
{!Get_Account_Record.BillingStreet}
{!Get_Account_Record.BillingCity}, {!Get_Account_Record.BillingState}
{!Get_Account_Record.BillingPostalCode}

Approver
{!Get_Account_Record.Owner.Manager.FirstName} {!Get_Account_Record.Owner.Manager.LastName}

7. Click Done.

Capture On-Site Approval Details in Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Store approval statuses for each request in on-site approval records. For visit requests that your
sales and service reps submit through Salesforce Maps, set up the flow to create records that include
record IDs, names, and approval statuses.

1. Continue building the flow from the previous procedure.

2. Add an element, then select Create Records.
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3. For the label, enter Create On-Site Approval, then enter a description. Select the option Use separate resources, and
literal values, then select the object On-Site Approval.

4. Set required field values.

ValueField

On-Site Request at {!Get_Account_Record.Name}Name

recordIdRelated_To__c

Not_SubmittedStatus__c
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5. Click Done.

Notify Reps When Errors Prevent Submissions for Visit Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Keep sales and service reps informed when problems prevent them from submitting requests for
in-person customer visits through Salesforce Maps. Include messaging in your flow that provides
your reps guidance for what to do next.

1. Continue building the flow from the previous procedure.

2. Select the Create Records element. Click Add Fault Path, then select Screen.

3. Add screen properties. Enter a label, then clear the options Show Header, Previous, and Pause.

4. Under Screen Components, scroll to and click Display Text. Enter an API name and the message with any guidance you want to
appear for field reps.
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5. Click Done.

Provide Reps Confirmation for Submitted On-Site Visit Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Let your sales and service reps know when they submit requests for on-site customer visits in
Salesforce Maps. Include messaging in your flow that, for example, tells reps to wait for manager
approval before scheduling in-person meetings.

1. Continue building the flow from the previous procedure.

2. Add an element, then select Screen.

3. Add screen properties. Enter a label, then clear the options Show Header, Previous, and Pause.
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4. Under Screen Components, scroll to and click Display Text. Enter an API name and the message you want to appear for field reps.

5. Click Done.

6. Save the flow, then activate it.

Preparing Salesforce Maps for On-Site Approval Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Let your sales and service reps submit requests for in-person customer visits directly in Salesforce
Maps. Provide visual indicators for your reps so that they identify which customers they’re approved
to visit.

1. Create a Custom Action to Submit On-Site Visit Requests

Set up Salesforce Maps so that your sales and service reps can submit requests for in-person
customer visits. A custom action triggers the flow that you set up earlier, which prompts
managers to review and respond to visit requests.

2. Set Up a Marker Layer That Shows Approval Statuses

Give your sales and service reps visual indicators that show the approval status for accounts
that they plot on the map. Color-code markers on records, such as accounts, by the statuses
that you created for requesting in-person customer visits through Salesforce Maps.
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Create a Custom Action to Submit On-Site Visit Requests

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Set up Salesforce Maps so that your sales and service reps can submit requests for in-person customer
visits. A custom action triggers the flow that you set up earlier, which prompts managers to review
and respond to visit requests.

1. From Setup, in the Quick Find box, enter Installed Packages, then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Settings > Custom Actions.

4. Select Create, then enter a name for your custom action button such as Request On-Site
Visit. Select Activity Support and Verified Location Support.

5. Select the action Launch Visual Flow, then enter the API name for the flow you created that prompts managers to review and
respond to on-site visit requests.

6. Save your work.

7. Click Button Set Name, then select the button set to which you want to add the button you created.

8. Under Available Buttons, position the new button under Popup.

9. Save your work. The button appears in a marker’s popup.
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Set Up a Marker Layer That Shows Approval Statuses

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Give your sales and service reps visual indicators that show the approval status for accounts that
they plot on the map. Color-code markers on records, such as accounts, by the statuses that you
created for requesting in-person customer visits through Salesforce Maps.

1. In Salesforce Maps, click Layers > Saved > Personal, then create a marker layer.

2. Select the base object whose records your reps plot on the map, such as Account (Billing).
Enter a name and a description for the marker layer.

3. Click Markers, set the assignment type to Dynamic, Field, then select the field you created
for tracking the status of on-site approvals, such as On-Site Approval Status.

4. Click each marker, then select a color that represents its status.

5. Click Save & Plot. The colors of the markers that appear on the map correspond with their statuses.
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Prompting Field Reps to Respond to Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Encourage your sales and service reps to minimize risk of exposure to COVID-19. Prompt them to
review and respond to your company’s safety guidelines in Salesforce Maps. Automate prompts
whenever your reps arrive at and depart from in-person customer visits.

1. Create Fields for Safety Guidelines

Capture your company’s safety guidelines for minimizing risk of exposure to COVID-19 among
sales and service reps and their customers. Later, you add checkbox fields to a flow that prompts
your reps to review and respond to guidelines in Salesforce Maps before visiting with customers.

2. Setting Up a Flow for Responses to Safety Guidelines

Automate processes to keep your sales and service reps safe and healthy during in-person
customer visits. Set up a flow that creates a task for each account that your reps visit. When
they check in, tasks capture your reps’ responses to your company’s COVID-19 safety
guidelines—directly in Salesforce Maps.

3. Connecting the Flow for Safety Guidelines to Salesforce Maps

Integrate the flow for COVID-19 safety guidelines into Salesforce Maps. Prompt your sales and service reps to respond to your
company’s guidelines when they check in at customer visits, and capture their responses to those guidelines in tasks.
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Create Fields for Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create fields:
• Customize Application

Capture your company’s safety guidelines for minimizing risk of exposure to COVID-19 among sales
and service reps and their customers. Later, you add checkbox fields to a flow that prompts your
reps to review and respond to guidelines in Salesforce Maps before visiting with customers.

1. From Object Manager in Setup, select Activity.

2. Click Fields & Relationships > New, select Checkbox, then click Next.

3. Enter a label and set the default value to Unchecked. Add a description such as the safety
guideline for the checkbox field, then click Next.

When you create a flow later in the process, you create a field label that reflects the safety guideline for this checkbox field.

4. Accept the field-level security settings, then click Next.

5. Add the field to page layouts, then click Save & New.

6. Repeat the procedure for each safety guideline that you want in a checkbox field.

SEE ALSO:

Salesforce Help: Create Custom Fields

Setting Up a Flow for Responses to Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Automate processes to keep your sales and service reps safe and healthy during in-person customer
visits. Set up a flow that creates a task for each account that your reps visit. When they check in,
tasks capture your reps’ responses to your company’s COVID-19 safety guidelines—directly in
Salesforce Maps.

1. Create a Flow for an Object That Reps Plot on the Map

Start developing the process that prompts sales and service reps to respond to your company’s
COVID-19 safety guidelines. Create a flow based on an object that reps plot in Salesforce Maps.
We give you guidance for reps who plot accounts on the map, but you can adapt this process
for reps who plot, for example, leads, contacts, and cases.

2. Set Up a Screen That Appears When Reps Check In to Visits

Create a screen that includes your company’s safety guidelines for minimizing the risk of exposure
to COVID-19 among your sales and service reps and their customers. When reps check in at their customer visits in Salesforce Maps,
they review and respond to those guidelines, which help ensure everyone’s health.
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3. Capture Responses to Safety Guidelines in Tasks

Store your sales and service reps’ responses to your company’s COVID-19 safety guidelines in tasks. When your reps check in at
customer visits using Salesforce Maps, the flow that you set up shows your reps a screen that includes checkboxes for each safety
guideline. The flow then captures responses in related tasks.

4. Notify Reps When Errors Prevent Responses to Safety Guidelines

Keep sales and service reps informed when problems prevent Salesforce from capturing their responses to your company’s COVID-19
safety guidelines. Include messaging in your flow that sets expectations for and provides guidance to reps directly in Salesforce Maps
so that they keep themselves and their customers healthy.

5. Provide Reps Confirmation for Responses to Safety Guidelines

Let your sales and service reps know when Salesforce captures their responses to your company’s COVID-19 safety guidelines that
appear in Salesforce Maps. Include messaging in your flow that, for example, encourages reps to practice social distancing and wash
hands before and after visits.

SEE ALSO:

Salesforce Help: Flow Builder Tour

Create a Flow for an Object That Reps Plot on the Map

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Start developing the process that prompts sales and service reps to respond to your company’s
COVID-19 safety guidelines. Create a flow based on an object that reps plot in Salesforce Maps. We
give you guidance for reps who plot accounts on the map, but you can adapt this process for reps
who plot, for example, leads, contacts, and cases.

1. From Setup, in the Quick Find box, enter Flows, then select Flows.

2. Click New Flow. Select Screen Flow, then click Next. Select Auto-Layout.

3. Click New Resource. For the resource type, select Variable.

4. For the API name, enter recordId. For the data type, select Text. Select Available for input, then click Done.
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5. Add an element, then select Get Records.

6. Enter a label that relates to the object you’re selecting for your flow. For example, for the Account object, enter Get Account
Record.

Select the object such as Account, then filter its records.

To...Set this filter
element...

IdField
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To...Set this filter
element...

EqualsOperator

recordIdValue

7. Click Done.

Set Up a Screen That Appears When Reps Check In to Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Create a screen that includes your company’s safety guidelines for minimizing the risk of exposure
to COVID-19 among your sales and service reps and their customers. When reps check in at their
customer visits in Salesforce Maps, they review and respond to those guidelines, which help ensure
everyone’s health.

1. Continue building the flow from the previous procedure.

2. Add an element, then select Screen.

3. Add screen properties. For the label, enter Safety Checklist, then enter a description. Clear the options Show Header and
Pause.
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4. Under Screen Components, click Checkbox.

5. Enter the label you want to appear for your field reps. The label represents one of your company’s safety guidelines.

6. Replace the API name with the checkbox field name that corresponds with the guideline.

7. Set the default value to !$GlobalConstant.False.

8. Repeat steps 4 through 7 for each safety guideline, then click Done.
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Capture Responses to Safety Guidelines in Tasks

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Store your sales and service reps’ responses to your company’s COVID-19 safety guidelines in tasks.
When your reps check in at customer visits using Salesforce Maps, the flow that you set up shows
your reps a screen that includes checkboxes for each safety guideline. The flow then captures
responses in related tasks.

1. Continue building the flow from the previous procedure.

2. Add an element, then select Create Records.

3. For the label, enter Create Task, then enter a description. Select the option Use separate resources, and literal values, then
select the object Task.

4. Set required field values.

ValueField

recordIdWhatId

!Get_Account_Record.OwnerIdOwnerId

Check-in at !Get_Account_Record.NameSubject

CompletedStatus
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ValueField

NormalPriority

5. Add the checkbox fields that you created for each safety guideline. In Field, enter the API name for one of the checkbox fields you
created. In Value, enter the component that corresponds with the checkbox field. Repeat for each checkbox field.

6. Click Done.

Notify Reps When Errors Prevent Responses to Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Keep sales and service reps informed when problems prevent Salesforce from capturing their
responses to your company’s COVID-19 safety guidelines. Include messaging in your flow that sets
expectations for and provides guidance to reps directly in Salesforce Maps so that they keep
themselves and their customers healthy.

1. Continue building the flow from the previous procedure.

2. Select the Create Records element, click Add Fault Path, then select Screen.

3. Add screen properties. Enter a label, then clear the options Show Header, Previous, and Pause.
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4. Under Screen Components, scroll to and click Display Text. Enter an API name and the message with any guidance you want to
appear for field reps.

5. Click Done.

Provide Reps Confirmation for Responses to Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create flows:
• Manage Flow

Let your sales and service reps know when Salesforce captures their responses to your company’s
COVID-19 safety guidelines that appear in Salesforce Maps. Include messaging in your flow that,
for example, encourages reps to practice social distancing and wash hands before and after visits.

1. Continue building the flow from the previous procedure.

2. Add an element, then select Screen.
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3. Add screen properties. Enter a label, then clear the options Show Header, Previous, and Pause.

4. Scroll to and drag Display Text to the center. Enter an API name and the message you want to appear for field reps.

5. Click Done.

6. Save the flow.
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Connecting the Flow for Safety Guidelines to Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Integrate the flow for COVID-19 safety guidelines into Salesforce Maps. Prompt your sales and
service reps to respond to your company’s guidelines when they check in at customer visits, and
capture their responses to those guidelines in tasks.

1. Create a Custom Action That Triggers the Flow for Safety Guidelines

Prompt sales and service reps to review and respond to your company’s COVID-19 safety
guidelines. You set up a custom action in Salesforce Maps so that when your reps check in at
customer visits, the flow begins.

2. Add the Custom Action for Safety Guidelines to Button Sets

Apply the custom action that triggers the flow for your company’s COVID-19 safety guidelines
to button sets in Salesforce Maps. That way, when sales and service reps check in at customer
visits, the flow you created prompts them to review and respond to the guidelines.

3. Test the Flow That Captures Responses to Safety Guidelines

Confirm that the flow you created for capturing responses to your company’s COVID-19 safety guidelines works the way you intend
in Salesforce Maps. Prepare to roll out the process to your sales and service teams so that everyone gets the guidance and support
they deserve to meet with customers safely.

Create a Custom Action That Triggers the Flow for Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Prompt sales and service reps to review and respond to your company’s COVID-19 safety guidelines.
You set up a custom action in Salesforce Maps so that when your reps check in at customer visits,
the flow begins.

1. From Setup, in the Quick Find box, enter Installed Packages, then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Settings > Custom Actions.

4. Select Create New, then give your custom action button a name. Select Activity Support and
Verified Location Support.
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5. Select the action Launch Visual Flow, then enter the API name for the flow you created that prompts reps to review and respond
to safety guidelines.

6. Save your work.

Add the Custom Action for Safety Guidelines to Button Sets

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Apply the custom action that triggers the flow for your company’s COVID-19 safety guidelines to
button sets in Salesforce Maps. That way, when sales and service reps check in at customer visits,
the flow you created prompts them to review and respond to the guidelines.

1. In Salesforce Maps Settings, select Button Set Name.

2. Select the button set that you want to add the custom action button to.

3. Find the new button that triggers the flow for your company’s safety guidelines, then drag it
where you want it to appear in the Popup layout.

4. Save your work.
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Test the Flow That Captures Responses to Safety Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Confirm that the flow you created for capturing responses to your company’s COVID-19 safety
guidelines works the way you intend in Salesforce Maps. Prepare to roll out the process to your
sales and service teams so that everyone gets the guidance and support they deserve to meet with
customers safely.

1. In Salesforce Maps, plot a layer whose object corresponds with the flow that you created for
your company’s safety guidelines. For example, if you built your flow based on the Account
object, plot accounts.

2. Click a marker, then select Actions. Click the button that you added to your button set.

3. Review and respond to the guidelines. Click Next, then click Finish.
Salesforce records responses in a task related to the account.

Identifying Trends for New COVID-19 Cases

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Give sales and service managers and their field reps tools to use to make informed decisions before
they schedule in-person customer visits. Show trends over 14-day moving averages within US
counties in Salesforce Maps. Adding an ArcGIS layer shows uptrends, downtrends, and trend duration.

1. Give Managers and Field Reps Access to ArcGIS Trend Data

Provide access to the ArcGIS data layer that helps sales and service managers and their field
reps identify trends for new COVID-19 cases by US county directly in Salesforce Maps.

2. Set Up Connections That Provide Access to ArcGIS Trend Data

Establish two connections to ArcGIS data in Salesforce. Then the data layer that you create in
Salesforce Maps shows trends by US county for new COVID-19 cases compared with 14-day
moving averages.

3. Create and Plot an ArcGIS Layer

Help sales and service managers track trends by US county for new COVID-19 cases compared with 14-day moving averages. Adding
an ArcGIS layer in Salesforce Maps shows whether the trends are increasing or decreasing and their duration.
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Give Managers and Field Reps Access to ArcGIS Trend Data

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Provide access to the ArcGIS data layer that helps sales and service managers and their field reps
identify trends for new COVID-19 cases by US county directly in Salesforce Maps.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Select Permission Groups.

4. To give a permission group access to the ArcGIS data layer, select Enable ArcGIS Layers.

5. Save your changes.

Set Up Connections That Provide Access to ArcGIS Trend Data

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Establish two connections to ArcGIS data in Salesforce. Then the data layer that you create in
Salesforce Maps shows trends by US county for new COVID-19 cases compared with 14-day moving
averages.

1. From Setup, in the Quick Find box, enter Remote Site Settings, and then select
Remote Site Settings.

2. Click New Remote Site.

3. Give the first remote site a name of your choice, such as ArcGIS_Services. Enter the remote site
URL https://services7.arcgis.com, and then click Save & New.
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4. Give the second remote site a name of your choice, such as ArcGIS_Online_Services. Enter the remote site URL
https://services.arcgisonline.com.

5. Save your changes.

Create and Plot an ArcGIS Layer

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Help sales and service managers track trends by US county for new COVID-19 cases compared with
14-day moving averages. Adding an ArcGIS layer in Salesforce Maps shows whether the trends are
increasing or decreasing and their duration.

1. In Salesforce Maps, select Layers > Saved > Corporate.

2. Click New > ArcGIS Layer.

3. Give the ArcGIS layer a name and enter a description. Then enter the URL
https://sfmaps.maps.arcgis.com/home/webmap/viewer.html?webmap=da18f557032842c8b8b81cdf96d15010.

4. Save your changes.

5. Plot the layer that you created.
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The layer shows trends for new COVID-19 cases over a 14-day moving average.

Simplifying and Automating Processes for Field Reps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Help field reps spend less time tending to administrative duties and more time cultivating customer
relationships using Salesforce Maps.

Automating Assignments for Salesforce Records

Avoid the hassle of manually assigning Salesforce records. Assign them to particular owners or
users in your territories based on conditions that you specify in Salesforce Maps assignment
plans and rules.

Configuring Schedules

Fine-tune the way Salesforce Maps relates the scheduled events it adds to Salesforce calendars.
When tracking events based on custom activity objects with defined start and end times or
durations, give your reps the option to add those events to their schedules. You determine how
to relate the events to Salesforce records.

Configuring Check In Settings

Let sales and service reps log activities and notes from the field using a convenient button on their mobile devices. Customize the
Check In experience by creating custom activity fields, a custom disposition, and specific settings for each base object in Salesforce
Maps.

Letting Reps Create Leads and Accounts from Salesforce Maps

Save your sales and service reps time when you let them create leads and accounts using the property and business data available
in Salesforce Maps. Your reps can also create records from points of interest, their current location, and any other areas on the map
using Click2Create.

Showing Nearby Maps in Salesforce Records and on Sites

Bring context to records and sites when you add a Salesforce Maps component to page and site layouts. Select from standard maps
for accounts, contacts, cases, leads, and opportunities. Or create custom maps that show the records or filtered layers of your choice.

Plot Specific Layers for Reps when They Start Sessions

Show the layers that managers and operations want to appear when reps start their sessions in Salesforce Maps. That way, your reps
can jump right into their work without searching for critical details. For example, set marker, data, and ArcGIS layers that give reps
more context for sales and service work in their respective areas.
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Automating Assignments for Salesforce Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Avoid the hassle of manually assigning Salesforce records. Assign them to particular owners or users
in your territories based on conditions that you specify in Salesforce Maps assignment plans and
rules.

1. Configure Record Assignments

Automate assignments for the records that matter to your sales and service teams in Salesforce
Maps. To automate assignments for records other than accounts and leads, such as campaigns
and cases, create lookup relationships for those records’ objects.

2. Set Up Plans for Record Assignments

Outline the details of what you want Salesforce Maps to assign in assignment plans. Assign
record owners, users, or both to records for the objects that you include in as many as 50 plans.
For example, filter the records to reassign a rep to accounts that earn a certain amount of annual
revenue.

3. Determine Record Assignments in Rules

Put your assignment plan into action when you add as many as 5,000 rules across your assignment plans in Salesforce Maps. For
example, to assign a rep to the Southwest territory, create a rule that assigns the Southwest territory shape layer to the rep.

4. Schedule and Run Record Assignments

Assign records to the right sales and service reps when you automate assignment plans to run on an interval that you choose in
Salesforce Maps. Or run ad hoc assignment when the needs arise.

Configure Record Assignments

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Automate assignments for the records that matter to your sales and service teams in Salesforce
Maps. To automate assignments for records other than accounts and leads, such as campaigns and
cases, create lookup relationships for those records’ objects.

1. From Setup, click Object Manger, and then select the object whose records you want to assign.

2. Click Fields & Relationships > New. Select Lookup Relationship, then click Next.

3. Select the assignment rule object, then click Next. Enter a field label and name, set any other options, then click Next.
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4. Set field-level security for the lookup field, then click Next.

5. Select Add Field for the page layout, then click Next. Confirm the custom related list options.

6. Save your work.
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Set Up Plans for Record Assignments

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Outline the details of what you want Salesforce Maps to assign in assignment plans. Assign record
owners, users, or both to records for the objects that you include in as many as 50 plans. For example,
filter the records to reassign a rep to accounts that earn a certain amount of annual revenue.

1. From Setup, in the Quick Find box, enter Installed Packages, then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Click Auto Assignment > Create a Plan.

4. Enter a name for the assignment plan, and select the object for the records that you want to
assign. Select latitude and longitude fields, and ensure that they’re mapped to the appropriate
coordinate fields on the object. Then specify whether to assign record owners, a specific user
field, or both.

5. To assign a subset of records, enter a SOQL filter and then test it. Add statements after the WHERE clause.

Enter the SOQL statement...For example, to create an assignment plan that assigns...

AnnualRevenue > 1000000
Sales reps to accounts that exceed $1,000,000 in revenue

AnnualRevenue < 1000000
Sales reps to accounts that earn less than $1,000,000 in revenue

Industry = ‘Apparel’
Records associated with the apparel industry to reps who specialize in it
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6. Save your work.

SEE ALSO:

SOQL and SOSL Reference: Salesforce Object Query Language (SOQL)

Determine Record Assignments in Rules

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Put your assignment plan into action when you add as many as 5,000 rules across your assignment
plans in Salesforce Maps. For example, to assign a rep to the Southwest territory, create a rule that
assigns the Southwest territory shape layer to the rep.

1. Confirm that you have a shape layer that represents an area such as a territory that you want
to assign.

2. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

3. Next to the Salesforce Maps package, click Configure.

4. Click Auto Assignment > Assignment Plans, and then select an assignment plan. Scroll to
Assignment Rules, then add rules to your assignment plan.

5. Save your work.

SEE ALSO:

Create Shape Layers
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Schedule and Run Record Assignments

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Assign records to the right sales and service reps when you automate assignment plans to run on
an interval that you choose in Salesforce Maps. Or run ad hoc assignment when the needs arise.

1. From Setup, in the Quick Find box, enter Installed Packages, then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Click Auto Assignment > Scheduled Plans > Set Schedule. Select the interval that you want
for running assignment plans. Then save your work.

4. To run ad hoc assignments, click Assignment Plans. Select the assignment plans that you want to run now, then click Run.

SEE ALSO:

Apex Developer Guide: Execution Governors and Limits
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Configuring Schedules

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Fine-tune the way Salesforce Maps relates the scheduled events it adds to Salesforce calendars.
When tracking events based on custom activity objects with defined start and end times or durations,
give your reps the option to add those events to their schedules. You determine how to relate the
events to Salesforce records.

Give Reps Permission to Edit Object Locations

Increase reps’ sales schedule efficiency when you give them access to add locations to records.
Calendar events for records without location information aren’t plotted on the map. Ensure
that reps can add location information to records so they can visualize those calendar events
in Salesforce Maps. Apply the principle of least privilege by restricting access to objects with
permission sets.

Set Up Schedules to Include Custom Activities

Let your reps add custom activities with defined start and end times or durations to their schedules in Salesforce Maps. You determine
how to relate those events to Salesforce records.

Assign Specific Event Types to Meetings

Specify the default Salesforce event types that you want to assign from the meetings your reps schedule in Salesforce Maps. Assigning
event types gives, for example, managers insight to the types of events that their reps schedule, such as meetings, calls, and email
messages.

Exclude Specific Events and Activities from Schedules

Partner with your Salesforce admin to exclude specific events and custom activities, such as all-day or private events, from appearing
on and optimizing Salesforce Maps schedules.

Give Reps Permission to Edit Object Locations

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Increase reps’ sales schedule efficiency when you give them access to add locations to records.
Calendar events for records without location information aren’t plotted on the map. Ensure that
reps can add location information to records so they can visualize those calendar events in Salesforce
Maps. Apply the principle of least privilege by restricting access to objects with permission sets.

1. Create or clone a permission set.

2. From the permission set, click Object Settings and select the object whose location you want
to grant access to.
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3. Click Edit.

4. Under Field Permissions, for Latitude and Longitude, select Read Access and Edit Access.

5. Save your work.

6. Click Manage Assignments > Add Assignments.

7. Select which users you want to have location edit access and then click Assign.

Set Up Schedules to Include Custom Activities

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Let your reps add custom activities with defined start and end times or durations to their schedules
in Salesforce Maps. You determine how to relate those events to Salesforce records.

1. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Routes & Schedule, then click + Custom Event.

4. Select the Salesforce object that represents custom activities. Specifically, select one that includes
defined start and end times or durations. Then click Confirm.

5. Configure the schedule settings for new custom activity records that Salesforce Maps generates.

What It IsSetting

The name of the custom activity object as you want it to appear in Salesforce Maps Schedule.Name
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What It IsSetting

The owner or assignee for custom activity records. Select a field that includes the ID of the owner or
assignee, such as OwnerID.

Scheduling Resource

The name of each custom activity record.Event Name Field

The time configuration relevant to your custom activity object. If the object has:Time Fields

• Start date/time and end date/time fields, select Use Start DateTime and End DateTime.

• Start date/time and duration fields, select Use Start DateTime and Duration.

The Salesforce field that represents the start date/time.Start Date Time Field

The Salesforce field that represents either the end date/time or duration.End Date Time Field

6. Select options for related object configurations. These options define which Salesforce objects are available for users to schedule
custom activity records. For example, you enable Account. Your reps can then schedule custom activity records related to accounts
in the Salesforce Maps schedule.

Keep in mind that the schedule requires a lookup relationship from the custom activity object to the related object. Otherwise, you
can’t enable the related object.

7. Save your changes.

Assign Specific Event Types to Meetings

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Specify the default Salesforce event types that you want to assign from the meetings your reps
schedule in Salesforce Maps. Assigning event types gives, for example, managers insight to the
types of events that their reps schedule, such as meetings, calls, and email messages.

1. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Routes & Schedule, then click Event.

4. Select a default event type for any related object configuration. For example, to specify Meeting
as the event type when scheduling visits to accounts, select Meeting for Account (Billing).
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5. Save your changes.

Exclude Specific Events and Activities from Schedules

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Partner with your Salesforce admin to exclude specific events and custom activities, such as all-day
or private events, from appearing on and optimizing Salesforce Maps schedules.

1. Ask your Salesforce admin to create an editable custom activity checkbox on the Activity object
for events. Set the label of the checkbox to a value that resonates with your reps, such as Private.

2. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

3. Click Configure next to the Salesforce Maps package.

4. Select Routes & Schedule, then click Event or a custom event object that you’ve already set
up.
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5. Click Exclude Specific Records from Schedule, and select an option, such as Private.

6. Save your changes.
When your reps open events in Salesforce and select the checkbox that your admin added, those meetings disappear from the
schedule in Salesforce Maps.

Configuring Check In Settings

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Let sales and service reps log activities and notes from the field using a convenient button on their
mobile devices. Customize the Check In experience by creating custom activity fields, a custom
disposition, and specific settings for each base object in Salesforce Maps.

Create Fields for Checking In to Visits

Capture data that’s important to your company every time reps check in to a visit or event.
Salesforce Maps Check In lets reps log their location, time, visit duration, and other details from
the field quickly and saves that information before they proceed to the next visit. Managers can
view those visit details in Salesforce at any time.

Match Check In Fields with Activity Settings

Get location data from reps in the field or at on-site events, and add that data to Salesforce. Set
up the check-in and check-out process to create events and tasks, post to Chatter, send arrival
alerts, and verify addresses, for example.

Prompt Users for Details about Meetings when Checking In

Determine which information field reps provide when they check in to meetings when you create a field set and a custom disposition
in Salesforce Maps.

Select Check In Settings for Base Objects

After creating Check In and Check Out fields and configuring a custom disposition, configure Check In settings for each base object.
Base object-level Check In settings let you further customize what activities and posts that Salesforce Maps generates each time a
user checks in at a specific record.

Check Reps Out from Visits Automatically

Save your reps time by letting them check in and out of a visit with one click in Salesforce Maps. Checking in to a location logs an
activity and marks it complete. If managers require reps to enter notes about a meeting before automatic checkout is complete,
include a custom disposition.
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Create Fields for Checking In to Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Capture data that’s important to your company every time reps check in to a visit or event. Salesforce
Maps Check In lets reps log their location, time, visit duration, and other details from the field quickly
and saves that information before they proceed to the next visit. Managers can view those visit
details in Salesforce at any time.

It’s best to create the fields listed in Check In Activity Fields and Criteria.

1. From the management settings for activities, go to Fields & Relationships > New.

2. Select the type of field you want available for check in or out. For example, to include the visit
location when a rep checks in, which is recorded as latitude and longitude, select Number,
and then click Next.

3. Enter a field label and set the field attributes. Click Next.

4. Specify the field access settings for each profile, and then click Next.

5. Select the page layouts you want to add the field to.
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6. Save your work, and then repeat these steps for each field you want to create.

SEE ALSO:

Check In Activity Fields and Criteria

Salesforce Help: Create Custom Fields

Match Check In Fields with Activity Settings

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Get location data from reps in the field or at on-site events, and add that data to Salesforce. Set up
the check-in and check-out process to create events and tasks, post to Chatter, send arrival alerts,
and verify addresses, for example.

1. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Settings > Activity Settings.

4. To map the activity fields to their corresponding activity settings, click Suggest, or select
individual fields.
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5. Save your changes.

SEE ALSO:

Check In Activity Fields and Criteria

Prompt Users for Details about Meetings when Checking In

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Determine which information field reps provide when they check in to meetings when you create
a field set and a custom disposition in Salesforce Maps.

1. Create a custom disposition field set. From the management settings for the Task object, click
Field Sets > New.

2. Enter a name for the Field Set Label.

3. Enter a description for Where is this used?.
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4. Save your changes.

5. In the Salesforce Maps Custom Disposition field set, add the fields you want listed for users to complete when they use Custom
Disposition.

For example, you want users to add comments about their meeting.

6. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed Packages.

7. Click Configure next to the Salesforce Maps package.

8. Select Settings > Activity Settings.

9. In the Custom Disposition section, select the Field Set you created.
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10. Save your changes.

SEE ALSO:

Salesforce Help: Creating and Editing Field Sets

Select Check In Settings for Base Objects

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

After creating Check In and Check Out fields and configuring a custom disposition, configure Check
In settings for each base object. Base object-level Check In settings let you further customize what
activities and posts that Salesforce Maps generates each time a user checks in at a specific record.

1. From Setup, enter Installed Packages  in the Quick Find box, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Base Object > Edit Existing or Base Object > Create New.

4. Select the base object that you want to edit.

5. Select the Check In settings that you want Salesforce Maps to generate when a user checks in
at that object.

Creates a Chatter post, a task, an event, or a combination of them.Post To

Requires mobile users to be within a given distance of a record’s geolocation to check in.Verification Distance

Determines the content of Chatter posts. Include any fields that you created in Activity
Settings using corresponding macros.

Chatter Body

6. Save your changes.

SEE ALSO:

Base Objects Settings
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Check Reps Out from Visits Automatically

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Save your reps time by letting them check in and out of a visit with one click in Salesforce Maps.
Checking in to a location logs an activity and marks it complete. If managers require reps to enter
notes about a meeting before automatic checkout is complete, include a custom disposition.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Permission Groups.

4. Create or select a permission group.

5. Click Edit, and then select Auto Check Out.

6. Save your changes.

SEE ALSO:

Prompt Users for Details about Meetings when Checking In

Letting Reps Create Leads and Accounts from Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Save your sales and service reps time when you let them create leads and accounts using the
property and business data available in Salesforce Maps. Your reps can also create records from
points of interest, their current location, and any other areas on the map using Click2Create.

1. Specify Which Fields Appear when Reps Create Records from Salesforce Maps

Capture specific information when reps create leads and accounts using Click2Create. You
create field sets in Salesforce for each object that’s relevant to your sales and service teams.

2. Set Up Field Mappings for the Records That Reps Create from Salesforce Maps

Direct the information that your reps enter into Click2Create fields to the Salesforce lead and
account record fields of your choice.
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3. Let Reps Create Records from Salesforce Maps

Add the Click2Create button to each button set and assign the button sets to permission groups for your sales and service teams.

Specify Which Fields Appear when Reps Create Records from Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Capture specific information when reps create leads and accounts using Click2Create. You create
field sets in Salesforce for each object that’s relevant to your sales and service teams.

1. From Setup, in the Quick Find box, enter Object Manager, and then select Object
Manager.

2. Select the object for the field set that you’re creating, such as Lead or Account. Then click Field
Sets > New.

3. Enter a field set label and name, and then describe where you’re applying the field set.

4. Save your changes.

5. Add the fields that you want to appear when reps create records in Salesforce Maps.

6. Save your changes.

SEE ALSO:

Salesforce Help: Creating and Editing Field Sets
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Set Up Field Mappings for the Records That Reps Create from Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Direct the information that your reps enter into Click2Create fields to the Salesforce lead and account
record fields of your choice.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure. Then, select Click2Create.

3. Select the object that you want your reps to create records for, such as Lead or Account. If your
reps generate leads using the property and business data available in Salesforce Maps, the
object that you select depends on the data that your reps generate leads from. Specifically, for:

• Property data, select Lead.

• Business data, select Account. Business data doesn’t include a Last Name field, which lead
records require.

4. Select field mappings between Salesforce and Salesforce Maps. Then select field set mappings,
which determine the fields that appear when your reps create records using Click2Create.

5. Save your changes.

Let Reps Create Records from Salesforce Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Add the Click2Create button to each button set and assign the button sets to permission groups
for your sales and service teams.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure. Then, select Click2Create.

3. Select Settings > Button Set Name.

4. Select the button set that you want to add the Click2Create button to.

5. From Available Buttons, drag the Click2Create button to the My Position, Points of Interest, and
Mass Action sections.
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6. Save your changes.

7. To assign the button set to any permission group, select Permission Groups, and then select one.

8. Scroll to the Information Window section, and then assign your button set to the permission group.

9. Save your changes.

SEE ALSO:

Button Sets Options

Create and Maintain Button Sets
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Showing Nearby Maps in Salesforce Records and on Sites

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Bring context to records and sites when you add a Salesforce Maps component to page and site
layouts. Select from standard maps for accounts, contacts, cases, leads, and opportunities. Or create
custom maps that show the records or filtered layers of your choice.

Considerations for Setting Up Nearby Maps

Consider tradeoffs when you show your reps and partners nearby maps in Salesforce records
and on sites. You can include nearby maps when you add a Salesforce Maps component to
record and site layouts.

Add Nearby Maps to Salesforce Record Pages

Embed relevant, contextual nearby maps directly in records when you add a Salesforce Maps
component to page layouts in Lightning Experience.

Add Nearby Maps to Sites

Give your customers and partners context for what’s local and relevant on nearby maps that appear directly on your sites when you
add a Salesforce Maps component to site layouts.

Create Custom Nearby Maps

Customize nearby maps to show the records or filtered layers that you want to appear in Salesforce records and on sites when you
add a Salesforce Maps component to page and site layouts.

Considerations for Setting Up Nearby Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Consider tradeoffs when you show your reps and partners nearby maps in Salesforce records and
on sites. You can include nearby maps when you add a Salesforce Maps component to record and
site layouts.

Setting up nearby maps to appear in Salesforce records and on sites requires that you:

• Disable clickjack protection. Keep in mind that when you disable clickjack protection, you make
Salesforce less secure for your company.

• Provide geocoded data. To geocode your data, plot several layers on the map or run a geocoding
batch.

SEE ALSO:

Salesforce Help: Disable Clickjack Protection
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Add Nearby Maps to Salesforce Record Pages

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Embed relevant, contextual nearby maps directly in records when you add a Salesforce Maps
component to page layouts in Lightning Experience.

1. If you don’t use enhanced domains, skip to the next step.

Otherwise, from Setup, in the Quick Find box, enter Installed Packages, and then
select Installed Packages.

Next to the Salesforce Maps package, click Configure. On the Advanced tab, select the option
to use enhanced domains. Save your changes.

2. In Salesforce, open a record that you want a nearby map to, such as an account or a contact.

3. Click Setup > Edit Page.
Lightning App Builder appears.

4. Under Components, scroll to Custom–Managed. Drag the Maps Nearby Map component to an area of the page layout where you
want the map to appear.

5. If you use enhanced domains, skip to the next step.

Otherwise, in Community Path, enter your Salesforce domain followed by --maps.visualforce.com.
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For example, your Salesforce domain is https://northerntrailoutfitters. Enter the community path:
https://northerntrailoutfitters--maps.visualforce.com

6. In Nearby Map, specify what you want to appear on the map.

For example, to show the account’s marker in the center of the map, select Default Account Billing.

7. Save your changes.

The nearby map appears on the record.

SEE ALSO:

Considerations for Setting Up Nearby Maps

Salesforce Help: Create and Configure Lightning Experience Record Pages

Salesforce Help: My Domain

Add Nearby Maps to Sites

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Give your customers and partners context for what’s local and relevant on nearby maps that appear
directly on your sites when you add a Salesforce Maps component to site layouts.

1. If you have enhanced domains turned off in My Domain Settings, skip to Step 4.

2. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

3. Next to the Salesforce Maps package, click Configure. On the Advanced tab, select the option
to use enhanced domains. Then save your changes.
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4. From Setup, in the Quick Find box, enter All Sites, and then select All Sites.

5. Next to the site that you want to add a nearby map to, click Builder.

6. Select Components, and then scroll to Custom Components. Drag the Maps Nearby Map component to an area of the site layout
where you want the nearby map to appear.

7. In Community Path, enter your site’s domain.

If you have enhanced domains turned on, enter the URL as it appears for your site.

If you have enhanced domains turned off, enter the URL followed by --maps.visualforce.com. For example, your Salesforce
domain is https://northerntrailoutfitters. Enter the path:
https://northerntrailoutfitters--maps.visualforce.com

8. In Nearby Map, select a global nearby map that you want to appear on the site. For example, to show all nearby account markers,
select All Accounts.

9. Publish your site.

127

Salesforce Maps SetupSalesforce Maps



The nearby map appears on the site.

SEE ALSO:

Salesforce Help: Enhanced Domains

Create Custom Nearby Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Customize nearby maps to show the records or filtered layers that you want to appear in Salesforce
records and on sites when you add a Salesforce Maps component to page and site layouts.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Click Configure next to the Salesforce Maps package.

3. Select Nearby Map, and then click Create New.

4. Name your map, and then select what you want the map to show.

For example, to show:

• Other records within close proximity to the record you’re working on, select This Record and Nearby.

• A predefined, filtered layer, select Global (filtered).

5. Customize your map, and then save your changes.

SEE ALSO:

Considerations for Setting Up Nearby Maps
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Plot Specific Layers for Reps when They Start Sessions

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Show the layers that managers and operations want to appear when reps start their sessions in
Salesforce Maps. That way, your reps can jump right into their work without searching for critical
details. For example, set marker, data, and ArcGIS layers that give reps more context for sales and
service work in their respective areas.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Select Permission Groups, and then edit the one that you want to specify which layers to load
on the map.

4. Search for and select the layers you want to appear for your reps.

5. Save your changes.

Setup Reference
Learn about settings and options so that Salesforce Maps works for your reps and managers the way you intend.

Data Coverage for Salesforce Maps Products and Sales Planning

Access coverage for the data that's available in Salesforce Maps, Salesforce Maps Advanced, Sales Planning, and Territory Planning.
For each country that matters to you, identify available data such as latitude and longitude coordinates, routes, and territory boundaries.

Data Sources for the Salesforce Maps Product Portfolio

Learn about the data available to you in Salesforce Maps and access details about the providers of that data.

General Settings Options

Understand the impact of the options that you select for Salesforce Maps users.
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Base Objects Settings

Fine-tune base objects in Salesforce Maps to meet your business needs.

Button Sets Options

Help field reps make their sales and service times as efficient as possible when you define button sets for users and profiles in
Salesforce Maps.

Permission Group Settings

Make informed decisions when you set up and maintain permission groups in Salesforce Maps.

Check In Activity Fields and Criteria

Define activity settings for the custom activity fields that you create to work with Salesforce Maps Check In.

Reference for Shape, Marker, and Data Layers

Customize shape, marker, and data layers using supported field and postal code formats in Salesforce Maps.

Requirements for Salesforce Maps Live Tracking

Ensure optimal tracking performance for your reps in the field when they meet minimum platform requirements for Live Tracking
on the Salesforce Maps mobile app.

Single Sign-On Options for Mobile Devices

Streamline the log-in process so that your reps log in to Salesforce and Salesforce Maps at the same time.

Data Coverage for Salesforce Maps Products and Sales Planning

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Access coverage for the data that's available in Salesforce Maps, Salesforce Maps Advanced, Sales
Planning, and Territory Planning. For each country that matters to you, identify available data such
as latitude and longitude coordinates, routes, and territory boundaries.

Access to Data Coverage

Download the Data Coverage by Country for Salesforce Maps Products and Sales Planning
spreadsheet.

Boundary Discrepancies

These products provide boundary data sourced from numerous data providers. Keep in mind that
boundaries from the data providers and your sources can vary. If the boundaries within Salesforce
Maps products and Sales Planning seem inaccurate to you, contact Salesforce Customer Support.

• Your support engineer can investigate potential data issues. If an issue originates in Salesforce Maps products or in Sales Planning,
the product team can schedule its resolution.

• And Salesforce can work with the data providers to correct inaccuracies. But Salesforce can’t control whether or when providers
resolve any of their inaccuracies.
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Data Sources for the Salesforce Maps Product Portfolio

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Learn about the data available to you in Salesforce Maps and access details about the providers of
that data.

Salesforce Maps and its portfolio of products are licensed to use data from these sources.

DetailsSource

This product is licensed to use data from ATTOM Data Solutions.ATTOM Data Solutions

Australian Bureau of
Statistics

• Australian Census

• Creative Commons

Modifications and derivative analytics are not endorsed by the Curator.

Companies House

This does not constitute an endorsement by Companies House of this
product.

Companies House

This product is licensed to use data from DatabaseUSA.Database USA

U.S. Energy Information Administration

This does not constitute an endorsement by EIA of this product.

EIA

Eurostat • Eurostat

• European Commission

The European Union authorizes reuse, provided the source is
acknowledged. This does not constitute an endorsement by EU or
Eurostat of this product.

This product is licensed to use data from HERE Technologies.HERE

INEGI • National Institute of Statistics and Geography

• This information is from INEGI with adherence to the provisions
of the INEGI’s Terms of Free Use of Information.

This product is licensed to use data from Pitney Bowes.Pitney Bowes

This product is licensed to use data from Precisely.Precisely

Statistics Canada

This does not constitute an endorsement by Statistics Canada of this
product.

StatCan

Statistics New Zealand

Licensed under the Creative Commons Attribution 3.0 New Zealand
license. Modifications and derivative analytics are not endorsed by
the Curator.

Stats NZ
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DetailsSource

This product uses data from:UK Office of National Statistics &
National Records of Scotland • Nomis

• National Records of Scotland

Under the terms of the Open Government License (OGL) and UK Government Licensing
Framework, anyone wishing to use or re-use ONS material, whether commercially or privately,
may do so freely without a specific application for a license, subject to the conditions of the OGL
and the Framework.

This product uses the Census Bureau Data API but is not endorsed or certified by the Census
Bureau.

US Census Bureau

This product is licensed to use data from Google.Google

This product is licensed to use data from Esri.Esri

This product uses weather APIs powered by AerisWeather.AerisWeather

General Settings Options

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Understand the impact of the options that you select for Salesforce Maps users.

What It DoesOption

Governs who can access specific shared folders within the Corporate folderFolder Permissions

Distinguishes among multiple users who share first and last names when
you include profile names next to usernames

Show user profile
names on popups

Lets users assign routes at or below their level in the user role hierarchyRouting Role Security

Option that’s reserved for Salesforce Customer SupportDebug Logs
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Base Objects Settings

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Fine-tune base objects in Salesforce Maps to meet your business needs.

What It DoesOption

Prioritizes event scheduling based on values of specific fields. For example,
you want reps to schedule events based on annual revenue. Here’s how.

Schedule Priority
Field

1. From Salesforce Maps Settings, select Base Objects > Edit.

2. Select the Account (Billing) base object.

3. In the Schedule Priority Field section, select Annual Revenue for your
priority field. Then, select your popup visual style.

4. Save your changes.

Lets you specify the content that posts to Chatter when reps check in, and
the maximum distance to check in from the check-in location. Here’s how.

Check In Settings

1. From Salesforce Maps Settings, select Base Objects > Edit.

2. Select a base object.

3. In the Check In Settings section, make selections for:

Post To
Determines whether Salesforce Maps creates a Chatter post, a task,
and an event, or a combination of them.

Verification Distance
Requires mobile users to be within a given distance of a record’s
geolocation to check in.

Chatter Body
Determines the content in Chatter posts generated when checking
in. Include any fields that you created in Activity Settings using
appropriate macros.

4. Save your changes.

Lets you set up the display and popups for custom Map It buttons.Map It Button
Settings 1. From Salesforce Maps Settings, select Base Objects > Edit.

2. Select a base object that you want to add a Map It button to.

3. In the Map It Settings section, create the popups that you want to
appear when reps click Map It.

4. Make selections for:

Map It Zoom Level
Shows the marker relative to the street, city, state, country, and
continent.

Map It Proximity On
Plots a proximity circle around markers created from when reps
click Map It.
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What It DoesOption

Radius of Circle
Sets the radius of the proximity circle.

Measurement Unit
Lets you select the unit of measurement to the radius.

5. Save your changes.

Button Sets Options

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Help field reps make their sales and service times as efficient as possible when you define button
sets for users and profiles in Salesforce Maps.

What It DoesLayout

Shows the action buttons available on the Actions tab when reps select
specific markers

Popup

Shows action buttons when users select multiple markers for a mass actionMass Action

With location services enabled, shows action buttons when users select
their location

My Position

Shows action buttons when users click POI search resultsPOI

Permission Group Settings

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Make informed decisions when you set up and maintain permission groups in Salesforce Maps.

What It DoesSetting

Lets users and profiles manage folders within the shared Corporate folder.Folder Admin

Lets users and profiles see personal folders of other users, based on each
user’s role in the Salesforce role hierarchy.

Show User Folders

Lets users and profiles export marker layer data from the Salesforce Maps
List View into a .csv  file.

Allow Marker Exports

Lets users and profiles view weather conditions and forecasts for a marker's
location.

Show Weather Tab

Lets users access their personal folders.Show Personal Folder

Lets users manage ArcGIS layers.Enable ArcGIS Layers

Lets users create and view data layers to visualize data from outside
Salesforce, based on its location.

Manage Data Layers
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What It DoesSetting

Saves field reps a step from having to check out after they check in

When reps check in, Salesforce Maps creates an activity logged against a record, and then marks it
complete.

Auto Check Out

Gives users and profiles live location tracking through mobile devices.Enable Live Mobile Tracking

Limits the number of markers that users and profiles can see to 2,000 or fewer in an external object
marker layer. Users can still plot multiple marker layers simultaneously.

Maximum Number of Records
to Plot for External Objects

Lets users export markers.Allow Marker Exports

Lets you assign a button set you created to a user or profile.Button Set Name

Lets users and profiles create, modify, and aggregate territory layers.Manage Territory Layers

Check In Activity Fields and Criteria

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Define activity settings for the custom activity fields that you create to work with Salesforce Maps
Check In.

CriteriaField

Created Latitude • Field Type: Number

• Field Label: Created Latitude

• Length: 3

• Decimal Places: 15

Created Longitude • Field Type: Number

• Field Label: Created Longitude

• Length: 3

• Decimal Places: 15

Distance From Record
(mi)

• Field Type: Number

• Field Label: Distance From Record (mi)

• Length: 14

• Decimal Places: 4

Created Location
Accuracy (m)

• Field Type: Number

• Field Label: Created Location Accuracy (m)

• Length: 14

• Decimal Places: 4

Created Location
Verified

• Field Type: Checkbox

• Field Label: Created Location Verified
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CriteriaField

• Default Value: Unchecked

Check Out Latitude • Field Type: Number

• Field Label: Check Out Latitude

• Length: 3

• Decimal Places: 15

Check Out Longitude • Field Type: Number

• Field Label: Check Out Longitude

• Length: 3

• Decimal Places: 15

Check Out Date • Field Type: Date/Time

• Field Label: Check Out Date

Check Out Accuracy (m) • Field Type: Number

• Field Label: Check Out Accuracy (m)

• Length: 14

• Decimal Places: 4

Check Out Distance From
Record (mi)

• Field Type: Number

• Field Label: Check Out Distance From Record (mi)

• Length: 14

• Decimal Places: 4

Reference for Shape, Marker, and Data Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Customize shape, marker, and data layers using supported field and postal code formats in Salesforce
Maps.

Marker Layer Options

Apply formats, filters, and visual settings that increase your reps effectiveness when they plot
marker layers in Salesforce Maps.

Supported Postal Code Formats for Shape Layers

Review supported formats by country for the postal codes that you add to Salesforce Maps
shape layers.

Fields for Property Data (USA)

Generate more leads when you identify opportunities using public US property data available
in Salesforce Maps. Filter and plot data layers that help you discover customers who can benefit from your products and services.
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Fields for Business Data (USA)

Drum up more business when you make the most of public US business data available in Salesforce Maps. Filter and plot data layers
that help you identify sales and service opportunities relevant to your business efforts.

Marker Layer Options

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Apply formats, filters, and visual settings that increase your reps effectiveness when they plot marker
layers in Salesforce Maps.

Filters

To limit the results in a marker layer to a particular scope, apply filters. Filtering marker layers is
similar to filtering Salesforce Reports.

What It DoesFilter Type

Specifies the records that you want to see by accessing fields on the record
detail page and lookups to parent objects. Not available for long text
fields.

Field Filters

Creates a report by showing objects with or without tasks and events
during a specific time period.

Activity Filters

Includes or excludes records from related objects and their fields. Add up
to two cross-object filters to their marker layer and extra subfilters under
those objects.

Cross Filters Set

Markers

Review the options to assign colors and shapes for markers.

What It DoesOption

Makes all markers the same color and shape. Select a new shape and color for all markers from the
preset marker type or create a custom marker type. Marker Type determines the shape and color of
markers. Standard marker shapes and colors meet Salesforce accessibility standards.

Uniform

Dynamically assigns colors and shapes to markers based on the value of the selected field type.Varied Based On 1 Field

Assigns marker colors and shapes based on two field values. One field determines marker color and
the other determines marker shape.

Varied Based On 2 Fields

Shows the label field of your choice or the field from Marker Pop-ups > Title Field for this marker
layer instead of a marker shape. Assigns static text and background colors for labels, or dynamically
assigns colors to labels based on a field from the base object.

Labeled Pins

Selects a field to display a numeric order for all markers based on their value for that field.Ordered by a Field

Heat Map

Show the intensity of data at geographical points on your heat map.
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DescriptionOption

The radius of influence for each data point, in pixels. The recommended radius value is 15.Unit Radius in Pixels

The opacity of the heat map from 0 through 100%. The recommended opacity value is 80%.Opacity

Lets you specify a fixed maximum, which helps when your dataset contains a few outliers with an
unusually high intensity. By default, Salesforce Maps dynamically scales heat map colors according
to the greatest concentration of points at any particular pixel on the map

The recommended max intensity value is 5, unless you assign a weighted value. If you assign a weighted
quantitative value, change the max intensity to 90% of the maximum value of the field you chose.
For example, if your maximum annual revenue is 1,000,000, set the max intensity to 900,000.

Maximum Intensity

Specifies whether heat maps dissipate on zoom. When deselected, the radius of influence increases
with the zoom level to ensure that Salesforce Maps preserve the color intensity at a given geographic
location.

Fade heat map with zoom

The field that you want to show on the heat map. By default, the heat map depicts the quantity of
records in a location. Colors for high-density areas are red and low-density areas are black. To change
a color, click it.

Weighted Value

The color gradient of the heat map, specified as an array of CSS color strings. Salesforce Maps supports
all CSS3 colors, including RGBA, except for extended named colors and HSL(A) values.

Color Gradient

Proximity

Display proximity radius circles around every marker in a marker layer.

What It DoesOption

Shows a proximity circle around each marker on the map.Show proximity around
markers

Shows proximity circles but hides markers of the currently plotted marker layer.Hide proximity center markers

Shows markers that fall within the proximity of the currently plotted marker layer.Hide markers outside of
proximities

Sets the default proximity circle radius.Radius Distance

Sets the unit of measurement for the proximity circle radius distance.Distance Units

Advanced Options

What It DoesOption

Sets automatic page refreshes if the dataset updates frequently or is monitored by an end user.Map Updates

Sets the default tooltip tab for a marker.Tooltip Default Tab

Limits the number of markers that appear on the map. Limits which markers appear on the map by
proximity boundary.

Marker Limits
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Marker Popups

Customize what information popups show. Select fields to display on the popups Details tab, or if the In-Line editing user permission is
enabled, update the fields from the map. Add objects and fields that you want to appear on the Related tab. The Related tab shows as
many as 10 related records for each marker that appears on the map.

Supported Postal Code Formats for Shape Layers

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Review supported formats by country for the postal codes that you add to Salesforce Maps shape
layers.

Example of Postal Code in Its Supported FormatCountry

6402Albania

A4400Argentina

5950Australia

6837Austria

2234Belarus

4701Belgium

PG 05Bermuda

75211Bosnia and
Herzegovina

01236Brazil

2873Bulgaria

T5WCanada

KY1-1700Cayman Islands

938Chile

153407Colombia

60116Costa Rica

32257Croatia

2120Cyprus

317 00Czechia

8789Denmark

43000Dominican Republic

11Egypt

74227Estonia

88615Finland
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Example of Postal Code in Its Supported FormatCountry

33230France

97370French Guiana

97334Germany

460 33Greece

97136Guadeloupe

1007Hungary

815Iceland

473775India

16875Indonesia

Y21Ireland

47249Israel

09067Italy

820Japan

21682Jordan

00Kuwait

5052Latvia

99287Lithuania

4057Luxembourg

31050Malaysia

QLAMalta

97290Martinique

97670Mayotte

04960Mexico

7414Moldova

81104Montenegro

33Morocco

9673Netherlands

2019New Zealand

1117North Macedonia

6715Norway
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Example of Postal Code in Its Supported FormatCountry

5614Philippines

83-041Poland

4650Portugal

01Romania

950Russia

25396Saudi Arabia

11223Serbia

21Singapore

987 01Slovakia

8256Slovenia

7141South Africa

03559Spain

982 60Sweden

3232Switzerland

904Taiwan

52200Turkey

210Ukraine

RM1United Kingdom

GU2 4United Kingdom

59022United States

772United States

75300Uruguay

3149Venezuela

98600Wallis and Futuna
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Fields for Property Data (USA)

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Generate more leads when you identify opportunities using public US property data available in
Salesforce Maps. Filter and plot data layers that help you discover customers who can benefit from
your products and services.

Salesforce Maps works with data providers that supply property data. Periodically, these providers
update their data, which means that your data layers reflect those updates. If the providers change
their data formats, Salesforce Maps includes new data layers for you to plot on the map. Salesforce
Maps can update, replace, or remove property data at any time.

DescriptionField

Details the area described by the AreaBuilding value.Area Building
Definition Code

Living square feet of all structures on the property.Area of Total Living
Space (Square Feet)

Amount paid by primary owner as provided by the assessor.Assessor Last Sale
Amount

Date when the primary owner acquired the property as provided by the
assessor in the format YYYY-MM-DD.

Assessor Last Sale
Date

Amount paid by previous owner as provided by the assessor.Assessor Prior Sale
Amount

The difference between the current market value represented by the AVM
value and the sum of the current outstanding loan amounts.

Available Equity

US Census assigned Block Group for subject property.Census Block Group

US Census assigned Tract Code for subject property.Census Tract

Combined Statistical Area (CSA) Names. Area consisting of at least two
adjacent metropolitan and micropolitan statistical areas that have

Combined Statistical
Area

substantial employment interchange as defined by the Office of
Management and Budget (OMB).

Construction Type.Construction Type

Anytown CA 90001-0001 CR0523 - Mailing carrier route.Contact: Owner
Mailing Address
Carrier Route

Anytown CA 90001-0001 CR0523 - Mailing city.Contact: Owner
Mailing Address City

123 1/2 N Main St. - Full mailing address.Contact: Owner
Mailing Address Full

Anytown CA 90001-0001 CR0523 - Mailing state.Contact: Owner
Mailing Address State

Mailing Standard U.S., PO Box, Rural Route.Contact: Owner
Mailing Address Type
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DescriptionField

Anytown CA 90001-0001 CR0523 - Mailing ZIP code.Contact: Owner Mailing
Address Zip

Anytown CA 90001-0001 CR0523 - Mailing ZIP plus 4 code.Contact: Owner Mailing
Address Zip 4

Mailing county of the property.Contact: Owner Mailing County

Mailing Federal Information Processing Standard (FIPS) code for the county.Contact: Owner Mailing FIPS

Core-Based Statistical Area (CBSA) Name - A US geographic area defined by the Office of Management
and Budget (OMB).

Core-Based Statistical Area
(CBSA) Name

The total number of rooms used as bathrooms. Includes partial bathrooms. Value can be interpreted.Count: Bathrooms

The number of rooms that can be qualified as bedrooms.Count: Bedrooms

The number of buildings on the property.Count: Buildings

Indicates the number of fireplaces on a property.Count: Fireplace

The number of rooms for all the buildings on the property. If multiple buildings exist, the values are
aggregated.

Count: Rooms

The number of stories for the buildings on the property. If multiple buildings exist, the values are
aggregated.

Count: Stories

The number of units encompassed by the property.Count: Units

Based on the ATTOM Data Solutions Loan Model algorithm. Indicates the type of loan (conventional,
construction, HELoC, or FHA). The model determines which loan is in the first lien position.

Current First Position Mortgage
Type

Based on the ATTOM Data Solutions Loan Model algorithm. The original amount of the loan that is
modeled to be in the first lien position.

Current First Position Open
Loan Amount

Based on the ATTOM Data Solutions Loan Model algorithm. The recorded Document Number of the
loan that is modeled to be in the first lien position.

Current First Position Open
Loan Document Number
Formatted

Based on the ATTOM Data Solutions Loan Model algorithm. The interest rate of the loan that is modeled
to be in the first lien position.

Current First Position Open
Loan Interest Rate

Based on the ATTOM Data Solutions Loan Model algorithm. When available, indicates the type of
interest rate terms of the loan that is modeled to be in the first lien position. Left blank if unknown.

Current First Position Open
Loan Interest Rate Type

Based on the ATTOM Data Solutions Loan Model algorithm. The lender type of the loan that is modeled
to be in the first lien position.

Current First Position Open
Loan Lender Info Entity
Classification

Based on the ATTOM Data Solutions Loan Model algorithm. If the lender is a company, it indicates
the complete lender name of the loan represented by the

Current First Position Open
Loan Lender Name First

CurrentFirstPositionOpenLoanDocumentNumberFormatted field. If the lender is an individual, it
indicates the lender’s first name for the loan represented by the
CurrentFirstPositionOpenLoanDocumentNumberFormatted field.
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DescriptionField

Based on the ATTOM Data Solutions Loan Model algorithm. If the lender is an individual, it indicates
the lender’s last name for the loan represented by the
CurrentFirstPositionOpenLoanDocumentNumberFormatted field.

Current First Position Open
Loan Lender Name Last

Based on the ATTOM Data Solutions Loan Model algorithm. The recording date of the Document
associated with the loan that is modeled to be in the first lien position.

Current First Position Open
Loan Recording Date

Based on the ATTOM Data Solutions Loan Model algorithm. The type of loan (P-Purchase, R-Refinance,
E-Equity) that is modeled to be in the first lien position.

Current First Position Open
Loan Type

Current First Position Open Loan Amount + Current Second Position Open Loan Amount + Current
Third Position Open Loan Amount.

Current Open Loan Amount

Based on the ATTOM Data Solutions Loan Model algorithm. Indicates what type of loan (conventional,
construction, HELoC, or FHA). The model determines which loan is in the second lien position.

Current Second Position
Mortgage Type

Based on the ATTOM Data Solutions Loan Model algorithm. The original amount of the loan that is
modeled to be in the second lien position.

Current Second Position Open
Loan Amount

Based on the ATTOM Data Solutions Loan Model algorithm. The recorded Document Number associated
with the loan that is modeled to be in the second lien position.

Current Second Position Open
Loan Document Number
Formatted

Based on the ATTOM Data Solutions Loan Model algorithm. The interest rate for the loan that is
modeled to be in the second lien position.

Current Second Position Open
Loan Interest Rate

Based on the ATTOM Data Solutions Loan Model algorithm. When available, indicates the type of
interest rate terms for the loan that is modeled to be in the second lien position. Left blank if unknown.

Current Second Position Open
Loan Interest Rate Type

Based on the ATTOM Data Solutions Loan Model algorithm. The lender type for the loan that is modeled
to be in the second lien position.

Current Second Position Open
Loan Lender Info Entity
Classification

Based on the ATTOM Data Solutions Loan Model algorithm. If the lender is a company, it indicates
the complete lender name for the loan represented by the

Current Second Position Open
Loan Lender Name First

CurrentSecondPositionOpenLoanDocumentNumberFormatted field. If the lender is an individual, it
indicates the lenders first name for the loan represented by the
CurrentSecondPositionOpenLoanDocumentNumberFormatted field.

Based on the ATTOM Data Solutions Loan Model algorithm. If the lender is an individual, it indicates
the lender last name for the loan represented by the
CurrentSecondPositionOpenLoanDocumentNumberFormatted field.

Current Second Position Open
Loan Lender Name Last

Based on the ATTOM Data Solutions Loan Model algorithm. The recording date of the Document
associated with the loan that is modeled to be in the second lien position.

Current Second Position Open
Loan Recording Date

Based on the ATTOM Data Solutions Loan Model algorithm. The type of loan (P-Purchase, R-Refinance,
E-Equity) that is modeled to be in the second lien position.

Current Second Position Open
Loan Type

Based on the ATTOM Data Solutions Loan Model algorithm. Indicates the type of loan (conventional,
construction, HELoC, FHA). The model determines which loan is in the third lien position.

Current Third Position
Mortgage Type

Based on the ATTOM Data Solutions Loan Model algorithm. The original amount of the loan that is
modeled to be in the third lien position.

Current Third Position Open
Loan Amount
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DescriptionField

Based on the ATTOM Data Solutions Loan Model algorithm. The recorded Document Number of the
loan that is modeled to be in the third lien position.

Current Third Position Open
Loan Document Number
Formatted

Based on the ATTOM Data Solutions Loan Model algorithm. The interest rate of the loan that is modeled
to be in the third lien position.

Current Third Position Open
Loan Interest Rate

Based on the ATTOM Data Solutions Loan Model algorithm. When available, indicates the type of
interest rate terms of the loan that is modeled to be in the third lien position. Left blank if unknown.

Current Third Position Open
Loan Interest Rate Type

Based on the ATTOM Data Solutions Loan Model algorithm. The lender type of the loan that is modeled
to be in the third lien position.

Current Third Position Open
Loan Lender Info Entity
Classification

Based on the ATTOM Data Solutions Loan Model algorithm. If the lender is a company, it indicates
the complete lender name for the loan represented by the

Current Third Position Open
Loan Lender Name First

CurrentThirdPositionOpenLoanDocumentNumberFormatted field. If the lender is an individual, it
indicates the lenders first name for the loan represented by the
CurrentThirdPositionOpenLoanDocumentNumberFormatted field.

Based on the ATTOM Data Solutions Loan Model algorithm. If the lender is an individual, it indicates
the lender last name for the loan represented by the
CurrentThirdPositionOpenLoanDocumentNumberFormatted field.

Current Third Position Open
Loan Lender Name Last

Based on the ATTOM Data Solutions Loan Model algorithm. The recording date of the Document
associated with the loan that is modeled to be in the third lien position.

Current Third Position Open
Loan Recording Date

Based on the ATTOM Data Solutions Loan Model algorithm. The type of loan (P-Purchase, R-Refinance,
E-Equity) that is modeled to be in the third lien position.

Current Third Position Open
Loan Type

The latest sale date in the format YYYY-MM-DD.Deed Last Sale Date

The latest sale price.Deed Last Sale Price

Indicates the presence or absence of a fireplace. It also indicates the type of fireplace the property
contains.

Fireplace Type

Identifies whether the first owner is a company, an individual, a government, or unknown.First Owner Type

True if loan data exists.Flag: Loan

Owner status (Absentee or Occupied). Logic based.Flag: Owner Occupied

Indicates whether the property includes a carport and any information about carport.Flag: Parking Carport on
Property

Indicates the type of foundation for the primary structure on the property.Foundation Type

Gross square feet of all structures on the property.Gross Area of All Structures
(Square Footage)

Indicates the method or system used to provide cooling.HVAC Cooling Type

Indicates the primary heating fuel used.HVAC Heating Fuel Type
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DescriptionField

Indicates the method or system used to provide heat.HVAC Heating Type

Last sale date for the most recent ownership transfer. Can be the same as the AssessorLastSaleDate.
Can convey a non-arms-length transfer after the most recent sale in the format YYYY-MM-DD.

Last Ownership Transfer Date

80% of the difference between the current market value represented by the AVM value and the sum
of the current outstanding loan amounts.

Lendable Equity

Loan To Value calculated by dividing the sum of open loan amounts by the AVM value for the property.Loan-to-Value Ratio (LTV)

Indicates the lot size in square feet.Lot Area (Square Footage)

Indicates the lot depth in feet.Lot Depth (Feet)

Indicates the lot size in acres.Lot Size (Acres)

Indicates the lot width in feet.Lot Width (Feet)

Metropolitan Statistical Area Name as defined by the Office of Management and Budget (OMB).Metropolitan Statistical Area
Name

Full, unparsed name of first owner.Owner 1 Name Full

Full, unparsed name of second owner.Owner 2 Name Full

Indicates the ownership vesting held by the owners.Ownership Vesting Type

Legacy Parcel. Deprecated. No longer supported.Parcel Number Formatted

Primary Parcel Number and unique identifier within the county or jurisdiction.Parcel Number Raw

Garage square footage.Parking Garage Area (Square
Footage)

Indicates whether the property includes a garage and any information about the garage, such as
attached or detached.

Parking Garage Type

Indicates whether the property includes a pool and any information about the pool.Pool Type

The total square footage of porches on the property.Porch Area (Square Footage)

Indicates whether the property includes a porch, and potentially the type of porch.Porch Type

Previous Total assessed value.Previous Assessed Value

Indicates the primary exterior wall covering material.Primary Exterior Wall Covering
Material

County where the property is situated.Property Address County

State where the property is situated.Property Address State Code

Anytown CA 90001-0001 CR0523 - Site address city name.Property: Address City

123 1/2 N Main St. - Full site address line.Property: Address Full

Anytown CA 90001-0001 CR0523 - Site address state.Property: Address State
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DescriptionField

Anytown CA 90001-0001 CR0523 - Site address ZIP Code.Property: Address Zip

Anytown CA 90001-0001 CR0523 - Site address ZIP Plus 4 code.Property: Address Zip 4

Name of the tax jurisdiction. Typically the county, with some exceptions. Exceptions are primarily in
New England where the townships are the taxing authorities.

Property: Jurisdiction Name

The latitude of the property in degrees.Property: Latitude

The longitude of the property in degrees.Property: Longitude

Standardized value to describe property use. Derived from jurisdiction-specific zoned use value
obtained from the Assessor.

Property: Use (Detail)

General property type description, such as residential, commercial, or other.Property: Use Group (Main)

The year that the current Parcel Number was introduced into the ATTOM Data databases.Record Year Added

Indicates the primary finish material of which the roof is made.Roof Material

Identifies if second owner is a company, individual, government, or unknown.Second Owner Type

Indicates the structural style or the presence of specific style elements in the structure.Structure Style Type

Subdivision name.Subdivision Name

Assessed value of the improvements.Tax: Assessed Value
Improvements

Assessed value of the land.Tax: Assessed Value Land

Total assessed value.Tax: Assessed Value Total

Tax Amount billed for Tax Year.Tax: Billed Amount

The respective year of the property taxes being provided. Not always associated with values.Tax: Fcal Year

Market value of the improvements.Tax: Market Value
Improvements

Market value of the land.Tax: Market Value Land

Total market value.Tax: Market Value Total

Year of assessed values.Tax: Year Assessed

Indicates whether there’s an ocean or mountain or other amenable or disamenable view from the
property.

Type of View From Property

Adjusted year built based on condition and major structural changes of the structure.Year Built (Adjusted for
Structural Changes)

Year built of the primary structure.Year Built (Primary Structure)
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Fields for Business Data (USA)

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Drum up more business when you make the most of public US business data available in Salesforce
Maps. Filter and plot data layers that help you identify sales and service opportunities relevant to
your business efforts.

Salesforce Maps works with data providers that supply business data. Periodically, these providers
update their data, which means that your data layers reflect those updates. If the providers change
their data formats, Salesforce Maps includes new data layers for you to plot on the map. Salesforce
Maps can update, replace, or remove business data at any time.

DescriptionField

The full length Standard Industrial Classification (SIC) code.7-digit SIC

The 9-digit ID that the IRS assigns to US businesses. Also known as:Company: Employer
Identification Number
(EIN)

• Federal Employer Identification Number (FEIN)

• Federal Tax Identification Number

Branches of the Fortune 1000.Company: Fortune
1000 Branches

Numeric rank in the Fortune 1000.Company: Fortune
1000 Rank

The city in which the business's immediate parent company is located.Company: Immediate
Parent Company City

The name of the business's immediate parent company.Company: Immediate
Parent Company
Name

The state in which the business's immediate parent company is located.Company: Immediate
Parent Company State

The type of location: headquarters or branch.Company: Location
Type

The name of the company.Company: Name

Number of linked locations.Company: Number of
Linked Locations

Stock exchange on which the company's stock trades.Company: Stock
Exchange

Indicates that a company issues stock or is part of a company that is openly
traded.

Company: Ticker
Symbol

The number of individuals employed by the business at all of its branches,
divisions, and subsidiaries. The number appears on single location and

Company: Total
Employees
(Corporate) headquarter records. The number isn’t the sum of Number of Employees,

Location values of other members within the corporate family. For
businesses with one location, the value in this field matches the Number
of Employees, Location field. Some values are modeled.
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DescriptionField

The number of employees at this location. Some values are modeled.Company: Total Employees
(Location)

The city in which the business's parent company is located.Company: Ultimate Parent
Company City

The name of the business's parent company.Company: Ultimate Parent
Company Name

The state in which the business's parent company is located.Company: Ultimate Parent
Company State

The website of the company.Company: Website

The year that the company was established.Company: Year Established

The standardized range for the number of years the company is in business.Company: Years in Business
(Range)

Area code of the phone number.Contact: Area Code

The email address of the listed contact at or owner of the company.Contact: Email

A fax number for the business.Contact: Fax Number

The first name of the listed contact at the company.Contact: First Name

The full name of the listed contact at the company.Contact: Full Name

The gender of the contact at the company.Contact: Gender

The last name of the listed contact at or owner of the company.Contact: Last Name

The middle initial of the listed contact at the company.Contact: Middle Initial

A phone number for the business.Contact: Phone Number

The prefix of the listed contact at or owner of the company. For example, Mr., Ms., Dr., or Rev.Contact: Prefix

The job title of the listed contact at or owner of the company as reported by the company.Contact: Reported Job Title

The standardized job title of the listed contact at or owner of the company.Contact: Standardized Job Title

The suffix of the listed contact at or owner of the company.Contact: Suffix

The maximum recommended extension of credit to the business based on a proprietary model that
excludes credit bureau data. Don’t use this information to make a credit decision.

Credit: Capacity

The credit rating of the company indicated by grade letter. Modeled using a proprietary calculation
that excludes credit bureau data. Don’t use this information to make a credit decision.

Credit: Code

The description of the credit rating of the company.Credit: Description

The credit score of the company. Modeled using a proprietary calculation that excludes credit bureau
data. Don’t use this information to make a credit decision.

Credit: Score

Estimated business expenditure on accounting services.Expenses: Accounting
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Estimated business expenditure on advertising.Expenses: Advertising

Estimated business expenditure on insurance.Expenses: Business Insurance

Estimated business expenditure on legal services.Expenses: Legal

Estimated business expenditure on office equipment.Expenses: Office Equipment

Estimated business expenditure on rent.Expenses: Rent

Estimated business expenditure on technology.Expenses: Technology

Estimated business expenditure on telecommunication services and equipment.Expenses: Telecom

Estimated business expenditure on utilities.Expenses: Utilities

Indicates whether an email address is associated with the contact.Flag: Email Availability

Indication that the business owner is a woman.Flag: Female Owned

Indicates whether company is listed in the Fortune 1000.Flag: Fortune 1000

Indicates whether a company is a part of a franchise.Flag: Franchise

Indication that business is home-based.Flag: Home-Based Business

Indication that manufacturing is performed at this business location.Flag: Manufacturing Location

Indication of a not-for-profit organization.Flag: Non-Profit

Indicates that a company issues stock or is part of a company that is openly traded.Flag: Public Ownership

Indicates whether the company is a small business.Flag: Small Business

The 4-digit ZIP code extension.Location: 4-Digit ZIP

A code identifying the individual mail carrier for mail delivery. If the business has both a physical and
a mailing address, this code applies to the mailing address.

Location: Carrier Route

The city where the company is located.Location: City

The name of the metropolitan area as defined by the United States Office of Management and Budget
(OMB). Previously known as MSAs or Metropolitan Statistical Areas.

Location: Core-Based Statistical
Area (CBSA)

The code for the county where the company is located. Modeled using a proprietary calculation that
excludes credit bureau data. Don’t use this information to make a credit decision.

Location: County Code (FIPS)

The county where the company is located.Location: County Name

The digit assigned to every mailbox for all addresses in the US Postal Service. For example, apartments
and office buildings.

Location: Delivery Point

The digit assigned to every mailbox for all addresses in the US Postal Service. For example, apartments
and office buildings.

Location: Delivery Point Check
Digit

The degree of accuracy for the address down to the ZIP code level.Location: Geo Match Level
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The 2010 population estimate for the metropolitan area.Location: Population of City
(2010)

The area of the company workspace measured in square feet.Location: Square Footage

2-digit Federal Information Processing Standard (FIPS) state code.Location: State

The street address of the company.Location: Street Address

The time zone of the company.Location: Time Zone

The range of the number of personal computers at the business locationLocation: Total Personal
Computers (PC)

The 5-digit ZIP code.Location: ZIP Code

The 4-digit ZIP code extension.Mailing: 4-Digit ZIP

A code identifying the individual mail carrier for mail delivery. If the business has both a physical and
a mailing address, this code applies to the mailing address.

Mailing: Carrier Route

The name of the city or town where the business receives mail.Mailing: City

The digit assigned to every mailbox for all addresses in the US Postal Service. For example, apartments
and office buildings.

Mailing: Delivery Point

The digit assigned to every mailbox for all addresses in the US Postal Service. For example, apartments
and office buildings.

Mailing: Delivery Point Check
Digit

Indicates the risk that mail sent to the address can, for example, missorted, undelivered, delayed, or
destroyed.

Mailing: Mail Deliverability

The Processing and Distribution Center (P&DC) of the US Postal Service (USPS) for the business mailing
address.

Mailing: Sectional Center
Facility (SCF)

The standard 2-character USPS abbreviation for the state where the business receives mail.Mailing: State

The mailing address for the business in the form of a street address, a PO box number, a PO drawer
number, or a Rural Route number.

Mailing: Street Address

The 5-digit ZIP code.Mailing: ZIP Code

The industry sector associated with the two-digit North American Industry Classification System
(NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 1 - Sector

The industry sector code associated with the 2-digit North American Industry Classification System
(NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 1 - Sector Code

The industry subsector associated with the 3-digit North American Industry Classification System
(NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 2 - Subsector

The industry subsector code associated with the 3-digit North American Industry Classification System
(NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 2 - Subsector
Code

The industry group associated with the 4-digit North American Industry Classification System (NAICS)
code used by the federal government to classify businesses by industry.

NAICS: Level 3 - Industry Group
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The industry group code associated with the 4-digit North American Industry Classification System
(NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 3 - Industry Group
Code

The North American Industry associated with the 5-digit North American Industry Classification System
(NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 4 - North
American Industry

The North American Industry code associated with the 5-digit North American Industry Classification
System (NAICS) code used by the federal government to classify businesses by industry.

NAICS: Level 4 - North
American Industry Code

The US Industry associated with the six-digit North American Industry Classification System (NAICS)
code used by the federal government to classify businesses by industry.

NAICS: Level 5 - US Industry

The US Industry code associated with the 6-digit North American Industry Classification System (NAICS)
code used by the federal government to classify businesses by industry.

NAICS: Level 5 - US Industry
Code

The range of total annual sales for this business. This element is modeled for most businesses in the
database.

Sales: Range (USD)

The total annual sales for this business. This element is modeled for most businesses in the database.Sales: Total (USD)

The industry associated with the lettered division of the Standard Industrial Classification (SIC) code
developed by the US Government and enhanced by Database101 with three more digits. This code

SIC: Level 1 - Division

is assigned to businesses and other organizations, classifying and subdividing the activity performed
by the establishment at that location.

The industry code associated with the lettered division of the Standard Industrial Classification (SIC)
code developed by the US Government and enhanced by Database101 with three more digits. This

SIC: Level 1 - Division Code

code is assigned to businesses and other organizations, classifying and subdividing the activity
performed by the establishment at that location.

The industry description associated with the 2-digit group number of the Standard Industrial
Classification (SIC) code developed by the US Government and enhanced by Database101 with 3

SIC: Level 2 - Major Group

more digits. This code is assigned to businesses and other organizations, classifying and subdividing
the activity performed by the establishment at that location.

The industry description code associated with the 2-digit group number of the Standard Industrial
Classification (SIC) code developed by the US Government and enhanced by Database101 with 3

SIC: Level 2 - Major Group Code

more digits. This code is assigned to businesses and other organizations, classifying and subdividing
the activity performed by the establishment at that location.

The industry description associated with the 3-digit group number of the Standard Industrial
Classification (SIC) code developed by the US Government and enhanced by Database101 with 3

SIC: Level 3 - Industry Group

more digits. This code is assigned to businesses and other organizations, classifying and subdividing
the activity performed by the establishment at that location.

The industry description code associated with the 3-digit group number of the Standard Industrial
Classification (SIC) code developed by the US Government and enhanced by Database101 with 3

SIC: Level 3 - Industry Group
Code

more digits. This code is assigned to businesses and other organizations, classifying and subdividing
the activity performed by the establishment at that location.

The industry description associated with the 4-digit number of the Standard Industrial Classification
(SIC) code developed by the US Government and enhanced by Database101 with 3 more digits. This

SIC: Level 4 - Industry

152

Salesforce Maps SetupSalesforce Maps



DescriptionField

code is assigned to businesses and other organizations, classifying and subdividing the activity
performed by the establishment at that location.

The industry description code associated with the 4-digit number of the Standard Industrial
Classification (SIC) code developed by the US Government and enhanced by Database101 with 3

SIC: Level 4 - Industry Code

more digits. This code is assigned to businesses and other organizations, classifying and subdividing
the activity performed by the establishment at that location.

Requirements for Salesforce Maps Live Tracking

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Ensure optimal tracking performance for your reps in the field when they meet minimum platform
requirements for Live Tracking on the Salesforce Maps mobile app.

The Salesforce Maps mobile app shares minimum platform requirements for devices and networks
with the Salesforce mobile app, but with some exceptions. Keep in mind that Salesforce can update
minimum platform requirements for both mobile apps from time to time.

Mobile Devices

For the best performance using Live Tracking on the Salesforce Maps mobile app, Salesforce requires
any of these devices and their corresponding operating systems.

Operating SystemDevice

iOS 14.0 or lateriPhone 8 or newer

Android 8.0 or laterSamsung Galaxy S models
S9 or newer

Google Pixel 2 or newer

While Salesforce doesn’t support using other devices and operating systems for Live Tracking, using them can still deliver adequate
performance.

Wireless Network Coverage

Performance for Live Tracking depends on a number of factors, including:

• Availability of A Wi-Fi or cellular network connection

For Live Tracking, Salesforce requires connections to 4G LTE networks of 12 Mbps or faster.

• Your reps’ geographical location

• The communications infrastructure surrounding your reps’ geographical location

Expect differences in performance among your reps depending on their location, terrain, and the local communications infrastructure.

SEE ALSO:

Salesforce Help: Requirements for the Salesforce Mobile App
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Single Sign-On Options for Mobile Devices

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Streamline the log-in process so that your reps log in to Salesforce and Salesforce Maps at the same
time.

Salesforce Maps supports SAML SSO with Salesforce as the service provider.

SEE ALSO:

Salesforce Help: SAML SSO with Salesforce as the Service Provider

Salesforce Maps Advanced Setup

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Reduce the time that sales and service managers and their reps spend planning customer visits.
Automate schedules and routes for your reps as far out as three months. The visit plans that you
create get your teammates facing more customers and driving fewer miles.

The Basics of Salesforce Maps Advanced

Automate your sales and service reps’ schedules and routes for up to 3 months using Salesforce
Maps Advanced. Review key use cases to get ideas for your own implementation and rollout.

Implementing Salesforce Maps Advanced Routing

Install and configure Salesforce Maps Advanced routing so that sales and service managers
support their reps with optimized routes, visits, and schedules.

The Basics of Salesforce Maps Advanced

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Automate your sales and service reps’ schedules and routes for up to 3 months using Salesforce
Maps Advanced. Review key use cases to get ideas for your own implementation and rollout.

What Is Salesforce Maps Advanced?

Meet target sales touchpoints when you optimize routes and improve field efficiency.

High-Level Tasks and Roles in Route Optimization

Learn about roles in Salesforce Maps Advanced for sales and service managers and the field
reps that they manage. And understand the tasks that managers and reps complete.

Key Terms and Concepts for Salesforce Maps Advanced Routing

Learn about terms and concepts that you encounter in Salesforce Maps Advanced before you
implement it.

Sample Scenarios for Salesforce Maps Advanced Routing

Salesforce Maps Advanced routing supports complex use cases in pharmaceutical, consumer goods, food service, and other industries.
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What Is Salesforce Maps Advanced?

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Meet target sales touchpoints when you optimize routes and improve field efficiency.

Salesforce Maps Advanced includes these features.

• Route optimization for up to 3 months at a time. For example, a pharmaceutical sales
operations manager has 25 new field reps to onboard. Managers create initial routes for field
reps, ensuring that the reps meet the minimum visit requirements for the medical offices that
they support.

• Thematic maps. For example, a sales manager creates a heat map to color-code regions based
on customer volume. Or, the sales manager color-codes regions by aggregated values, such as
total opportunity value.

• Data import for map layers. For example, a sales manager imports potential medical office
leads to see if any office locations overlap existing account locations.

High-Level Tasks and Roles in Route Optimization

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Learn about roles in Salesforce Maps Advanced for sales and service managers and the field reps
that they manage. And understand the tasks that managers and reps complete.

Managers set up the product and visit plans, which are the templates for routes. Field reps generate
their routes automatically, providing input, such as their days off and shift times.

ExampleDetailsHigh-Level Task

A service manager sets up the product to give access to all
service reps. The service manager creates a custom routable

Typically, sales and service managers use their
knowledge of company business rules and processes
to set up Salesforce Maps Advanced.

Install and set up

object called ServiceAccount to use for location data for
the routes.

A retail sales manager creates a visit plan for store account
reps that includes account and location data, weekly visit

Before field reps can generate their routes, managers
create a visit plan, or template. The visit plan contains

Create a visit plan
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ExampleDetailsHigh-Level Task

frequency, and a custom visit window between 10:00 AM
and 12:00 PM.

the data, users, and criteria to optimize routes as
much as possible, including visit windows.

A restaurant sales rep decides to take off Friday, but the rep
must fulfill the weekly visit target. When the rep generates

After providing their calendar and schedule
information, field reps generate their routes. Visit
plans then determine the best-fitting routes.

Generate routes

the route, the product schedules account visits Monday
through Thursday, avoiding the day off on Friday.

To keep Salesforce data up to date, a sales operations
manager schedules periodic data sync batch jobs. In

During the route generation lifecycle, managers
identify areas to maintain and optimize in Salesforce
Maps Advanced.

Use best practices

another example, a restaurant sales manager updates a
visit plan to accommodate a Restaurant Week promotional
period.

Key Terms and Concepts for Salesforce Maps Advanced Routing

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Learn about terms and concepts that you encounter in Salesforce Maps Advanced before you
implement it.

What’s a Routable Object?

A standard or custom object containing location data that can be mapped. Salesforce Maps Advanced
comes with standard Salesforce routable objects such as accounts, cases, contacts, leads, and
opportunities. Your field reps visit locations on their routes, such as an account location.

Example:  You can create a custom routable object that contains retail store or dental office
location data.

What’s a Visit Plan?

A template for creating a route. Visit plans collect the requirements for a route in one place, enabling you to easily regenerate routes
with the same criteria if your calendar changes. Visit plans include routable objects to represent accounts or visits, a list of reps who
perform the visits, start and end dates, and other settings such as shift times.

Example: You can create a visit plan for a pharmaceutical sales team’s quarter. The plan contains all providers that require visits
and their respective visit targets and cadences for October through December.

What’s a Visit Window?

A timeframe in which a customer or prospect accepts visits from a rep. A visit window can include specific days in the week or even
certain hours during the day. You specify visit windows in visit plans. After visit windows are set, Salesforce Maps Advanced schedules
all future visits within these windows. If you don’t specify visit windows in the visit plan, Salesforce Maps Advanced schedules visits
within the reps’ working hours and the visit plan start and end dates.

Example:  A doctor’s office has a visit window of Monday through Thursday, 2:00 PM to 4:00 PM. A restaurant has a visit window
during their slow time of 10:00 AM to 11:30 AM.
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What’s the Relationship Between Visit Plans and Routes?

Optimized routes are the output of visit plans. When a field rep generates a route in Salesforce Maps Advanced, the visit plan tells the
product the requirements for the route. Reps can regenerate routes from visit plans whenever their schedules and other criteria change,
such as customer visit windows and days off.

What’s an Output Object?

A standard or custom object that represents a scheduled visit after a rep generates a route. By default, output is events on reps’ Salesforce
calendars.

Example:  You can create a custom output object that represents a visit in Consumer Goods Cloud.

Days Between Visits

Learn how Salesforce Maps Advanced determines the dates for customer visits by using minimum and maximum days between
visits.

SEE ALSO:

Create a Custom Routable Object

Creating Visit Plans

Create Shared Visit Windows for Individual Routable Object Records

Creating a Custom Output Object for Visits

Days Between Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Learn how Salesforce Maps Advanced determines the dates for customer visits by using minimum
and maximum days between visits.

Minimum and maximum days between visits, or visit frequency, determine when the next customer
visit occurs. When you create a visit plan, you specify the visit frequency by entering the number
of days or by specifying object fields containing the number of days.

Example:  During a 3-month planning period, your account requires three visits, or one a
month. You divide the total days in the period (90) by the number of expected visits (3) to
get 30 days maximum between visits. In your visit plan, you specify the maximum days
between visits as 30. To increase the likelihood of visits occurring within those 30 days, you
set the minimum days between visits as 27.

To adhere to the minimum and maximum days between visits, we see that the rectangles
show when visits can occur. The circles show the days that Salesforce Maps Advanced
scheduled the visits.
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SEE ALSO:

Specify Visit Frequency, Duration, and Visit Windows

Create Shared Visit Windows for Individual Routable Object Records

Set Up Visit Window Selection for Specific Routable Object Records

Sample Scenarios for Salesforce Maps Advanced Routing

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Salesforce Maps Advanced routing supports complex use cases in pharmaceutical, consumer goods,
food service, and other industries.

Route Planning and Coverage for Pharmaceutical Reps

Suppose you’re a pharmaceutical sales operations manager with 25 new field reps to onboard.
Use Salesforce Maps Advanced routing to create routes for the field reps’ first month, to help
ensure that they meet the visit targets for the medical offices that they support. Use the following
checklist to assemble your data and criteria before you generate routes.

Complex Visit Frequencies and Windows for Consumer Goods Reps

Suppose you’re a retail sales manager using Consumer Goods Cloud to support brick-and-mortar
store accounts and seasonal retail pop-up stores. It can be a challenge to balance routes to
maintain customer satisfaction and meet visit targets. And you want to avoid burning out your
reps. Use this checklist to assemble your data and criteria before you generate routes in Salesforce Maps Advanced.

Visit Prioritization for Restaurant Account Reps

Suppose you’re a restaurant sales manager with reps who service food and beverage accounts. In November, your region has a
Restaurant Week promotion. Clients who participate in the promotion require higher visit frequencies. And Restaurant Week clients
are prioritized over other clients for that week. Your challenge is to ensure that they’re prioritized without manually creating routes
to optimize reps’ workload and to accommodate days off. Use this checklist to assemble your data and criteria before you generate
routes in Salesforce Maps Advanced.
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Route Planning and Coverage for Pharmaceutical Reps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Suppose you’re a pharmaceutical sales operations manager with 25 new field reps to onboard. Use
Salesforce Maps Advanced routing to create routes for the field reps’ first month, to help ensure
that they meet the visit targets for the medical offices that they support. Use the following checklist
to assemble your data and criteria before you generate routes.

Note:  Salesforce Maps Advanced schedules reps for in-person visits only.

Pre-Implementation Checklist

Scenario DetailsRequirement

The object that represents rep visits. In this scenario, rep visits appear as events
on your reps’ Salesforce calendars, so your calendar object is the Event object.

Calendar object

The object containing the locations of your medical office accounts. In this
scenario, assume that your Accounts object contains location data. If it doesn’t,
create a custom object that contains the location data.

With location data you can generate the most efficient routes for your reps.

Routable object
for location data

In this scenario, the minimum and maximum days between visits are 10 and
30 days, respectively. Office business hours are 9 AM to 5 PM.

Visit frequency
and visit windows

The object containing data about whether your reps have completed a visit.
In this scenario, your visit object is the Task object.

Visit object

Accounts are assigned to reps through a user lookup field on the routable
object. In this scenario, the account owner is responsible for visiting the

Assigned
accounts

medical offices. When you generate routes, the optimization process adds
stops to your reps’ schedules for the accounts that they own.

You’re generating routes for the month of January, so your start date is January
1 and the end date is January 30.

Visit timeframe

Your field reps have a maximum shift of 8 hours.Maximum shift
length and other
settings

Conflicting events on your reps’ calendars, such as days off, are accounted for when Salesforce Maps Advanced creates routes. You can
regenerate routes at any time to accommodate changes such as rep rescheduling or company holidays.
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Complex Visit Frequencies and Windows for Consumer Goods Reps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Suppose you’re a retail sales manager using Consumer Goods Cloud to support brick-and-mortar
store accounts and seasonal retail pop-up stores. It can be a challenge to balance routes to maintain
customer satisfaction and meet visit targets. And you want to avoid burning out your reps. Use this
checklist to assemble your data and criteria before you generate routes in Salesforce Maps Advanced.

Note:  Salesforce Maps Advanced schedules reps for in-person visits only.

Pre-Implementation Checklist

Scenario DetailsRequirement

The object that represents rep visits. In this scenario, rep visits are represented
by visit records in Consumer Goods Cloud, so you add a lookup relationship
to the visit object in Routes & Schedule in Setup.

Calendar object

The object containing the locations of your retail accounts. In this scenario,
you use the Retail Store object, with location information in that object.

With location data you can generate the most efficient routes for your reps.

Routable object
for location data

In this scenario, the Retail Stores object contains formula fields for minimum
and maximum days between visits derived from quarterly visit requirements.

Visit frequency
and visit windows

The Retail Stores object looks up to visit windows that contain standard
business hours and temporary visit windows for seasonal businesses.

The object containing data about whether your reps have completed a visit.
In this scenario, your visit object is the Visit object in Consumer Goods Cloud.

Visit object

Accounts are assigned to reps through a user lookup field on the routable
object. In this scenario, the account owner is responsible for visiting stores.

Assigned
accounts

When you generate routes, the optimization process adds stops to your reps’
schedules for the accounts that they own.

You’re generating routes for the fourth quarter of the calendar year, so your
start date is October 1 and the end date is December 31.

Visit timeframe

Your field reps have a maximum shift of 7 hours.Maximum shift
length and other
settings

Example for Determining Days Between Visits

Your customers expect three visits every quarter.

By Using this MethodDetermine

Calculate the number of days in the quarter.

90 days / 3 months = 30 days maximum between visits

Maximum days

Decide on a number of days between visits that’s less than 30 so that optimizations can adjust visit schedules
and increase the likelihood of achieving full coverage.

Minimum days
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Customers Who Require Special Visit Schedules

When visit requirements for customers vary, you can route reps through the same neighborhoods multiple times. To help your reps
avoid repeat trips through the same neighborhoods on different days, cluster visits geographically. To do so, determine a common
denominator for the minimum days between visits such as 7, 14, 21, or 28.

SEE ALSO:

Salesforce Help: Retail Execution for Sales Managers

Visit Prioritization for Restaurant Account Reps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Suppose you’re a restaurant sales manager with reps who service food and beverage accounts. In
November, your region has a Restaurant Week promotion. Clients who participate in the promotion
require higher visit frequencies. And Restaurant Week clients are prioritized over other clients for
that week. Your challenge is to ensure that they’re prioritized without manually creating routes to
optimize reps’ workload and to accommodate days off. Use this checklist to assemble your data
and criteria before you generate routes in Salesforce Maps Advanced.

Note:  Salesforce Maps Advanced schedules reps for in-person visits only.

Pre-Implementation Checklist

Scenario DetailsRequirement

The object that represents rep visits. In this scenario, rep visits are represented
by events on your reps’ Salesforce calendars, so your calendar object is the
Event object.

Calendar object

The object containing the locations of your food and beverage accounts. In
this scenario, assume that your Accounts object contains location data. If it
doesn’t, create a custom object that contains the location data.

You also have a custom routable object, RW_Accounts, that contains
Restaurant Week account locations only. You prioritize the RW_Accounts

Routable object
for location data

object over the Accounts object when you create routes for your reps.
Prioritization means that Salesforce Maps Advanced schedules Restaurant
Week clients sooner on reps’ calendars so that they meet or exceed the
maximum number of visits scheduled.

In this scenario, the Accounts object contains fields for visit target numbers
for the quarter and visit target numbers for Restaurant Week.

Visit frequency
and visit windows

The object containing data about whether your reps have completed a visit.
In this scenario, your visit object is the Task object.

Visit object

Accounts are assigned to reps through a user lookup field on the routable
object. In this scenario, the account owner is responsible for visiting the

Assigned
accounts

restaurants. When you generate routes, the optimization process adds stops
to your reps’ schedules for the accounts that they own.

You’re generating routes for the month of November, so your start date is
November 1 and the end date is November 30.

Visit timeframe
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Scenario DetailsRequirement

Your field reps have a maximum shift of 8 hours.Maximum shift length
and other settings

Implementing Salesforce Maps Advanced Routing

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Install and configure Salesforce Maps Advanced routing so that sales and service managers support
their reps with optimized routes, visits, and schedules.

Preparing for Routing Automation

Get systems, processes, and people in place before you create visit plans in Salesforce Maps
Advanced routing. Before you begin, confirm that you installed Salesforce Maps and gave users
access to it and to Salesforce Maps Advanced.

Creating Visit Plans

In Salesforce Maps Advanced, sales and service managers create visit plans that contain the
input for reps’ routes.

Fine-Tuning Your Routing Implementation

To streamline your business processes, refine your routing implementation after you set up Salesforce Maps Advanced and create
a visit plan. For example, create predefined visit windows for chains and franchises and then share them with your reps to apply to
their accounts.

Best Practices for Routing Success

As you implement Salesforce Maps Advanced, observe these best practices.

Preparing for Routing Automation

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Get systems, processes, and people in place before you create visit plans in Salesforce Maps Advanced
routing. Before you begin, confirm that you installed Salesforce Maps and gave users access to it
and to Salesforce Maps Advanced.

Designate an OAuth User for Route Optimizations

Assign yourself or a colleague as the OAuth user. Salesforce Maps Advanced processes route
optimizations through the OAuth user on Salesforce Maps servers. That way, no one is affected
during intensive system processing.

Keep Salesforce Data up to Date

Schedule batches to send and receive data to Salesforce Maps Advanced routing.

Creating a Custom Output Object for Visits

Set up Salesforce Maps Advanced to create events on reps’ calendars as the output of creating routes. If you don’t want to use events
to represent visits, create a custom output object. For example, you can create a custom output object based on visits in Consumer
Goods Cloud.
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Create a Custom Routable Object

Salesforce Maps Advanced comes with the following standard routable objects: accounts, cases, contacts, leads, and opportunities.
If you want to use a different object containing location data for your customers, create a custom routable object.

SEE ALSO:

Installing and Giving Access to Salesforce Maps

Rollout Guidelines

Designate an OAuth User for Route Optimizations

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Assign yourself or a colleague as the OAuth user. Salesforce Maps Advanced processes route
optimizations through the OAuth user on Salesforce Maps servers. That way, no one is affected
during intensive system processing.

Regardless of who creates and manages visit plans and schedules, Salesforce Maps Advanced has
processes that work through the OAuth user.

1. To designate yourself as the OAuth user, log in to Salesforce with your username and password.
To designate a colleague, ask that person to log in to Salesforce with their username and
password.

The person you designate as the OAuth user completes the rest of this configuration.

2. Confirm that you have the following:

• A role that is above the Salesforce Maps Advanced end users’ role in the Salesforce hierarchy.

• Access to Salesforce Maps Advanced. Specifically, the SF Maps and SF Maps Advanced
permission sets assigned to you.

• Access to the Salesforce objects used in the visit plan process, such as the Account, Event,
and Task objects.

3. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed Packages.

4. Next to the Salesforce Maps package, click Configure.

5. Select OAuth.

6. Click Authorize.

7. Click Allow Access.

SEE ALSO:

Salesforce Help: Controlling Access Using Hierarchies
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Keep Salesforce Data up to Date

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Schedule batches to send and receive data to Salesforce Maps Advanced routing.

1. Identify your OAuth user, and have that user log in to Salesforce with their username and
password.

2. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

3. Next to the Salesforce Maps package, click Configure.

4. Under Maps Advanced, select Data Management.

5. Click Schedule Advanced Batches.
A Batches Scheduled message appears. About every hour, the product checks to see if there
are any visit plans with route optimization scheduled. If there are, route and schedule data is
updated in those visit plans.

It’s not recommended, but if you want to disable scheduled batches for all visit plans, delete the
Advanced Route Reoptimization Template Batch job in

Setup.

SEE ALSO:

Designate an OAuth User for Route Optimizations

Creating a Custom Output Object for Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Set up Salesforce Maps Advanced to create events on reps’ calendars as the output of creating
routes. If you don’t want to use events to represent visits, create a custom output object. For example,
you can create a custom output object based on visits in Consumer Goods Cloud.

1. Create a Lookup Relationship Between Your Custom Object and Waypoints

After you create your custom object for Salesforce Maps Advanced output, create a lookup
relationship with the Maps Advanced Route Waypoint object.

2. Create a Custom Event

To ensure that your custom object’s records appear on your reps’ schedules in Salesforce Maps
Advanced, create a custom event.

SEE ALSO:

Salesforce Help: Create a Custom Object
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Create a Lookup Relationship Between Your Custom Object and Waypoints

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings and
create and edit custom
objects:
• Customize Application

After you create your custom object for Salesforce Maps Advanced output, create a lookup
relationship with the Maps Advanced Route Waypoint object.

1. From Setup, in the Quick Find box, enter Object, and then select Object Manager.

2. Create and name your custom object in Object Manager.

3. Select Fields & Relationships, and then click New.

4. On the New Custom Field page, under Data Type, select Lookup Relationship, and then click
Next.

5. From the Related To list, select Maps Advanced Route Waypoint, and then click Next.

6. On the New Relationship page, specify the field label and field name, and then click Next.

a. Field Label: Maps Advanced Route Waypoint

b. Field Name: WA_AdvRouteWaypoint

7. Configure optional field-level security and other settings for the custom object, and then save your work.

Next, create a custom event to ensure that your custom object’s records appear on your reps’ schedules.

Create a Custom Event

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings and
create and edit custom
objects:
• Customize Application

To ensure that your custom object’s records appear on your reps’ schedules in Salesforce Maps
Advanced, create a custom event.

1. From Setup, in the Quick Find box, enter Packages, and then select Installed Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Select Routes & Schedule, and then click Custom Event.

4. In the Create Custom Event Config window, select your custom object from the list, and then
click Confirm.

5. On the Event Object Configuration page, configure these settings.

DescriptionSetting

The name of the custom activity object as you want it to appear in
Salesforce Maps Schedule.

Name

The owner or assignee for custom activity records. Select a field that
includes the ID of the owner or assignee, such as OwnerID.

Scheduling
Resource

The name of each custom activity record.Event Name Field
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DescriptionSetting

The time configuration relevant to your custom activity object. Select Use Start DateTime and End
DateTime.

Time Fields

The Salesforce field that represents the start date/time.Start Date Time Field

The Salesforce field that represents the end date/time or duration.End Date Time Field

6. Turn on Enabled, and then save your work.

SEE ALSO:

Salesforce Help: Set Up Schedules to Include Custom Activities

Create a Custom Routable Object

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To create and edit custom
objects:
• Customize Application

Salesforce Maps Advanced comes with the following standard routable objects: accounts, cases,
contacts, leads, and opportunities. If you want to use a different object containing location data for
your customers, create a custom routable object.

After you create your custom object in Object Manager, create a lookup relationship between your
object and the Maps Advanced Route Waypoint object.

1. From Setup, in the Quick Find box, enter Object, and then select Object Manager.

2. Select the Maps Advanced Route Waypoint object.

3. Select Fields & Relationships, and then click New.

4. On the New Custom Field page, under Data Type, select Lookup Relationship and click Next.

5. From the Related To list, select your custom object, and click Next.

6. On the New Relationship page, specify the field label and field name, and then click Next.
You use Consumer Goods Cloud, and your custom routable object is RetailStore. The field label
is RW_RetailStore, and the field name is RW_RetailStore__C.

7. Configure optional field-level security and other settings for the custom object, and then click
Save.

SEE ALSO:

Salesforce Help: Create a Custom Object
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Creating Visit Plans

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

In Salesforce Maps Advanced, sales and service managers create visit plans that contain the input
for reps’ routes.

1. Visit Plans Checklist

Before you create a visit plan in Salesforce Maps Advanced, make sure that you have the data
and criteria you need, such as custom objects.

2. Name and Describe Your Visit Plan

The name and description of the visit plan appear on the Visit Plans page in Salesforce Maps
Advanced.

3. Select a Calendar Object for Output

In Salesforce Maps Advanced, standard event or custom object records are the output from
route generation. For example, if the Event object is the calendar object, then events appear on your reps' calendars after reps
generate routes.

4. Creating and Prioritizing Datasets

In Salesforce Maps Advanced, a dataset is a collection of customer records containing location data for routing. Use datasets in your
visit plan to determine the customers placed on routes, the reps assigned to routes, and how often customers are visited. To create
routes that align with your business priorities, prioritize datasets in the visit plan.

5. Assign Users to Your Visit Plan

You can assign users or user profiles to a visit plan to generate routes for those users. After you save the visit plan, assigned users
receive an email instructing them on how to generate routes in Salesforce Maps Advanced.

6. Define Required Visit Plan Settings

In Salesforce Maps Advanced, set the route planning period and the number of routes to include when you generate routes. Also,
specify how often to regenerate (optimize) routes during the planning period.

7. Specify Visit and Optimization Parameters

Tailor routes in Salesforce Maps Advanced when you prevent scheduling more than one visit during a shift and limit the length of
shifts. Specify maximum drive time between stops, and choose your preferred speed to optimize non-batched routes. Keep in mind,
as a by-product of these constraints, optimizations can be less efficient and deliver fewer routes to reps.

8. Review and Save Your Visit Plan

After you specify all your visit plan requirements and settings, review and save your plan. After you save it, assigned users receive an
email instructing them on how to generate routes in Salesforce Maps Advanced.

Visit Plans Checklist

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Before you create a visit plan in Salesforce Maps Advanced, make sure that you have the data and
criteria you need, such as custom objects.
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ExampleQuestions to AnswerHigh-Level Task

To create and update visit plans, a retail operations
manager requires the Maps Admin, SF Maps, and
SF Maps Advanced permission sets.

To generate routes, the manager's reps require the
SF Maps and SF Maps Advanced permission sets.

In your company, who creates and maintains visit plans?

Visit plans require a dedicated person to keep them current
and relevant for reps.

Create a plan

You use events to represent retail reps’ visits on
their calendars, so you use the Event object for the
output object.

How do you represent reps’ visits on their schedules?

Events are standard. Anything else needs a custom output
object.

Select calendar data

You use Consumer Goods Cloud and your custom
routable object is RetailStore. That RetailStore

Select visit data • Which Salesforce object containing location data do you
want to use?

Accounts, cases, contacts, leads, and opportunities are
standard. Anything else needs a custom routable object.

object contains formula fields for minimum and
maximum days between visits based on quarterly
visit requirements.

The object looks up to visit windows that contain
standard business hours and temporary visit
windows for seasonal businesses.

• Do you want to route multiple objects?

• Do you have visit frequency or prioritization fields in
Salesforce that you want to use in the scheduling
process?

• Do you have a target number of visits, minimum days
between visits, or time to complete a visit?

• Do your accounts have visit windows?

• Do your accounts have a promotional period?

The account owner is responsible for visiting
stores. When you generate routes, the optimization

Assign users • Are routable records owned by a single user or shared
between users? User lookup fields on routable objects
determine your reps' account assignments. process adds stops to your reps’ schedules for the

accounts that they own.
• Do reps have Salesforce licenses to generate their own

routes?
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ExampleQuestions to AnswerHigh-Level Task

You decide the visit plan applies to routes for your
next business quarter. You choose to optimize

Specify advanced
settings

• What timeframe do you want the visit plan to cover?

• Do you update route data periodically during the visit
plan timeframe? For example, when integrated systems
update data or when reps use administrative time.

routes weekly. You allow a shift length of no more
than 4 hours for part-time reps.

• Do your reps frequently reschedule visits during the day?

• Does your organization limit the number of hours
employees can work? For example, for part-time
employees or overtime restriction compliance.

Name and Describe Your Visit Plan

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

The name and description of the visit plan appear on the Visit Plans page in Salesforce Maps
Advanced.

1. Make sure that you have the Maps Admin, SF Maps, and SF Maps Advanced permission sets
assigned to you.

2. From the App Launcher, find and select Maps Advanced Visit Plans.

3. Click New Visit Plan.

4. In the New Plan wizard, under Name Your Plan, enter a name and description for your visit plan.

5. Click Next.
Set Up Calendars appears in the visit plan wizard.

Example: Your visit plan generates routes for reps to visit high-priority customers in
December. You name your plan December Routes  and add a description of This
plan focuses on Platinum accounts for seasonal releases.

Select a Calendar Object for Output

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

In Salesforce Maps Advanced, standard event or custom object records are the output from route
generation. For example, if the Event object is the calendar object, then events appear on your reps'
calendars after reps generate routes.

1. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Set Up Calendars.

2. Below the object that you want to use as output for your visit plan, click Use this object.

169

Salesforce Maps Advanced SetupSalesforce Maps



3. Click Next.
Prioritize Data Sets appears in the visit plan wizard.

Example: The output for your visit plan is Consumer Goods Cloud visit records. You create a custom object based on the Consumer
Goods Cloud visit object and select that object as your calendar output object.

SEE ALSO:

Creating a Custom Output Object for Visits

Configuring Schedules

Creating and Prioritizing Datasets

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

In Salesforce Maps Advanced, a dataset is a collection of customer records containing location data
for routing. Use datasets in your visit plan to determine the customers placed on routes, the reps
assigned to routes, and how often customers are visited. To create routes that align with your
business priorities, prioritize datasets in the visit plan.

Creating Datasets for Generating Routes

To generate routes in Salesforce Maps Advanced, every visit plan requires at least one dataset.
If your visit plan has customer groups with different visit requirements, create additional datasets
that represent those customers. For example, you have reps who visit both leads and accounts,
so you create separate datasets that represent them in your visit plan.

Prioritize Datasets in Salesforce Maps Advanced

You can prioritize certain customer visits over others, which increases the likelihood that they’re
scheduled sooner and reps meet visit targets earlier. For example, if you have accounts that have different visit targets than leads,
create a separate dataset, and make it the highest priority.

Creating Datasets for Generating Routes

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To generate routes in Salesforce Maps Advanced, every visit plan requires at least one dataset. If
your visit plan has customer groups with different visit requirements, create additional datasets
that represent those customers. For example, you have reps who visit both leads and accounts, so
you create separate datasets that represent them in your visit plan.

1. Name Your Dataset and Select a Routable Object

To generate routes in Salesforce Maps Advanced, every dataset in a visit plan requires a routable
object. Routable object records represent the customer locations reps visit, such as accounts.

2. Select Routable Records and Assign Users

In your Salesforce Maps Advanced dataset, select the records you want to route and indicate
the field to determine the user responsible for visiting customer locations. For example, an
account rep or merchandiser user.

3. Specify Visit Frequency, Duration, and Visit Windows

In Salesforce Maps Advanced, specify your visit requirements manually or get them from fields in a routable object.

4. Accommodate Prescheduled Visits

If reps have appointments on their calendars that Salesforce Maps Advanced didn’t generate, you can include them when you
generate routes. Including prescheduled visits in the visit plan ensures that they count towards reps’ visit targets.
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5. Reschedule Missed Visits in Salesforce Maps Advanced

To reschedule missed visits during route optimization, specify how your reps log completed visits.

6. Show Waypoint Tooltips on Maps

When reps view their routes in Salesforce Maps Advanced, you can display additional information in waypoint tooltips. Waypoints
are output records, such as visit records, that appear on reps' schedules and routes.

7. Specify Default Output Record Values

To create more comprehensive, detailed output records, specify default field values for the records that the visit plan creates in
Salesforce Maps Advanced.

8. Specify Promotional Periods

To support customer promotions in Salesforce Maps Advanced, prioritize visits to customers within a particular timeframe. This
timeframe is in addition to the visit frequency requirements specified in the dataset. By default, one additional visit is scheduled to
the customer location during the promotional window.

Name Your Dataset and Select a Routable Object

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To generate routes in Salesforce Maps Advanced, every dataset in a visit plan requires a routable
object. Routable object records represent the customer locations reps visit, such as accounts.

1. Confirm that you’ve created at least one base object in Salesforce Maps.

2. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Prioritize Data Sets.

3. Click Create a DataSet.

4. In the dataset wizard, enter a name and description for your dataset.

5. Under Base Object, select the routable object that contains the location data that you want to
use in your visit plan. If you don’t see the routable object that you want, you can create a custom
routable object.

6. Click Next.
User assignments and record filters appear in the dataset wizard.

SEE ALSO:

Create a Custom Routable Object
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Select Routable Records and Assign Users

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

In your Salesforce Maps Advanced dataset, select the records you want to route and indicate the
field to determine the user responsible for visiting customer locations. For example, an account rep
or merchandiser user.

1. In the dataset wizard, from the Assigned User Field Mapping list, select the lookup field that
represents the user who is responsible for visiting locations in the dataset. For example, a Route
Driver field.

2. If your user field is in a child object related to the routable object, select Use rep assignment
from a related object and complete the following fields.

Contains...This field...

An object containing the user field, such as the rep.Child Object

A field that relates the child object to the routable object.Relationship Field

A field that represents the user who is responsible for visiting
locations in the dataset.

Assignment Field

Filter criteria to narrow down the users to use for record
assignment.

Assignment Criteria

3. Under Field Filters, add filter criteria to narrow down the records that you want to route in the dataset. For example, you want to
limit your dataset to customers in Sydney, Australia, so you add filter criteria for the Billing City field. If you don’t add any filters, all
records with the user criteria that you specified are included in your dataset.

4. Click Next.
Visit requirements appear in the dataset wizard.

Example: You use the Account object as your routable object for the dataset. Related Account Team Member object records
represent account users. Because there can be multiple team members per account, you filter user records to those records with
a Team Role field that equals Account Manager  to use in the dataset.
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Specify Visit Frequency, Duration, and Visit Windows

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

In Salesforce Maps Advanced, specify your visit requirements manually or get them from fields in
a routable object.

1. In the dataset wizard, under Visit Requirements, enter the days between visits in Minimum
Days and Maximum Days. As a shortcut, select a frequency from the Suggested Frequency
list.
For example, each account requires three visits over a 90-day period, or one a month. You divide
the total days in the period by the number of expected visits, and you set Maximum Days to
30 and Minimum Days to 27.

2. If an object field contains your visit frequency, select the field from Value from Selected Field.
If the field doesn’t contain a value, then routes use the values in Minimum Days and Maximum
Days.

3. Enter visit duration and buffer time in minutes, or select the field from Value from Selected Field.

Buffer time is additional time to add to the Salesforce-calculated travel time between visits to account for unexpected delays, such
as traffic congestion. Or, time for reps to take notes or walk across large parking facilities.

4. Under Visit Windows, specify the days and times for customer visits for this dataset.

a. If a field on your routable object contains your visit window, select that field from the Field Associated to Advanced Visit
Windows list.

b. If there are two windows for visits on the same day, you can add a window.

For example, store franchise customers prefer visits from 9:00 AM to 11:00 AM, and then again from 1:00 PM to 4:00 PM.

5. Click Next.
Field filters for future visits appear in the dataset wizard.

SEE ALSO:

Set Up Visit Window Selection for Specific Routable Object Records

Days Between Visits
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Accommodate Prescheduled Visits

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

If reps have appointments on their calendars that Salesforce Maps Advanced didn’t generate, you
can include them when you generate routes. Including prescheduled visits in the visit plan ensures
that they count towards reps’ visit targets.

Track manually scheduled visits in the output object for your visit plan. For example, if you use the
Event object as your output (calendar) object, then event records represent manually scheduled
visits.

1. In the dataset wizard, under Field Filters, add filter criteria to narrow down the records
representing scheduled visits that you want to include in the dataset.

For example, reps use the Visit Type field in your routable object to indicate whether a customer visit is virtual or on-site. Under Field
Filters, you set Visit Type to On-Site Meeting  to include only on-site meeting records when you generate routes.

2. Click Next.
The object and fields that represent completed visits appear in the dataset wizard.

Example: The custom output object for your visit plan is based on the Consumer Goods Cloud Visit object. Reps can also create
visits manually. When reps create a visit, they set the Call Type to Visit  and the Status to Planned. You include this criteria
as a filter to ensure that these visits are included when the rep generates routes.

Reschedule Missed Visits in Salesforce Maps Advanced

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To reschedule missed visits during route optimization, specify how your reps log completed visits.

1. In the dataset wizard, from the Visit Object list, select the object that indicates that a scheduled
visit is complete. This object can be the output (calendar) object or another object that has a
lookup relationship with the routable object.

2. From the Lookup Field to Visited Object list, select the field that relates the object to the routable
object.

3. From the Visit Date list, select the date or timestamp field that indicates when a visit was completed.

4. From the Assignment Field list, select the field that represents the user who completed the visit.

If you have multiple reps visiting the same account but with different visit frequencies, select Created by ID as your assignment field.
When you select Created by ID, Salesforce Maps Advanced matches the rep with the visit plan that they’re assigned to and applies
their visit to the appropriate visit requirement.
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For example, suppose you have a sales rep and a merchandiser who visit the same accounts at different timeframes. You want the
sales rep's visit to be counted towards sales visit targets, not merchandiser visit targets. To track visits by user, select Created by ID
as your assignment field.

5. Under Field Filters, add filter criteria to narrow down the records representing completed visits that you want to include in the
dataset.
For example, after reps log a visit, they create a task with a subject starting with “Check In At.” So, you specify Task as the visit object.
You have a Related To ID field that looks up to your routable object, so you specify Related To ID as your lookup field. Under Field
Filters, you specify Subject contains Check In At.

6. Click Next.
Tooltip settings appear in the dataset wizard.

Example: The custom output object for your visit plan is based on the Consumer Goods Cloud Visit object. When reps complete
a visit, they set the Status to Completed. You include this criteria as a filter to ensure that these visits count towards visit targets
when the rep generates routes.

Show Waypoint Tooltips on Maps

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

When reps view their routes in Salesforce Maps Advanced, you can display additional information
in waypoint tooltips. Waypoints are output records, such as visit records, that appear on reps'
schedules and routes.

1. In the dataset wizard, under Tooltips, select the routable object fields that you want reps to see
when they interact with waypoints on their route maps.

2. Click Next.
Default field values for output records appear in the dataset wizard.

Specify Default Output Record Values

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To create more comprehensive, detailed output records, specify default field values for the records
that the visit plan creates in Salesforce Maps Advanced.

1. In the dataset wizard, under Event, select the fields and corresponding values that you want
output records to have by default after reps generate routes.

2. Click Next.
The object, field, and dates that represent promotional windows appear in the dataset wizard.
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Example: The custom output object for your visit plan is based on the Consumer Goods Cloud Visit object. When reps generate
routes, the output is visits. For output records, you specify the default value of Call Type to Visit  and Status to Planned.

Specify Promotional Periods

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To support customer promotions in Salesforce Maps Advanced, prioritize visits to customers within
a particular timeframe. This timeframe is in addition to the visit frequency requirements specified
in the dataset. By default, one additional visit is scheduled to the customer location during the
promotional window.

1. Confirm that your routable object, or an object that looks up to your routable object, contains
fields that represent your promotion start and end dates. If you require more than one additional
visit during the promotion, confirm that your object contains numeric fields that represent the
minimum and maximum days between promotional visits.

2. In the dataset wizard, under Promotional Window, select the routable object that contains the
start and end date fields that you want to use.

3. From the Field list, select the field that relates the promotional window object to the routable object. If you selected the routable
object in the previous step, leave this field blank.

4. From the Start Date and End Date lists, select the fields that correspond to the promotional window start and end dates.

5. If you require two or more additional visits during the promotional window, select More than 1 visit is required within the Promo
period.

a. Check that you have two numeric fields in the promotional window object that represent the minimum and maximum days
between promotional visits.

b. Select those fields in Minimum Days Between Visits and Maximum Days Between Visits.

6. Click Next.
Prioritize Data Sets appears in the visit plan wizard.

When reps generate routes, Salesforce Maps Advanced schedules additional visits within the promotional period. If the rep already met
minimum days between visits or exceeded the visit target, the system still attempts to schedule a visit to the location within the
promotional period dates.
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Prioritize Datasets in Salesforce Maps Advanced

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

You can prioritize certain customer visits over others, which increases the likelihood that they’re
scheduled sooner and reps meet visit targets earlier. For example, if you have accounts that have
different visit targets than leads, create a separate dataset, and make it the highest priority.

1. Confirm that you've created at least two datasets in your visit plan. (You can clone an existing
dataset by clicking the three vertical dots next to the dataset and selecting Clone.)

2. For each dataset, confirm that you've filtered records by a field that indicates priority. For
example, you have a Tier field in your Retail Store routable object. You create three datasets,
each with filter criteria that includes only records with Tier equal to 1, 2, or 3, respectively.

3. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Prioritize Data Sets.

4. Drag datasets to the position that reflects the priority that you want. To make datasets equal
in priority, put them in the same row.

5. Click Next.
Assign Users appears in the visit plan wizard.

SEE ALSO:

Name Your Dataset and Select a Routable Object

Assign Users to Your Visit Plan

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

You can assign users or user profiles to a visit plan to generate routes for those users. After you save
the visit plan, assigned users receive an email instructing them on how to generate routes in
Salesforce Maps Advanced.

1. Confirm that your rep users are assigned the SF Maps and SF Maps Advanced permission sets.

2. Confirm that your rep users own one or more routable records as defined in the visit plan’s
datasets. For example, you've assigned a rep as account manager to at least one account record.

3. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Assign Users.

4. On the Assign Users page, select the user profiles or individual users that you want to generate
routes for.
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5. Click Next. Visit plan settings appear in the visit plan wizard.

After you save the visit plan, assigned users, or users with a selected profile, receive an email directing them to Salesforce Maps
Advanced to update their schedule and generate routes.

Define Required Visit Plan Settings

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

In Salesforce Maps Advanced, set the route planning period and the number of routes to include
when you generate routes. Also, specify how often to regenerate (optimize) routes during the
planning period.

1. Confirm that you've enabled scheduled batches in Setup. If they're not enabled, then the
optimization batches you specify in step 6 don’t run, even when they're shown as enabled in
your visit plan.

2. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Define Visit Plan Settings.

3. On the Define Visit Plan Settings page, specify the start and end dates for this visit plan’s
timeframe. Your visit plan can span 3 months.

4. If you want the visit plan to generate routes for the same amount of time after the end date, select Restart Visit Plan After its End
Date.
For example, your visit plan timeframe is 90 days. At the end of 90 days, the visit plan timeframe starts a new 90-day period. This
90-day rollover occurs until you deactivate the visit plan.

5. Under Number of Routes to Include in Optimizations, select the number of weeks or months worth of routes to generate during
each optimization.

Salesforce recommends that this time value matches the visit plan duration.

For example, use this feature if you want your reps to see 2 weeks of routes, but your visit plan timeframe is for 3 months.

6. Schedule optimization batches to send and receive data to Salesforce Maps Advanced routing. At the frequency and time that you
select, Salesforce Maps Advanced updates route and schedule data in your visit plan.
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For example, you generated routes for your reps last Friday. On Monday, one of your reps decides to take off Tuesday and marks it
on the schedule. Because you scheduled optimization batches to run every Monday, routes are automatically updated to move that
rep's Tuesday visits to another day.

7. Click Next.
Additional Options appears in the visit plan wizard.

SEE ALSO:

Keep Salesforce Data up to Date

Specify Visit and Optimization Parameters

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Tailor routes in Salesforce Maps Advanced when you prevent scheduling more than one visit during
a shift and limit the length of shifts. Specify maximum drive time between stops, and choose your
preferred speed to optimize non-batched routes. Keep in mind, as a by-product of these constraints,
optimizations can be less efficient and deliver fewer routes to reps.

For example, if you specify a 10-minute drive time between stops, it can postpone other customer
visits that fall outside that 10-minute drive.

1. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Set Additional Options.

2. To help reps adhere to visit spacing requirements, ensure they visit customers one time during
their shift. Set the option to prevent same shift visits, which is especially helpful for large volumes
of accounts that require frequent visits.

For example, a customer requires daily visits, but the rep travels 2 days a week. This option schedules the rep to visit one time on
each of those 2 days instead of scheduling multiple visits to that same customer on each of those 2 days.

3. To prevent reps or managers from scheduling themselves for more hours than allowed, enter the maximum hours they can schedule
each day, including breaks.
For example, you want to set a time buffer that allows reps to complete their visits each day, but you also want to control their
overtime. You set Maximum Shift Length to 10 hours. In another example, you want to ensure that part-time employees aren’t
scheduled for full days. You set Maximum Shift Length to 5 hours.

4. To reduce total travel time and promote clustering of visits, specify your recommended drive time in minutes.
For example, your reps have customer locations spread throughout their territories and prefer to drive less between visits during
the day. By setting a Preferred Maximum Drive Time Between Stops of 60 minutes, Salesforce Maps Advanced generates routes with
customer visits close together, limiting drive time as much as possible.

5. To generate routes faster for non-batched optimizations, such as when a rep clicks Plan My Visits on the Maps Advanced Route
tab, specify your preferred optimization time.
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Setting a maximum time can result in reduced route quality because Salesforce Maps Advanced has less time to find the most ideal
routes.

6. Click Next.
Confirm & Save appears in the visit plan wizard.

Review and Save Your Visit Plan

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

After you specify all your visit plan requirements and settings, review and save your plan. After you
save it, assigned users receive an email instructing them on how to generate routes in Salesforce
Maps Advanced.

1. On the Maps Advanced Visit Plans tab, in the New Plan wizard, click Confirm and Save.

2. Review your visit requirements and settings. You can save your plan and come back later to
specify more requirements.

3. If everything looks good, click Confirm & Save.
A list of visit plans appears and your visit plan’s status is set to Active. Salesforce Maps Advanced
sends an email to each assigned user informing them of their assignment to the plan. The email
includes a link to the Maps Advanced Route page so that reps can add personal schedule
information such as their starting location and working hours. Reps must add this information
before they can generate their routes.

If your visit plan's status is Needs Attention, edit your visit plan to include all required elements, such as a dataset, timeframe, and
users.

If your visit plan's status is Deployed, it's active but its start date is in the future.

SEE ALSO:

Knowledge Article: Salesforce Maps Advanced Route Calendar

Fine-Tuning Your Routing Implementation

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To streamline your business processes, refine your routing implementation after you set up Salesforce
Maps Advanced and create a visit plan. For example, create predefined visit windows for chains
and franchises and then share them with your reps to apply to their accounts.

Prevent Certain Events from Appearing on Schedules

Reduce the noise and show only the things that matter when you schedule appointments in
Salesforce Maps Advanced. Flag private and all-day events that you don’t want to schedule.

Optimize Visits for the Future in Salesforce Maps Advanced

After updating your active visit plan, push the changes to your reps' schedules on a future date
to avoid disturbing their near-term visit schedule.

Create Shared Visit Windows for Individual Routable Object Records

Help your sales reps save time and honor customers’ visit windows by creating shared visit windows for chains and franchises. For
example, as a sales and service operations manager, you create windows in Salesforce Maps Advanced that restrict visits to begin
and end during certain time frames. Your reps apply those visit windows to the accounts that they sell to and serve.
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Set Up Visit Window Selection for Specific Routable Object Records

Make it easy and intuitive for your reps to link a visit window to a customer by creating a lookup relationship and a menu option on
the record page layout. If reps don't set visit windows at the record level, then Salesforce Maps Advanced uses the visit window in
the visit plan when generating routes.

Verify That Scheduled Batches Are Running

If you're unsure whether your Salesforce Maps Advanced data is being kept up to date through scheduled batches, check the status
of the scheduled job in Setup.

Track Route Optimization Status

As a manager, monitor the progress of your reps’ route optimization by using the Maps Advanced Route Template User object. Verify
the last time that your reps' routes were optimized in Salesforce Maps Advanced, and identify errors.

Check Optimization Status in Your Calendar

As a rep, monitor the progress of your route optimization through your Salesforce Maps Advanced calendar. Check the last time that
your routes were optimized and identify errors.

Prevent Certain Events from Appearing on Schedules

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Reduce the noise and show only the things that matter when you schedule appointments in
Salesforce Maps Advanced. Flag private and all-day events that you don’t want to schedule.

1. From Setup, in the Quick Find box, enter Installed Packages, and then select Installed
Packages.

2. Next to the Salesforce Maps package, click Configure.

3. Under Maps, select Routes & Schedule, and then click Event.

4. On the Event Object Configuration page, from Exclude Specific Records from Schedule, select
the types of events that you want to omit from appearing on schedules. For example, a private
event.
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Optimize Visits for the Future in Salesforce Maps Advanced

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

After updating your active visit plan, push the changes to your reps' schedules on a future date to
avoid disturbing their near-term visit schedule.

When you optimize your reps' schedules, Salesforce Maps Advanced creates another visit on a
future date for an incomplete past visit.

1. From the App Launcher, find and select Maps Advanced Visit Plans.

2. On the Visit Plans page, edit an active visit plan, then save it.

3. On the Visit Plans page, next to the active visit plan, select Plan Visits.

4. In Plan My Visits, select the date in the future when you want to apply your visit plan changes
to your reps' calendars, and then click Plan.

Example: You update a visit window for a quarterly visit plan for your pharmaceutical reps. You want to update your reps'
schedules but you don't want to disrupt this week's schedule. In Plan My Visits, you select next Monday. After you click Plan, you
regenerate (optimize) routes now, but only update reps' schedules for next Monday and beyond.

Create Shared Visit Windows for Individual Routable Object Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Help your sales reps save time and honor customers’ visit windows by creating shared visit windows
for chains and franchises. For example, as a sales and service operations manager, you create
windows in Salesforce Maps Advanced that restrict visits to begin and end during certain time
frames. Your reps apply those visit windows to the accounts that they sell to and serve.

1. From the App Launcher, find and select Maps Advanced Shared Visit Windows.

2. Under Default Visit Windows, name and specify your shared visit window time frame.
For example, you create a shared visit window for all Tossed Greens restaurant franchise locations.
The franchises prefer visits that begin and end on weekdays between 9:00 AM to 11:00 AM or
2:00 PM to 5:00 PM.
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3. Save your work.

4. To make it easy for your reps to select a shared visit window from an account record, create a lookup relationship with visit windows.
Then create a custom menu option on the routable object and add it to the record page layout.
For example, an account record has a custom menu option named Maps Advanced Visit Window (1). When the rep selects the
option, shared visit windows appear. The rep selects a visit window to link to the account record (2).

SEE ALSO:

Set Up Visit Window Selection for Specific Routable Object Records

Days Between Visits
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Set Up Visit Window Selection for Specific Routable Object Records

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

Make it easy and intuitive for your reps to link a visit window to a customer by creating a lookup
relationship and a menu option on the record page layout. If reps don't set visit windows at the
record level, then Salesforce Maps Advanced uses the visit window in the visit plan when generating
routes.

Tip:  If the same visit window applies to more than one customer location, consider creating
a shared visit window.

1. From Setup, in the Quick Find box, enter Object, and then select Object Manager.

2. Select the routable object that you want to link visit windows to. For example, the Account
object.

3. Select Fields & Relationships, and then click New.

4. On the New Custom Field page, under Data Type, select Lookup Relationship and click Next.

5. From the Related To list, select Maps Advanced Route Visit Windows and click Next.

6. On the New Relationship page, specify the custom field label and field name, and then click
Next.

7. Configure field-level security and other settings, and then save your work.

8. To create another lookup custom field for a customer location with more than one visit window, repeat steps 1 through 7. For
example, if sales reps and merchandisers visit the same customer location at different times, use two lookup custom fields to represent
each visit window.
Next you create a custom menu option on the record page layout. Reps select this menu option to link a visit window to a customer
location, such as an account.

For example, on a franchise account record, the rep selects a custom menu option to specify a visit window for that franchise location
(1).

9. In Object Manager, for the same routable object as in step 1, select Buttons, Links, and Actions, and then click New Button or
Link.

10. For Display Type, select Detail Page Button.
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11. For Behavior, select Display in existing window without sidebar.

12. For Content Source, select URL.

13. In the URL box, paste this code and then replace the bracketed text with the appropriate values.

/apex/maps__AdvRouteVisitWindow?id=[Routable Object Record Id]&field=[API Name of
the Maps Advanced Route Visit Windows lookup field]

For example, your routable object is Retail Store, and the API name of your custom lookup field is
Maps_Advanced_Route_Visit_Windows__c. The code in the URL box is:

/apex/maps__AdvRouteVisitWindow?id={!RetailStore.Id}&field=Salesforce_Maps_Visit_Window__c

14. Check your syntax and save your work.

15. Add your custom menu option, also known as a custom button, to your routable object record page layout. Then your reps can see
and use it on a record detail page to add visit windows.

SEE ALSO:

Create Shared Visit Windows for Individual Routable Object Records

Salesforce Help: Define Custom Buttons and Links

Salesforce Help: Page Layouts

Days Between Visits

Verify That Scheduled Batches Are Running

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

If you're unsure whether your Salesforce Maps Advanced data is being kept up to date through
scheduled batches, check the status of the scheduled job in Setup.

1. From Setup, in the Quick Find box, enter Jobs, and then select Scheduled Jobs.

2. Navigate to the Advanced Route Reoptimization Template Batch job and identify when the job
started and is scheduled to run next. About every hour, the product checks to see if there are
any visit plans with route optimization scheduled. If there are, the batch job runs and updates
route and schedule data in those visit plans.

Warning:  If you delete the Advanced Route Reoptimization Template Batch job, you disable
scheduled batches for all visit plans.

SEE ALSO:

Keep Salesforce Data up to Date
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Track Route Optimization Status

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To customize settings:
• Customize Application

As a manager, monitor the progress of your reps’ route optimization by using the Maps Advanced
Route Template User object. Verify the last time that your reps' routes were optimized in Salesforce
Maps Advanced, and identify errors.

You can create reports and list views from the Maps Advanced Route Template User object. Use
these high-level steps to create a central view of all users' route optimizations still in progress.

1. In Setup, create a custom object tab based on the Maps Advanced Route Template User object.

2. From the App Launcher, find and select your new Maps Advanced Route Template User tab.

3. On the tab, name and enter a new list view to show the route optimization progress. For example,
Routes in Progress.

a. Select the fields that you want to show and the sort order. For example, you can show the
Maps Advanced Route Template User Name, User, Current Processing Status Bulk, Job
Submitted At, and other fields.

b. Filter the list view as follows: Current Processing Status Bulk not equal to Available for
Submission.

c. Save your work.

To troubleshoot errors, use the debug logs. From the App Launcher, find and select Maps Debug Logs. For example, this debug log
shows an optimization error that the rep saw in his calendar view.

You can create reports and list views based on the Maps Debug Log object.

SEE ALSO:

Salesforce Help: Create Lightning Page Tabs

Check Optimization Status in Your Calendar

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

As a rep, monitor the progress of your route optimization through your Salesforce Maps Advanced
calendar. Check the last time that your routes were optimized and identify errors.

1. From the App Launcher, find and select your Maps Advanced Route tab.

2. Above the calendar, note when your optimization last ran and whether any errors occurred.
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SEE ALSO:

Knowledge Article: Salesforce Maps Advanced Route Calendar

Best Practices for Routing Success

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

As you implement Salesforce Maps Advanced, observe these best practices.

Rollout Guidelines

Plan for your Salesforce Maps Advanced implementation and rollout. The better you prepare,
the better your reps are able to meet with more customers in less time.

Data Quality Guidelines

To ensure that sales and service reps get the best routes to make their trips efficient, use the
best quality data in Salesforce Maps Advanced.

Rollout Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Plan for your Salesforce Maps Advanced implementation and rollout. The better you prepare, the
better your reps are able to meet with more customers in less time.

Implementation Strategy

Because Salesforce Maps Advanced requires numerous configurations, consider appointing a
dedicated project manager for your implementation.

• To verify your use case requirements, refer to the pre-implementation checklists in Sample
Scenarios for Salesforce Maps Advanced Routing.

• To gather the objects, fields, and business logic for visit plans, use the visit plan checklist in
Create Visit Plans.
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Testing Strategy

Achieve a successful rollout and increase rep adoption by establishing a testing strategy. Test your product features before you release
them to your teams. For example:

• Practice running route optimizations in a sandbox.

• Start small and plan visits for one rep who owns a defined set of records. Then identify configuration or user issues in the error log.
Repeat the process for other users, then create visit plans for your teams.

SEE ALSO:

Preparing for Routing Automation

Creating Visit Plans

Data Quality Guidelines

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

To ensure that sales and service reps get the best routes to make their trips efficient, use the best
quality data in Salesforce Maps Advanced.

Route optimizations perform best when your Salesforce data includes balanced territories and
record assignments. Algorithms drive the optimization process by using multiple data points so
that your reps visit more customers and drive fewer miles.

It’s best that you...To ensure...

Investigate your territories in Salesforce and the balance of reps in each.
Adjust record assignments to distribute work efficiently. Imbalanced record
assignments can result in too many visit requirements for some reps and
too few for others.

Salesforce offers ways for you to create balanced territories and assignments.

Territory Planning
Create balanced, strategic territories that ensure the best coverage by
your sales and service reps. Then publish your territories and rep
assignments to Salesforce Maps or to Enterprise Territory Management.

Balanced territories

Enterprise Territory Management
Create territory structures and strategies when you build a model, and
then add account assignment rules. Assign users and accounts, and
then run reports to assess your model’s impact.

Data quality • Confirm record assignments for all records or related records that you
want to include in visit plans. Route optimizations exclude any records
that are missing rep assignments.

• Encourage your reps to always check in when they arrive at visits and
to mark visits as done when they leave. If they don’t do so, those visits
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It’s best that you...To ensure...

can reappear on reps’ schedules and give managers an inaccurate read on team performance.

SEE ALSO:

Salesforce Help: Designing Strategic Territories

Salesforce Help: Enterprise Territory Management

Get Technical Support for the Salesforce Maps Portfolio

EDITIONS

Available in: both Salesforce
Classic (not available in all
orgs) and Lightning
Experience

Available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Remove roadblocks and reduce downtime when you route your requests directly to support
engineers who specialize in Salesforce Maps, Salesforce Maps Advanced, and Territory Planning.

1. Log in to Salesforce Help, and then click Contact Support.

2. Click Create a Case.

3. Select the product Sales, and then select the topic Salesforce Maps. Enter information in the required fields, and then submit your
case.

A Salesforce Maps support engineer reviews your details then contacts you.
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